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In Parts, you can create, edit, and delete content for your website. For example, to include your
organization's mission statement on your site, you can create a part in Parts and write the statement.
You can also include your organization's logo in the part. Other examples of parts include navigation
buttons, profile forms, event registration forms, and frames. After you save a part, you can display it on
multiple web pages. This section describes how to create parts for your website.

Note: Content does not appear on the website until you add the part to a web page in Pages &
templates. For information, see the Website Design Guide.

Create and Edit Parts

When you include a part on multiple web pages, you can edit and update it once for all pages. To
ensure a new part’s appearance, such as font size and style, is consistent with the rest of your website,
you can copy an existing part. This retains the bulk of information required to create content.

The procedures in this section describe the tabs you use to create and edit parts. For information
about how to design a specific part, see the section about that part type.

> Create a part

When you host multiple sites, you can create parts for individual sites. To do this, log in to the site and
create the part. For more information, see the Administration Guide.

1. From Site explorer, click Parts. Parts appears.
2. Click New part. The New Part screen appears.

3. On the Properties tab, enter basic information that defines the part. For example, select the part
type and enter a name for the part. For more information, see Properties Tab on page 12.

4. Select the Targeting & Security tab. In the grid, assign view, edit, delete, and change security
rights for users and roles. For more information, see Targeting & Security Tab on page 14.

5. Click Next. The Design tab appears. For more information about the Design tab, see Design Tab
on page 14. For information about how to design a specific part, see the section for that part

type.
6. Click Save. You return to Parts.
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> Edit a part

To search for an existing part to edit in Parts, use the filter tools. For example, select a part type in
the Filter by Type field or enter a full or partial name in the Filter by Name field.

1. From Site explorer, click Parts. Parts appears.
Parts

| JiNew part 3

From Parts, you create, edit, and delete parts such as a User Login, Donation Form, and Profile

zecure rights to roles.

Folders | Search ,
Hll ' “'Move | X Delete ’
17 Deleted Parts . - »
=0 it i MY
|_i Content Management [ S =B X " ,
| Fundraising [l 7 El' B3 X i o B ’
| Online Community '
D fiart gl aine
D fimt gl nans : 2
D Biiad gl nans T s
D [ERLEST  EETE
0

2. When you edit parts, you can perform the following actions:

« To edit a part’s design, click Click here to edit this part. The Edit Part screen appears on the
Design tab. For information about how to design a specific part, see the section for that part
type. For information about the Design tab, see Design Tab on page 14.

« To edit a part's properties, click Click here to view/edit this part’s properties under Action.
The Edit Part screen appears on the Properties tab. For information about part properties, see
Properties Tab on page 12.

« To create a part based on an existing part, click Click here to copy this part under Action. The
Copy Part screen appears. In the New Part name field, enter a new name and click Next. The
Edit Part screen appears so you can edit the new part.

Note: If the original part contains tags, the copy inherits the tags. From the Tags tab, you can modify
the copied tags.
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« To move a part to another folder, select the checkbox beside the part and click Move. The
Move selected items screen appears for you to select a different folder.

« To delete a part, select the checkbox beside the part and click Delete. A message appears to
confirm you want to delete the data. When you do this, the part is available for you to restore
from the Deleted Parts folder.

Warning: To prevent you from inadvertently removing active content from your website, you can no
longer delete parts when they are associated with web pages. When you attempt to delete a part that
is associated with a single site, or shared across multiple sites, a message appears to inform you that
you cannot remove it because it exists on a page. To identify the pages where the part appears, select
the part's Usage tab. For information about the Usage tab, refer to Usage Tab on page 19.

3. Click Save. You return to Parts.

Properties Tab

On the Properties tab, you enter basic information that defines the part.

2 Define part properties
1. Select the Properties tab of a part.

Froperties

Part Type:® Part Description:

Donation Form ]

Part Name:#®
Alurnni Donation

Target Language:
= All = w Part will anly be displayed for the zelected language, or =elect All to turn off

language targeting.

Test Mode allows you to design, style, and test a part without saving or

[#] Test Mode .
processing any data.

You can choose to schedule a begin and end date for displaying this part on

[¥] Scheduled Publishing
a page.

Publish Date: Expiration Date:

4/8/2010 [=] 4/9/2010 =]
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Note:

In the Part Type field, select a part type, such as “Formatted Text and Images.” This is the type
of content to include on the web page. After you save the part, you cannot change the part

type.
After you save a part, you can view its ID in the Part ID field. You can use this ID to identify the

part in a URL for a traffic measurement service, such as Google Analytics. For more
information, see the Administration Guide.

In the Part Name field, enter a name such as “Mission Statement” to allow users to quickly
identify the information in Parts. The name is for internal use and does not appear on the
website.

In the Part Description field, enter any additional information to identify the part.

In the Target Language field, select a language for content in the part. If the website user's
primary language for the Internet browser is selected to the same language in the field, the
part appears on the web page. If the browser is selected to a different language, the part does
not appear. If the part applies to all languages, leave the default " <All>" in the field.

The languages that appear in the drop down are those selected in the Language box on the
Settings tab in Sites & settings. For more information, see the Administration Guide.

To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or The Raiser's Edge, select Test
Mode. For example, you can complete the fields on a donation form to ensure the
confirmation page is styled and working properly. Although you submit the donation and
receive a confirmation, a transaction does not appear on the NetCommunity page.

The Test Mode checkbox appears on the Payment, Donation Form, and Event Registration
Form parts. Only users with supervisor rights can view parts in Test mode.

Use Test mode to verify the user’s experience, not to test data processing. Test mode does not

validate credit card numbers and merchant accounts.

7.

Note:

a.

To make the part available within a certain time frame, select Scheduled Publishing. When
you select this checkbox, the date fields are enabled.
If you do not select Scheduled Publishing, no time limits exists for the part.

In the Publish Date field, enter the date and time the part first becomes available on your
site.

b. In the Expiration Date field, enter the date and time the part becomes unavailable on your

Note:
canm
site, it

site.

If an expired part exists on a live web page on your site, the part does not appear. The other
parts on the page dynamically fill the space where the expired part previously appeared.

When you host multiple sites and edit part properties, the Assign to site field appears so you
ove a part from its current site to another site. If the part is in use on a web page on the source
continues to appear on that site. However, the part is now associated with the target site and

its security. When you move a part, some parts require you to configure options again when you edit
the part's design after the move. For example, the eCards part requires you to select an eCard

templ

ate before you save it. During this time, there are no disruptions to the part on your site. It

maintains the original configuration until you edit the part.

8.

If you plan to use the part on a site that is a template for multiple sites, you can create a single
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instance of the part when you copy the site so you only have to make changes to one instance.
To create a single instance, select Share part across sites. To limit the users who can edit the
shared content, assign security rights from the Targeting & Security tab. For information about
how to copy a site, see the Administration Guide. For information about the Targeting &
Security tab, see Targeting & Security Tab on page 14.

Note: This option appears for the Formatted Text and Images, Slideshow, and Unformatted Text
parts.

When you select Share part across sites, the Allow users who do not have permission to
edit content to create a local copy checkbox appears. If you select this checkbox, users
without permission to edit shared content can copy it.

9. Click Next. The Design tab appears. For more information about the Design tab, see Design
Tab on page 14. For more information about how to design a specific part, see the section for
that part type.

Design Tab

The Design tab appears after you save a part's properties. On this tab, you set parameters defining the
part's content, appearance, and processing. For example, on some parts you define required fields,
allowable payment options, and how users navigate away from the part. For more information about
the Design tab for a particular part, see the section for that part type.

Targeting & Security Tab

On the Targeting & security tab, you assign website security rights for users and roles. You can assign
view, edit, delete, and change security rights.

By setting view rights, you target website content to only certain users. For example, on a Formatted
Text and Images part, you can assign view rights to the Board Members role so only users in that role
view the part on a web page.

Users with rights to edit and delete content can help manage the website. For example, on an Event
Registration Form part, users with edit rights can update last year's golf tournament information with
this year's information.

Users with change security rights have view, edit, and delete rights to the content. They can also
change security on this tab. Only users with supervisor rights should have rights to change security.

2 Select website security permissions

Follow this procedure for information about the Targeting & security tab on pages, templates,
images, and other areas in the program.

1. On a part, select the Targeting & security tab. A grid appears that lists the Everyone role in the
first row.
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Targeting & security

To target this content to specific users, assign the appropriate permissions to roles.

Copy permissions ]

Action User/Role Name View Edit Delete Change Security
Everyone

X Site Administrators

X Content Authors L] O

+ Add users and roles

Note: You cannot edit a checkbox that you select for the Everyone role. All users inherit permissions
from the Everyone role.

2. To apply the same security permissions another part uses, click Copy permissions. The Select a
Part screen appears to select the part.

When you copy permissions, you overwrite the current security settings on the Targeting &
Security tab.

Tip: You cannot copy permissions from a different task. For example, when you select to copy
permissions from a part, you must select permissions from another part. You cannot select
permissions from a page or template. In addition, images do not support copying permissions.

3. Select the part and click Select to return to the Targeting & security tab. The users and roles
appear in the grid. You can adjust the permissions as necessary.

4. To adjust the permissions for users and roles for this part, select Add users and roles. The
Create new security permissions screen appears.
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Create new security permissions

Select users and roles

To add users or roles, move them from Awvailable to Selected. Up to 100 users and roles appear in
alphabetical order. To search for additional users and roles, use the Filter field.

Filter: Selected:
Filter by type:
Both v
Available:
EE users i Add =
Email link
Gabriel Add all ==
ImageOnly
Matthew
Merber
e
Assign permissions
View Edit Delete Change Security
E | |

Tip: When you create or edit a User Login part, you select the roles to assign to a user who signs up
on that part for your website. This is commonly the way users become a part of the roles you assign
permissons for on this screen. For more information about role assignments on the User Login part,
see User Login on page 232.

a.

In the Filter field, enter the first letter of the user or role to include.

Note: The Available box displays 30 users and roles in alphabetical order. Use the Filter field to find
additional users and roles that do not appear in the box.

b.

d.

Locate the user or role, and click Add. The user appears in the Selected box.

To select multiple users or roles, press SHIFT while you select the multiple users, and then
click Add all. The users appear in the Selected box.

Under Assign permissions, grant the users and roles view, edit, delete, and change security
permissions.

Click OK. You return to the Targeting & security tab. The users and roles appear in the grid.

5. To apply the permissions to the part, click Save. You return to Parts.

For more information about security, see the Users & Security Guide.
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Parts That Require User Login Information

Users must log in to view some parts on your website. The following parts require user name and
password information before website users can access them.

« Change User ID/ Password
» Chapter Links

+ Email Forwarding Form

» My Friends

« Profile Display

« Profile Form

+ Targeted Content

« Transaction Manager

« User Education Profile Form
* User Interests Form

» User Link Module

» User Networking Manager
* User Photos Form

Other parts, such as the Personal Page Manager part, allow any user to access some of the part but
require user name and password information to view the rest. Parts, such as the Menu and Weblog
parts, do not require any login information.

Language Tab

Use the Language tab to rename labels, headings, and other text on your web pages. For example, if
you do not want the anonymous gift checkbox to display I prefer to make this donation
anonymously on the donation page, you can change the text to Anonymous gift. For the Tag Display
part, you can enter the header that appears before the list of tags. You can also choose the punctuation
mark, or delimiter, that separates entries in displays that include only tags on the selected page.

You can also enter localized text in another language for the items that appear on the Language tab.
For example, you can create a Donation Form part for English and enter localized text for Spanish. On
the Language tab, you enter the localized text for each language. You use this tab in combination with
other features to create international pages for your website.

2 Rename and localize text
1. Select the Language tab of a part.

Tip: The Language tab appears on the Donation Form, eCards, Giving Search, Language Selector,
Payment, Tag Display, Transaction Manager, User Email Preferences Form, and User Login parts.
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Language

Specify any part text to be replaced with alternate text for a specific language.

Category: Language:

Address ~| | English (United States) v
Item name Item type Default text Text
Address Lines Field label Address lines: |Addreaa lines: |
Country Field label Country: |CDL|r1try: |

In the Category field, select the area of the part to rename text for.
In the Language field, select the language to localize.

You select the languages that appear in the Language box on the Settings tab in Sites &
settings.

4. Refer to the Item name column to enter text in the Text column. This text replaces the
default text.

« Enter the text to replace the default label or heading. For example, for the Anonymous gift
checkbox item, you do not want the checkbox to display | prefer to make this donation
anonymously on the web page. In the Text column, enter “Anonymous gift” to change the
name of the checkbox.

 Enter localized text for selected languages. For example, to create a Spanish web page, you
can change the text to “Donacién anonimo." In the Language field, select the next language
to localize. When you toggle the Language field between multiple languages, the localized
text appears in the Text column for each language.

For more information about multiple languages on your website, see Add Localized Text For
Web Pages on page 18.

 For the Tag Display part, you can enter a new delimiter to separate tag entries.

Note: The delimiter separates entries in tag displays that show only tags for the parts on a page. For
tag displays that include all tags in use, entries appear on separate lines by default and the delimiter
does not appear. To add a delimiter to a tag display for all tags, you must modify the
BBTagDelimiterAll element under Tag Display for the appropriate style sheet. For information about
how to manage style elements, see the Website Design Guide.

Add Localized Text For Web Pages

You use the Language tab in combination with other features to create international pages for your
website. You can create localized text for pages on your website in two ways. You can enter the
localized text to appear on the Language tab and create the Language Selector part. The Language
Selector part allows the website user to render the localized text on the web page. You can also create
a part specifically for a language. If a website user’s primary language for the Internet browser is the
same as the part, the part appears on the web page.
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2 Implement multiple languages on your website

1.

3.

On the Settings tab in Sites & settings, select the languages to associate with your website. For
example, if your website audience includes Spanish and French users, select Espaiol (Mexico)

and francais (Canada) in the Language box. For more information, see the Administration
Guide.

Create a part specifically for a language. You can create localized pages in two ways.

« On the part’s Properties tab, in the Target language field, select the language for the part. If

the website user’s primary language for the Internet browser is selected to the same language
in the Target language field, the part appears on the web page. If the browser is selected to a
different language, the part does not appear. If the part applies to all languages, leave the
default “<All>" in the field. For more information, see Properties Tab on page 12.

OR

« On a part's Language tab, in the Language field, select the language to localize. In the Text

column, enter the localized text for the web page. Create the Language Selector part. This part
displays a Language drop down field on your website. A website user selects a language
preference from the field on the web page. After the user selects the language, the page
renders the localized text. For more information, see Language Tab on page 17 and Language
Selector on page 127.

Add all applicable parts to a template or page in Pages & templates.

Usage Tab

After you save a part, the Usage tab appears. This tab displays the layouts, templates, and web pages
that use the part. The information is for informational purposes only. If the part is not used, a "This part
is not being used” message appears.

The following depicts where this part is currently used on the =ite, showing the pages and templates that indirectly include this

Usage

part.

El @ Blank Client Site
I!"" GC Test d Site
|7 Test 43 Lod

= Template

|&’ Page
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Helplets Tab

On the Helplets tab, you can add custom text to help users understand the features of certain parts on
your website. For example, on the Personal Page Manager part, you can provide instructions for the
various Dashboard buttons.

Tip: The Helplets tab appears on the Event Registration Form, Fundraiser, Payment, and Personal Page
Manager parts.

> Add helplets
1. Select the Helplets tab.

2. Inthe Screen field, select the screen to add help text for.

Helplets
Helplets
Frovide help text for this form's different screens.
Screen: Login * lz‘ * indicates screen contains help text content | Restore Default
7o Formatting Insert View
E g Cut Fontfamily |+ Fontsze » 3=~ i= -3 =@ M Find
23 Co Sy ) e Format i
SR LY B FfUmA-F-====xx F-
Paste — - . 5
wme Code _» Remove formatting

»

Please enter your infermation and form of payment balow.

Note: Some screens contain default helplet text. You can use the text provided or enter different text.
If you overwrite the default text, you can click Restore Default to restore the original text.

3. Inthe box, enter the text to appear on the part. To format the content’s appearance and
layout, use the HTML editor. For information about the HTML editor, see the Program Basics
Guide.

4. To create help text for another screen, select it in the Screen field. The program automatically
saves your changes, and an asterisk appears beside the screens in the field that have help
content.
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Content Approval Tab

When you design a Formatted Text and Images part or Formatted Text and Images (Secured) part, the

Content Approval tab appears. On this tab, you select the approval status of the part and view its status
within the selected workflow and its approval history. If you have rights to manage workflows, you can
also assign the part to a different workflow.

When you revise a published part, the program automatically archives its earlier version. From the
Content Approval tab, you can view its previously published versions. If you have rights to approve
content, you can also restore the part to an earlier version.

2 Select the workflow and approval status of a part from its Content Approval tab

1.

On the Edit Part screen, select the Content Approval tab.

Set approval status and workflow for this part.

Approval Status: | Diraft "|
Workflow: | Default for FT&I * V| * denotes default workflow
ACtVIY: | action  Version Status  Status Updated On Status Updated By
a1 1 Draft 8/6/2009 3:41:50 PM Supervisor

Content Approval

1 version meets selected criteria

2.

3.

In the Approval Status field, select the part's status in the workflow.

When you first create or edit a part, the approval status is “Draft” until you complete its design
and submit it for approval. Until the part is ready for approval, select this account status. In the
Activity grid, parts with this status display "Draft” in the Status column. Parts with this status
appear in Approvals and on the Approvals tab of the selected workflow.

When you complete the part's design and content, select “Ready for Approval” to submit it for
approval. Users in the approval role for the workflow can review parts with this status and
select whether to approve the content to appear on the website. In the Activity grid, parts
with this status display “Pending” in the Status column. In Approvals and on the Approvals tab
of the selected workflow, parts with this status display an approval status of “Pending.”

To approve the part and its content, users in the approval role for the workflow select
“Publish.” Parts with this status appear on your website. In the Activity grid, parts with this
status display “Published” in the Status column.

To reject the part and its content, such as if the content contains error or is inappropriate for
your website, users in the approval role for the workflow select “Reject.”

If you have rights to manage workflows, the Workflow field appears. Select the workflow to
apply to the part. The workflow determines the users who review the part for approval.
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Note: When you create a workflow in Workflows, you can select whether it is the default workflow for
the selected part type. When you design a part and select its workflow in the Workflow field, an
asterisk (*) appears next to the default workflow. For information about how to create a workflow, see
the Administration Guide.

4,

In the Activity grid, view the recent approval activity for the part, including its approval status
and the date and owner of the more recent approval status update.

To view the part and its content, such as for review and approval, click Click here to view this
version in the Action column. The part and its content appears. To return to the Content
Approval tab, click Close.

To compose and send an email message to the most recent person to update the status of a
draft or pending part, click Click here to send email in the Action column.

To continue to design the part and its content, select the Design tab. For information about
how to design the Formatted Text and Images or Formatted Text and Images (Secured) part,
see Formatted Text and Images on page 120.

To return to Parts, click Save.

2 Restore a published part to an archived version

When you revise a published part, the program archives its earlier version. On the Content
Approval tab, the Status column displays “Archived” for earlier published versions of the part.
From the Content Approval tab, users in the content approval role can restore the part to an earlier
archived version.

1.

On the Edit Part screen, select the Content Approval tab.

Content Approval

Set approval status and workflow for this part.

Approval Status:

Workflow: | Default workflow (Secured) * V| = denates default warkflow
By Action ‘ersion Status Status Updated On Status Updated By
LA 4 Published 4/4/2008 5:44:31 PM supervisor
0 & 3 Archived 4/4/2008 5:44:31 PM supervisor
Jo .l <) 2 Archived 4/4/2008 3:44:18 PM supervisor
5 & i Rejected 4/4/2008 3:43:45 PM supervisor

In the grid, determine the version of the part to restore. To view the part and its content for an
earlier version, click Click here to view this version under Action. The part and its content for
that version appears. To return to the Content Approval tab, click Close.

Next to the version to restore, click Click here to restore this version under Action. A
message appears to confirm the restoration of the version.

Click OK. You return to Parts.



PARTS 23

Tags Tab

On the Tags tab, you enter keywords or phrases to identify a part's content. You can also associate user
interests with the part. When the part is on a web page with a Tag Display part, its tags and user
interests appear as hyperlinks. Users can click the links to access similar content from a list of the web

pages that contain parts associated with the tags and user interests. For information about how to
display tags as hyperlinks, see Tag Display on page 208.

> Add tags
1. Select the Tags tab.

Tags

Tags are keywords that describe the content on parts and allow you to link to similar content. The Search part uses tags when it
searches your website. The Suggested Content and Tag Display parts use tags to link to similar content on your website.

Add tag:

Tags currently attached to this part:
< Type tags for this part = Add

¥/ Existing tags and interests

To make this part eligible to appear on a Suggested Content part, select this
checkbox. Suggested Content parts search for parts with similar tags and
interestz and then link to the pages with the closest matches.

[Jinclude on Suggested Content parts

To view the tags and user interests, click Existing tags and interests. Links appear for existing
tags and user interests.

Note: A number beside a tag or user interest indicates how many parts use it. This information also
appears in autocomplete text in the Add Tag field.
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Add tag: Tags currently attached to this part:
< Type tags for this part = Add

%) Hide tags and interests

Click the tags and interests to add to this part.
Advocacy Basketball [Interest] Biking [Interest]
Cards [Interest] Community

Contemporary art [Interest] Cooking [Interest]
Cricket [Interest] Donate Ewvents Fiching [Interest
Football [Interest] Gardening [Interest]

Get Involved Giving Golf [Interest
Horseback riding [Interest] Local(l) Membership

|

Multimedia News MNewslstter —

Outdoor activities [Interest] Photography [Interest]
FPhotoz Profile Recent Events Rugby [Interest
Sailing [Interest](2) Soccer [Interest]

|<

3. To associate existing tags and user interests with the part, click the links. The items appear
under Tags currently attached to this part.

4. To create atag, enter aword or phrase in the Add tag field and click Add. The tag appears
under Tags currently attached to this part.

Note: To save data entry time, the program uses autocomplete to suggest existing tags from the Site
Tags code table. When you add tags, the program adds them to the code table. For information
about how to manage the Site Tags code table, see the Administration Guide.

5. To remove a tag or user interest, click the “x” beside it under Tags currently attached to this
part.

To make this part eligible to appear on a Suggested Content part, select this
[#] Include on Suggested Content parts checkbox. Suggested Content parts search for parts with similar tags and
interests and then link to the pages with the closest matches.

Title:

Summary:

6. To allow Suggested Content parts to link to the part, select Include on Suggested Content
parts. The Suggested Content part searches for parts with matching tags and user interests to
recommend content to website users. For information about the Suggested Content part, see
Suggested Content on page 197.




PAarTs 25

7. Inthe Title field, enter a header to display on a Suggested Content part when it recommends
the part. The header links users to the part's web page.

In the Summary field, enter a short description to appear on a Suggested Content part.

Click Save. You return to Parts.

Alumni Class Notes (Deprecated)

Warning: The Alumni Class Notes (Deprecated) part was replaced with the more powerful Personal
Notes part. The Alumni Class Notes (Deprecated) part type appears in Parts only if you have saved
Alumni Class Notes (Deprecated) parts. While the deprecated part continues to operate for backwards
compatibility on your website, you can no longer create or copy Alumni Class Notes (Deprecated)
parts. The Personal Notes part includes all the functionality of the Alumni Class Notes (Deprecated)
part. In addition, with personal notes, you can select the note topics to display and you can give site
users the ability to search and manage their personal notes. You can have multiple Personal Notes
parts on your website while you can have only one Alumni Class Notes part. For information about the
Personal Notes part, see Personal Notes on page 182.

Use the Alumni Class Notes part so alumni can add notes to a class notes web page. You can create a
class notes page for each graduating year. Each page includes the same Alumni Class Notes part. For
security reasons, you can have only one Alumni Class Notes part. After you create the part, the option is
removed from the Part type field on a New Part screen so another cannot be created. If you mark
Require Approval when you create the part, users with edit rights must approve class notes on the
web page before they appear online.

Note: You can download the notes alumni add about themselves to the Notes tab of their constituent
record. This helps you know more specifics about your constituents.

2 Design Alumni Class Notes

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Class Year Notes, select class year information for the Alumni

Class Notes.
a. To add aclass, select the year in the Class Year List field.
b. Click Add Year. The class year becomes available for selection on the web page.
c. Toremove a class, select the class year in the Class Year List field and click Remove Year.
d. To require note approval before publishing on the web page for public viewing, mark

Require Approval.

If you unmark this checkbox, the Approval Rights frame is removed from the Edit Part
screen.

e. To display alink to alumni profile pages on the Alumni Class Notes part, select a Profile
Page. You can link the Alumni Class Notes part to any page with applicable data. For
example, to link an alumni name on a class note to the profile for the selected person, select
a page that uses the Profile Display part.
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2. Inthe Captions frame, enter text to appear on the Alumni Class Notes part on your web page.

Note: Information you enter in the Captions frame applies to each class year. You cannot specify the
text to appear for an individual class year. The text is a one time setting for the entire Alumni Class
Notes part. If you edit the text, the updated text appears for each class year.

a. Inthe Title field, enter text to appear on the title bar of the part.

b. Inthe View Button field, enter text to appear on the link for alumni to click to view a class
note.

c. Inthe Edit Button field, enter text to appear on the link for alumni to click to edit a class
note.

d. Inthe Approve Button field, enter text to appear on the link for users in the roles with Can
Approve rights.

When a user clicks this link, a View drop down field appears. The user can filter the notes to
view by Pending Approval, Approved Only, or All.

3. Inthe Approval Rights frame, select approval rights for roles.

a. Inthe Select roles with class note approval rights for the class of field, select the class
year to apply approval rights to.

b. Inthe Can Approve column, select the roles with permission to edit and delete class notes.
If you select Can Approve for a role, it can approve notes. To automatically assign approval
rights to all roles, mark Can Approve at the top of the column.

c. To save your changes for the class year, click Save above the security grid.

4. Click Save. You return to Parts.

Anonymous Newsletter Subscription

With the Anonymous Newsletter Subscription part, you can offer a newsletter for website users to
subscribe to without registering on your website. Because the subscriber does not create a user
account, no sign-up transaction or constituent record is created in The Raiser's Edge. Typically, you may
want to enable anonymous subscriptions for a particular newsletter, such as an introductory newsletter,
that leads subscribers to become more involved with your organization and become active users and
constituents.

Tip: To keep information for anonymous newsletter subscribers private, subscriber data is stored in
the online database. You cannot view it on the administrative side of the website.

On the web page, the Anonymous Newsletter Subscription part appears as a box where users can enter
their names and email addresses and click a button to subscribe.

2 Design Anonymous Newsletter Subscription

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Newsletter field, select the newsletter that users can anonymously
subscribe to.
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Anonymous Newsletter Subscription

Use this form to allow website users to subscribe to the newsletter without signing up for a user account.
Because anonymous subscribers do not create user accounts, they do not appear as sign-up transactions in
The Raiser's Edge to become new constituents.

Newsletter; ®

w Select the newsletter that users can anonymously subscribe to.

Form title:

After subscribing navigate to:
T Select the page users are redirected to after subscribing.

2. Inthe Form title field, enter the text to appear at the top of the Anonymous Newsletter
Subscription part on your website, such as "Get the Newsletter!”

3. In the After subscribing navigate to field, select the web page, such as a Welcome or Thank
You page, to appear after the site user clicks Subscribe.

Note: If you do not select a web page in the After subscribing navigate to field, the website user
returns to the Anonymous Newsletter Subscription part after he clicks Subscribe.

4. Click Save. You return to Parts.

Change User ID/Password

With the Change User ID/Password part, website users can change their usernames and passwords in
the online database without affecting the usernames and passwords for other integrated Blackbaud
programs. On the website, the user can update the username and password.

2 Design Change User ID/Password

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the After update navigate to field, select the web page to appear
after the website user changes the username and password.

Note: If you do not select a web page in the After update navigate to field, the Home Page
selected on the Settings tab in Sites & settings automatically appears after the website user changes
the username or password.
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General
After update navigate to:#®
User Profile Farm il Select the page users navigate to after they update their user ID or
Confirmation password.
Fields
Select the fields to include on form.
Include Field Editable Required
Username
Password
Confirm Password
] Time Zone ] O

2. Inthe Fields grid, select the fields to display on your Change User ID/Password form. You can
include the User Name, Password, Confirm Password, and Time Zone fields. For details
about the grid, see Change User ID/Password Fields Grid on page 28.

Note: If the site only collects email addresses for user logins, Email Address appears instead of User
Name as the login field option.

3. Click Save. You return to Parts.

Change User ID/Password Fields Grid

The table provides information about the options in the Fields grid on the Change User ID/Password
part.

Option Program Administrator Notes
or Website User?

Include Program Select the checkbox next to the fields to include on your
Change User ID/Password form.

Field N/A Displays the default field name for your Change User
ID/Password form.

Editable Program and website To enable other users to edit the field, select this checkbox.

Required Website To make a field required on the Change User ID/Password

form, select this checkbox.
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Communication Consent Part

The Communication Consent part enables you to capture explicit communication consent from your
constituents — and to assist with General Data Protection Regulation (GDPR) compliance — on your
Blackbaud NetCommunity forms. Website users can make consent option preference selections on a
web form. This includes specifically opting in or opting out of specific consent options.

Note: Raiser's Edge Patch 8 — where the communication channels and categories are configured —
is required to use the new Communication Consent part in Blackbaud NetCommunity. If you are not
using Patch 8, the communication consent functionality is not enabled in Blackbaud NetCommunity.

As an organization, you can create one Communication Consent part — or multiple versions of the part
— to support the forms in Blackbaud NetCommunity that collect constituent information and write the
data to constituent records in The Raiser's Edge.

The Communication Consent part cannot be added directly to a page — it must be included on a
form. You can include the part on any of the following forms in Blackbaud NetCommunity by
configuring the Consent section on the form's Design tab:

« Donation Form

« Event Registration Form (Classic)
« Events Registration Form

o User Login Form

o User Email Preferences Form

o Payment 2.0 Form

Note: This form supports consent for all transactions types — donations, event registrations
and memberships.

« Membership Form
« Profile Form
« Email Signup

After users submit the form, their consent information is downloaded to the BBNC plugin along with
their transaction. After the transaction is processed, their constituent record is updated in The Raiser's
Edge with their communication consent preferences. If the user is logged in when they submit the
form and their BBNC account is linked to a constituent record in The Raiser's Edge, their
communication consent preferences are written directly to their record in The Raiser's Edge.

Note: You can expect a lag time of approximately 5 minutes between the time you commit a
donation or membership transaction batch and the time the consent preferences are written to the
constituent's record in The Raiser's Edge.

After a user has already provided consent preferences, if they fill out a subsequent form that includes
the Communication Consent part and they are logged into Blackbaud NetCommunity, their consent
preferences are automatically pre-populated. Users can modify their consent preferences, and the
changes are then written to their constituent record when they submit the form.
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If a transaction is canceled for any reason, the user's consent preference selections for that transaction
are not written to their constituent record.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

2 Design Communication Consent Part

1. Under General, enter a title to display on the web page for the communication consent
preferences or use the default title. This field is required.

General
TiElg:
[ e R e Irfed & ot DlSe 00 EiEar o e sl Db

Consent Statement =

Phkdrkd bEE il bR Bdva ek 3P0l Cobaah
Wi bt Puture. Erdd thit iradructions for Bh Consent

Consent Options =
dge] forent Solor 1o Siplyy 34 Consend cpliong on the med page

€ hservrard Calagary Caplinm Hrggueiied
[mad [ [pea—
APy e 85 Phird g
Al Opraiets A Laparsbor
Email Opt-out checkbox
Thip 8- Gaafl CRapchbon & Thap Coniant Part allgwi webiita wiers 1o S abe thal Ehiry &5 fedl mail 10 Pidehvd ermall Meiiagel from o
o 2 gitpeni

Qe -t EhaiBaim Lalepd: @

1 s Pt et S fe g Pubuns s [t & Lkl Port Ehip chupihibesn bo ool oot of dvnull i
Lo e DR 4 TPSem S f SER D R

Privacy Policy =
Al » bnk te 3 privacy polCy fo desplay on B welb page.
Ml |
® Crpale lend R0 BLaCkhaesd Mol oererianely o IPriv a0y polely "

LARL

2. Under Consent Statement, enter customized instructions or use the default statement.
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3. Under Consent Options, add the consent options you want to display on the web page.

a. Select Add Option to search for consent options that are configured in The Raiser's Edge,
then choose the ones to include on the form. For each consent option, you can modify the
caption that displays on the form, specify whether the option is required, or remove the
option.

b. To add adivider to separate sections on the form — for example, to keep all email consent
options together — select Add Separator and include a caption for the separator.

You can click and drag the consent options to reorder them and to move the corresponding
separators.

4. Under Email Opt-out checkbox, enter the text to use for the Email opt-out option that's
included on the consent part. When users select this option, it globally opts them out from
receiving communication from your organization through any email channel. It also selects the
Requests no email option on their constituent record in The Raiser's Edge.

5. Under Privacy Policy, select an option for including access to your organization's privacy
policy on the web page. Select Create link to Blackbaud NetCommunity page, then click the
binoculars to choose an existing page on your website that includes your privacy policy. Select
URL to include an external link to the privacy policy, then enter the URL. If you don't want to
include a link, select None.

6. Select Save.

Content Comparison

With the Content Comparison part, you can compare the effectiveness of different appeals to your
website users. For example, you can create multiple Formatted Text and Images parts to promote an
event or to solicit donations. On the Content Comparison part, you add up to six of these parts and
select a target page, such as a page with an event registration form or donation form. After you place
the Content Comparison part on a page, it randomly displays the Formatted Text and Images parts to
website users and tracks the click-through rate to the target page. After a user views the comparison,
the program associates the user with a particular Formatted Text and Images part so that each user
only sees one part in the comparison. To track users, the Content Comparison part uses the login
information or cookies that identify the user's computer.

The Formatted Text and Images parts in the comparison must include links to the target page because
the comparison measures their effectiveness by the click-through rate to the target page. The
comparison also measures the conversion rate if the target page includes a donation form,
membership form, event registration form, payment part, survey part, or user login. For example, if the
target page includes an event registration form, the comparison tracks how many users register for the
event. If the target page includes a donation form, the comparison also tracks the amount donated.

The Content Comparison part tracks the performance of Formatted Text and Images parts until it
achieves statistical significance. The number of Formatted Text and Images parts in the comparison
determines the default threshold to reach statistical significance, but you can also select your own
threshold. Comparison statistics are not calculated in real time but are updated nightly. After the
comparison reaches statistical significance, the Content Comparison part ends the comparison and
displays only the most effective Text and Formatted Images part. If you decide to use a different Text
and Formatted Images part, you can override this selection.
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2 Design Content Comparison

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, browse to the target page for the comparison. To track the click-through
rate, the Formatted Text and Images parts in the comparison must include a link to the target
page.

Choose a target page

To compare the effectiveness of appeals to website users, the Content Comparison part tracks the click-through
rate to a target page. You should include a link to this target page in all the parts in the comparison.

Target Page:
;o)

The test will end after a certain number of users have clicked through to the target page. The system sets this
threshold to 30 by default (although that number increases as the number of parts being tested increases) but the
default can be overridden by entering a value in the box below. This can be useful for high-traffic sites where the
threshold might be reached very quickly.

Threshold (leave blank for system default): I:l

Add parts

You can include up to six Formatted Text and Images parts in the comparison. These parts cannot be edited while
the comparison is conducted.

| Part Name | Performance

[ Add Part for Comparison ] [ Create Part for Comparison ]

Enable comparison

The comparison tracks the performance of the parts until it achieves statistical significance. Comparizon statistics
are not calculated in real time but are updated nightly. After the comparison reaches statistical significance, the
program selects the most effective part.

l Enable Comparison ]

The comparison measures the effectiveness of the Formatted Text and Images parts by the
click-through rate. It also measures the conversion rate if the target page includes a donation
form, membership form, event registration form, payment part, survey part, or user login. If
the target page includes a donation form, the comparison also tracks the amount donated.

2. To override the default threshold for the comparison, enter the number of users who must
click through to the target page in the Threshold field. The default threshold to achieve
statistical significance is based on the number of Formatted Text and Images parts in the
comparison.

3. Under Add parts, add parts to the comparison. You can only include up to six different
Formatted Text and Images parts. You cannot edit the parts during the comparison.
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« To add an existing part, click Add Part for Comparison. The Select a Part screen appears with
all available Formatted Text and Images parts.

+ To create a part, click Create Part for Comparison. The New Part screen appears with
“Formatted Text and Images” in the Part Type field. For information about how to create a
Formatted Text and Images part, see Formatted Text and Images on page 120.

Note: After you add Formatted Text and Images parts to the comparison, you can edit and delete the
parts from the Content Comparison part. After you start the comparison, you can no longer edit or
delete the parts. In addition, while a Formatted Text and Images part is placed on the Content
Comparison part, you cannot delete it elsewhere in the program.

4. To start the comparison, click Enable Comparison. The status appears. The comparison tracks
the performance of the Formatted Text and Images parts until it achieves statistical
significance.

After you enable the comparison, click View Report to view details.
6. Click Save. You return to Parts.

Custom Parts

In Administration, Custom parts, you can create a new custom content part type or link to an existing
framework part type. After you create or link to the part type, it is available for selection in Parts.

Note: Custom parts offer additional flexibility, but come with additional complexity. If you host your
own website, we strongly recommend only developers knowledgeable in all areas of customizations
design them. This includes writing HTML and JavaScript code. Users without this expertise should not
design these parts. If Blackbaud hosts your website, customizations can only be completed by
Blackbaud or one of our designated partners. For more information, please contact your Blackbaud
Account Executive.

To create a custom content part type, click New content part. A custom content part uses JavaScript
and HTML to create the part editor and define how to display the part on a web page. You can use
custom content parts to create customizations such as slideshows, tabbed content, RSS Feed readers,
accordion content, pop-up boxes, and callout boxes.

To link to an existing framework part type, click New framework part. To build custom framework
parts for your website, you should understand Blackbaud NetCommunity from a site designer’s
perspective and have a working technical knowledge of ASP.NET. The content for custom framework
parts can come from a variety of sources and can be as simple as text or HTML stored in the Blackbaud
NetCommunity database, or it can be data from the back office such as constituent giving history. For
example, you can use a custom framework part to create a custom individual search form or a custom
pledge form for Blackbaud NetCommunity.
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Custom parts ]

L‘aa Mew content part l."T}JNew framewaork part
Manage your custom parts by specifying the display and edit user controls for your custom parts.
Filter by name:

| Filter |

Require

Action Name SSL

Description Type

7 XA Main slideshow No Slideshow rotating pics for home page Content

7 X Mews widget No Recent news posts Content

2 custom parts meet selected criteria

Directory

With a Directory part, you can allow website users to search for other website users in defined groups
of constituents. Users can then view profile displays to learn more about constituents. To publish
directories on your website, you use constituent queries to access information about website users. For
example, you can create a constituent query for the Class of 2000 in The Raiser's Edge and use it to
create a directory of users in that class. You can then select fields for website users to search against.
For example, you can allow users to search the directory for data in the First Name, Last name, and
State fields. You can also provide links from the directory to constituent personal pages.

Note: The directory search can return up to 500 results that match the criteria entered by a site user.

You also select the fields to appear on your web page when the user’s search produces results. For
example, you can select to display First Name, Last name, Address Line 1, City, and State fields for
your directory results. The field you list first for results links to the constituent’s published profile
information.

You can also allow website users to send personal messages to others in the directory without sharing
their email addresses.

2 Design Directory

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Directory title field, enter a name for the directory, such as “Class
of 2000 Directory.”
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Directory title: Directory
Records to Include
Limit to query: | (All Constituents) i
Include: Individuals Only -
Include Deceased: [
Search Form
Split search fields into: 1 *  column(s).
[ Load unfiltered results when this part is loaded
Results
Show navigation controls: Both above and below the results = Results per page: 2 ™
Show number of results: Both above and below the results -
Enable alphabetical index for individual and organization name
Display text: Last name index:
No records found message: Mo directory entries match your criteria
Linked profile page: -

Include a page link for: ¥ (applies to Individuals only)

Include a send message link for: < Specify User Networking Manager = - [l Allow messages to non-users

R N o R

2. Under Records to Include, specify the records to include in the directory's search results.

a. The Limit to query field displays the selected query of records included in the directory. By
default, “All Constituents” appears.

Tip: For a query to appear as a selection, you must first create it in The Raiser's Edge. When you

create a query, you may need to refresh the website for it to appear as a selection. To refresh, select
View, Refresh from the menu bar.

To include information from all constituents in your database, leave the default database "All
Constituents.” To select another existing constituent query to use as the directory, click

Change. The Query Search screen appears. For information about how to use the Search
screen, see the Program Basics Guide.

b. In the Include field, select the type of constituent records to include in the directory search
results. You can select “Both Organizations & Individuals,” “Individuals Only,” or
“Organizations Only.”

c. Toinclude deceased constituents in the directory search results, select Include Deceased.

3. Under Search Form, in the Split search fields into field, select how many columns of search
fields to appear in the criteria table. You can display up to five columns.

To process a search while the user browses your Directory part, select Load unfiltered results
when this part is loaded. When you select this checkbox, the directory search processes
before the user enters criteria and clicks Search on your website.

4. Under Results, set up how search results appear on your Directory part.

a. Inthe Show navigation controls field, select whether the navigation buttons should appear
above the results, below the results, or both above and below the results.
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b. The directory search can return up to 500 results that match the criteria entered by a site
user. In the Results per page field, select the maximum number of results to appear on a
page when a site user searches the directory. You can display up to 50 results per page.

¢. You caninclude in the search results the total number of records that met the user's search
criteria. In the Show number of results field, select whether to display the total number of
results above the results, below the results, or both above and below the results.

d. To display an alphabetical index so that website users can filter search results by the first
letter of last names and organization names, select Enable alphabetical index for individual
and organization name. Then in the Display text field, enter the field label to display
beside the alphabetical index.

e. Inthe No records found message field, enter the message to appear if no records meet the
search criteria the user enters to search the Directory on your website. By default, the
message “No directory entries match your criteria” appears.

f. Directory results can link to a page that contains a Profile Display part. In the Linked profile
page field, select the page to link to. The field you list first in the Listing Fields box
becomes the link to the page you select in Linked profile page field.

Note: When website users open profile pages from directory search results, a Back to search results
link appears at the top of the page.

To display additional education profile information, link to a page that includes a User
Education Profile Form part under a Profile Display part. A Profile Display part contains
primary education information such as Campus, GPA, and Major. The User Education Profile
Form part includes this information for all education records.

g. To allow website users to view Team Fundraiser or Personal pages for individual constituents
included in the results, in the Include a page link for field, select the Fundraiser or Personal
Page Manager part to link to the directory results.

h. To allow website users to send personal messages to constituents in the results, in the
Include a send message link for field, select the User Networking Manager part to link to
the directory results.

Note: If constituents opt out of email in The Raiser's Edge, website users can send them personal
messages through the user networking site, but they cannot send them email messages.

i. To allow website users to send personal messages through the User Networking Manager
part to constituents who are not registered website users or who are registered but are not
members of the user networking site, select Allow messages to non-users.

Warning: Constituents who do not have user networking accounts receive personal messages
through email. To allow users to send email messages to these constituents, you must enable a
Directory Message Notification in Email and select the User Networking Manager part for it. Without
this notification, your users will not be able to send messages to constituents who are not registered
website users or to constituents who do not have social networking accounts. For more information
about notifications, see the Email Guide.

5. Under Fields to Include, select the fields the user uses to search the directory, such as First
Name or Last name. Drag the field from the Available Fields box to the Search Form Fields
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box, or select the field in the Available Fields box and click the right arrow to move it to the
Search Form Fields box.

Fields to Include

Available Fields: A search Form Fields:
Bl &2 profile Fields

(3 Bio

[ Organization

[ Preferred Address

[ Phones and Email

[CRecord

[ 5pouse

[C | Business

[ Primary Alumni

[Z Education History

[C Constituent Attributes Listing Fields:
[ Primary Education Attributes
[ Education History Attributes

II

Note: The system administrator selects the attributes available on the Settings tab in Sites & settings.
For information, see the Administration Guide.

Note: The Education History and Primary Alumni search fields appear only if you use Alumni
Tracking in The Raiser's Edge. To allow website users to search only primary alumni information, use
the Primary Alumni search fields. To allow users to search primary alumni and education history at
the same time, use the Education History search fields and include the Alumni Info field.

To arrange the placement of a field in the Search Form Fields box, select the field and click
the Up or Down button.

Note: The fields in the Search Form Fields list and the Listing Fields list do not have to match.

6. Next, under Fields to Include, select the fields to appear in the directory display window.
Drag the field from the Available Fields box to the Listing Fields box, or select the field in the
Available Fields box and click the right arrow to move it to the Listing Fields box.

To arrange the placement of a field in the Listing Fields box, select the field and click the Up
or Down button.

Warning: The listing field you put first for results acts as a link to the constituent record. However, if,
on the Profile Form, the field's data is marked Privacy edit and the user selects to hide the data, no
link exists. For example, if you select to list First name first, and the user selects to hide First name
data, no link appears.
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While you can link every field, the field you place first in the Listing Fields box automatically
links to the page you select in the Linked Page field. For example, you select to display the
alumni’s last name, first name, birth date, and address. In this case, the last name is the link.
When results appear, to indicate the last name is a link, it is underlined and changes color
when you drag your mouse over it. When a website user clicks the alumnus's last name, the
published profile information for that constituent appears.

7. To allow website users to send personal messages through the directory, select Allow
messaging between users under Messaging Fields.

8. To enable anonymous messaging, select Allow users who are not logged in to send
messages.

Note: You must have reCAPTCHA enabled on your site in Administrator > Sites & settings to use
anonymous messaging. See reCAPTCHA settings for information on configuring reCAPTCHA.

If desired, configure the message's default text:
a. In Default subject, edit the text that displays in the subject line of the email message.

b. In Confirmation message, edit the text to display to the user after the message has been
successfully sent.

c. In From address, enter the sender's email address.

Note: To avoid having the email rejected or considered spam, the From address must be an email
address on a domain that the organiization owns and controls. This is necessary as some email
providers, such as Yahoo and AOL, have strict DMARC policies that reject any emails with a
yahoo.com or aol.com email address that have not originated from those domains.

d. In From name, enter the sender's name.

e. Configure the default email message and the default opt-out message.

Note: When messaging is enabled, an email icon (- ) displays in the directory's Messaging
column for users that have a primary email address and have not opted out of messaging. To send
a message, click - beside the recipient's name. The email is sent via the organization to the
recipient, and the recipient's email address is not visible to the sender. A confirmation message
displays when the email is successfully sent. Website users can send a maximum of 10 messages
per hour.

9. Click Save. You return to Parts.

Discussion Group

Select the Discussion Group part type to create an electronic bulletin board so website users can
participate in interactive discussions. For example, you can create a Reunion 2007 Discussion Group for
your alumni to plan events and arrange to meet with old friends. Website users can submit new topics
or add responses to existing topics in this electronic bulletin board. Your organization can create
multiple Discussion Group part types to post on your website.

If you have manager rights, you can approve and delete messages and topics posted to the website.
Additional buttons also appear on messages for discussion group managers. To block the content of a
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message without affecting replies to the message, click Block. To delete a message and all replies to
the message, click Prune.

2 Design Discussion Group

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Group Name field, enter the main topic of discussion to generate,
such as “Reunion 2007."

Discussion Group

Group Mame: | |:1:
Post New Topic Message: |Type your message using the form below. Then dlick the Preview
button to preview your post, or click the Post Topic button to
post your message immediately. .
Post New Reply Message: |Type a reply to the message using the form below. Then dlick the
Preview button to preview your post, or click Post Reply to post
your message immediately.
*®

[IrRequire approval for topics and messages added to this group

2. Inthe Post New Topic Message box, enter the message to appear on your website to provide
users with more information about the discussion topic. For example, enter “Post a new topic
for the Reunion 2007 discussion group. Feel free to start a discussion about a reunion event or
meeting with friends at your favorite old college hang-outs!”

Note: The website user's message box for postings is limited to 3000 characters.

3. Inthe Post New Reply Message box, enter the message to appear on your website for users
who post a message. For example, enter “Thank you for participating in the Reunion 2007
discussion! We look forward to seeing you on campus!”

4. If you select Require approval for topics and messages added to this group, topics and
messages posted by users with Can Manage rights appear on your website immediately. A
user with manager rights must approve other topics.

Warning: If you do not select this checkbox, all topics appear immediately on your website.

5. Under Security Rights, assign Manage rights to roles for discussion group users. To assign Can
Manage rights to a role, select its checkbox.



40 CHAPTER 1

Security Rights

Select which Roles will manage topics added to this discussion group. Managers may approve or delete
any topics added to this group.

Action User/Role Name Manage

Everyone F

= Add users and roles

DAIIDW Anonymous Posting

Choose a default display name for an Anonymous |
poster:

To include additional users and roles, select Add users and roles.

Note: Managers can approve or delete any messages and topics added to groups. Additional buttons
appear on messages for managers. To block the content of a message without affecting replies to the
message, click Block. To delete a message and all replies to the message, click Prune. For more
information about how to manage a discussion group, see Manage Discussion Group on page 41.

6. To allow users to participate in the discussion group anonymously, select Allow Anonymous
Posting. In the Choose a default display name for an Anonymous poster field, enter the

name to appear when an anonymous user posts on the discussion group, such as
“Anonymous.”

7. Under Spelling Correction, customize the messages on your website for users who participate
in the discussion group.
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Spelling Correction

Topic With Errors Message:

Your message contains spelling errors. Use the form below
to correct them. When you have checked your entire
message, click Post Topic to save your changes and post

the edited message. To continue editing your message,
click Gn Back /Edit

£
¥

Topic With Mo Errors Message:

Your message did not contain any spelling errors. Click Post
Topic to submit yvour message, or click Go Back/Edit to make
changes.

Reply With Errors Message:

Your message contains spelling errors. Use the form below
to correct them. When you have checked your entire
message, click Post Reply to save yvour changes and post

the edited message. To continue editing your message,
click Gn Back /Edit

£
¥

Reply With No Errors Message:

Your message did not contain any spelling errors. Click Post
Reply to submit your message, or click Go Back/Edit to make
changes.

a. Inthe Topic With Errors Message box, enter the message to appear if a website user posts
a new topic with spelling errors.

b. Inthe Topic With No Errors Message box, enter the message to appear if a website user
posts a new topic without any spelling errors.

c. Inthe Reply With Errors Message box, enter the message to appear if a website user posts
a response to an existing topic with spelling errors.

d. Inthe Reply With No Errors Message box, enter the message to appear if a website user
posts a response to an existing topic without spelling errors.

8. Click Save. You return to Parts.

2 Manage Discussion Group

If you are a user with Manage rights, you have additional options with the Discussion Group part
type. These options are available when you log in to your website with your manager role.

1. Using your manager role with Manage rights, log in to your organization's website.

2. Inthe upper right corner of your Discussion Group part, the View field appears. In this field,
select whether to view all postings, only approved postings, or only those postings pending

approval.

Note: If Require Approval for Topics Added to This Group is not selected on the Edit Part screen
for the discussion group, Approve does not appear on your website for users with manager roles.
However, the View field and Delete remain available.

3. Manage the messages and topics of the discussion group.

« To approve a message or topic, click Approve in the same row as the message or topic to
approve. This makes the information available for all website users to view and respond.
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» To delete a message or topic, click Delete in the same row as the message or topic to
remove. This permanently removes the information from the website.

 To block the content of a message without affecting replies to the message, click Block in the
same row as the message to block.

Note: When you click Block, the button changes to Unblock. To recover the message, click Unblock.

« To delete a message and all its replies, click Prune in the same row as the message to prune.
The program deletes only the selected message and its replies. Any messages posted in the
topic prior to the pruned message remain.

4. To return to the administrative side of the program, log out of the website or click Go to
Blackbaud NetCommunity on the toolbar.

Documents

Using the Documents part, you can easily upload documents of any type to a web page and share the
information. For example, you can upload a Microsoft Word document (*.doc file type) of your board
meeting minutes. You can include a message to appear on the website page that provides details

about the information the document contains. For your board meeting minutes Word document, you
can include "Board Meeting minutes from 05/05/2007. Please call the office if you have questions or

comments.”

The ability to upload documents is based on security rights. For example, users with manager rights
can approve and delete documents.

Note: If you do not want users to upload a document to a web page and want to create alink to a
document for users to access, use the HTML editor. For more information, see the Program Basics
Guide.

2 Design Documents
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select a folder in Files to store the documents. You can also create a new
folder on the Select Folder screen. The part displays all files in the folder.
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General
Select folder from Files:*

| Mo folder selected & Select a folder to store documents in Files. The part displays all files in the folder.

Title:

Message:

Upload button:

Maximum file size:
10240 KB To prevent possible Denial of Service attacks, we recommend you do not increase this value
beyond the default value. If you want to increase this limit, contact your Administrator.

2. Inthe Title field, enter a name to identify the documents on the web page. For example, enter
“Board Meeting Minutes.”

3. Inthe Message field, enter the message to appear on the web page. For example, you can
provide details about the documents or instructions for site users.

4. Inthe Upload button field, enter a label for the button that website users click to upload
documents to your website.

Tip: There is not a limit to the number of documents on your website. However, hardware space
limitations may constrain the number of documents you are able to store in the online database. The
more documents your website has, the more hardware space used.

5. In the Maximum file size field, enter the maximum size of a document to store on your site.
The size is stored in kilobytes. By default, the maximum file size is typically 4096 KB.

Warning: To prevent possible Denial of Service attacks, there is a limit to the size of the files you can
upload. The default is typically set to 4096 KB, but the system administrator can adjust it up to 10,000
KB. We do not recommend you go over this size. The administrator can specify this limit in the
Web.Config file. For example, to increase the file size, add maxRequestLength="8192" (where 8192 is
the file size) to the <httpRuntime useFullyQualifiedRedirectUrl="true" /> key. For very large files,
increase the website timeout setting. For example, to increase the timeout setting, add
executionTimeout="120" (where 120 is the duration in seconds) to the <httpRuntime
useFullyQualifiedRedirectUrl="true" /> key. Before you maximize the document file sizes or website
timeout settings, visit http://support.microsoft.com/?id=295626 and review the Microsoft
Knowledgebase article.

6. Specify whether uploaded documents require approval before they appear on your website.
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Require approval

« If you select Require approval, documents posted by users with Manage rights appear on

your website immediately. Other documents must be approved by a user with manager rights.

Note: To enhance security for your website, we recommend you select Require approval.

« If you do not select Require approval, all documents appear immediately on your website.

7. To limit the file types available to upload to your site, select Restrict by file type.

a. Under Common types, select the file type to make available on the site. To move the type
from the Common types box to the Allowed types box, click Add.

Restrict by file type

Common types:
-mpd I§
_mpeg
-mpg
_ppt
pptx
psd
qt

rif
swf
Xls
Xlsx

Zip E

Choose file types that users are permitted to upload.

Allowed types:

.doc

.docx

]|
jpeg

]

]

]

Add =

Jpg
pdf
-png
ba

< Remove

L
| Addall >>
|
|

== Remove all

[ Add additional types

b. To move all file types at the same time, click Add all. All file types move to the Allowed

types box.

8. To add file types not available under Common types, click Add additional types. The Add
custom file type screen appears for you to enter the custom MIME type.
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For information about how to enter a custom MIME type, see Add Custom MIME File Types on
page 45

9. Under Security Rights, specify the roles with manage and upload rights for the Documents
part.

Security Rights

Cnly legged in vsers can upload files.

Action User/Role Name Manage Upload

Everyone ] ]

* Add users and roles

a. Inthe Manage column, select the checkbox to assign manage rights to users and roles. This
grants rights to add, edit, and delete documents. If the part is marked Require Approval,
these users and roles can approve documents.

Note: If the part is marked Require Approval, documents are pending until a user with Manage
rights approves them. A user with Upload rights can view his or her pending documents, but not
those of other users with Upload rights. Only users with Manage rights can view all pending
documents.

b. Inthe Upload column, select the checkbox to assign upload rights for documents to users
and roles. This does not grant rights to edit or delete documents.

c. To include additional users and roles, select Add users and roles.
10. Click Save. You return to Parts.

Add Custom MIME File Types

On the Documents part when you select to restrict by file type, under Common types, 28 common file
types pre-populate for you based on the Internet Assigned Numbers Authority (IANA) MIME Media
Types standards. However, you can choose to add additional custom MIME types your organization
allows for upload. For each custom file type, you enter the MIME type, sub-type, and extension.

2 Add a custom file type
1. From the Design tab, select Restrict by file type.
2. Under Allowed types, click Add additional types. The Add custom file type screen appears.
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ﬁiHmp

Add custom file type

Add custom file type
MIME type:
application D

MIME sub-type:

Extension:

[ Add H Cancel]

3. Select the MIME content type.

Enter the MIME sub-content type. For example, for the application content type, you enter
msword, pdf, and postscript.

5. In the Extension field, enter the file extension for the sub-content type. For example, the file
extension for msword is .doc or .docx, the file extension for pdf is .pdf, and the file extension
for postscript is .ps.

6. Click Add. You return to the Design tab and the new custom file type appears under Allowed
types.

Donation Form

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

For a new Donation Form part, you select the constituent code, fund, and giving levels for web
donations. When you select a Donation Form part for your web page, a canned donation form appears
using the constituent code, fund, and giving level information you select.

The Donation Form part also contains an Acknowledgement screen. On this screen, you can create a
standard email to send to donors who donate via your website.

When you download gifts from your website, you can create gift records for the donations in The
Raiser's Edge. The gift records can include data such as amount, credit card number, billing address, an
option to give anonymously, and comments.

Note: To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or The Raiser's Edge, select Test Mode
on the Properties tab. For example, you can complete the fields on a donation form to ensure the
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confirmation page is styled and working properly. Although you submit the donation and receive a
confirmation, a transaction does not appear on the NetCommunity page in The Raiser's Edge. Use
Test mode to verify the user’s experience, not to test data processing. Test mode does not validate
credit card numbers and merchant accounts. Only users with supervisor rights can view parts in Test
mode.

Note: We recommend you design the page to include the same look and feel as your third party site
so that users seamlessly transition to the page.

« Design Donation Form: General and Donor Gift Schedule Options on page 47

» Design Donation Form: Donor Options on page 49

» Design Donation Form: Designations and Giving Levels on page 50

» Design Donation Form: Sources (Appeals) and Required Fields on page 51

« Design Donation Form: Additional, Spouse, and Attribute Information on page 52

» Design Donation Form: Payments and Pledges on page 52

» Design Donation Form: eCards on page 55

« Design Donation Form: eReceipts on page 55

2 Design Donation Form: General and Donor Gift Schedule Options

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

1. You can specify a constituent code to apply to new and existing constituents who use this part
to contribute and select the minimum amount the donor can enter.

a. Inthe Constituent Code field, select a constituent code to assign to donors.

For more information about constituent codes, see the Constituent Codes section of the
Program Basics Guide.

b. Inthe Minimum Gift Amount field, enter the minimum donation a donor can contribute.
Enter "0" or leave this field blank to allow donors to contribute any gift amount.

2. To allow donors to contribute a single gift and pay the total amount at the time of the
donation, select Allow one-time gifts under Donor gift scheduling options. A One-time gift
option appears under Type of gift on the donation form.

3. To allow donors to contribute regular recurring gifts, select Allow recurring gifts. A
Recurring gift option appears under Type of gift on the donation page. When a donor
selects Recurring gift, Frequency options appear.

To allow the donor to determine the frequency of the recurring gift on the donation form,
select General. Donors can select to make a contribution every week, month, quarter, or year.

To define the recurring gift schedules donors can choose, select Specific.
a. Select "Weekly,” “Monthly,” "Quarterly,” or “Annually” as the frequency.

b. Inthe On field, select a day or date donors can choose to schedule the gift.
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Tip: If a constituent donates a recurring gift and selects a start date that is not today's date, the
transaction downloads to The Raiser's Edge. However, the transaction is not sent to your bank
merchant when the donor submits the recurring gift. The merchant receives the transaction from
the batch output you send to your bank for processing from The Raiser's Edge. For more
information about bank merchants, see the Administration Guide.

C.
d.

To add the frequency to the donation page, click Add frequency.

Select Allow donor to enter ending date, if donors can specify when the recurring gift
ends.

Note: To add multiple frequency options to the donation form, enter each custom schedule and click
Add frequency to add the new schedule to the list. The selections you make appear in the
Frequency grid on the Donation Form part.

4. To allow donors to create a pledge and define a pledge installment schedule, select Allow

a.
b.

pledge installment gifts. An Installment option appears under Type of gift on the donation
form. When a donor selects Installments, a Number of Installments field and frequency
options appear on the donation form. Donors may enter up to “200” in this field.

To allow the donor to determine the frequency of the pledge payments on the donation
form, select General. Donors can select to make payments in weekly, monthly, quarterly, or
yearly installments.

To define the pledge installment schedules donors can choose, select Specific.

Select "Weekly,” “Monthly,” "Quarterly,” or “Annually” as the frequency.
In the On field, select a day or date donors can choose to schedule the installments.

To add multiple frequency options to the donation form, enter each custom schedule and
click Add frequency to add the new schedule to the list. The selections you make appear in
the frequency grid on the Donation Form part.

The program calculates the installment amount and end date based on the number of
installments, frequency, and date the donor specifies and displays this information on the
donation page. For example, a donor contributes $100 in four monthly installments and
selects to pay each installment on the first day of the month beginning January 1. This
generates four scheduled payments of $25 ending April 1. Installment payments do not
occur after the end date.

If a constituent selects a pledge installment start date that is not today’s date, the transaction
is sent to the merchant account when the gift is processed. For more information about bank
merchants, see the Administration Guide.

In the Minimum installment amount field, enter the minimum amount a donor can select
to pay for each installment. For example, if you enter “10,” in this field, when a donor selects
a pledge installment schedule, each pledge payment must be at least ten dollars.

You can enter a minimum installment amount to prevent donors from making small
payments over a long period of time. For example, if you do not enter a minimum amount, a
donor may pledge twenty dollars and choose to pay one dollar each month for twenty
monthes.

Note: You can configure the Transaction Manager part to allow payments toward outstanding
pledges. However, when a donor selects to pay a pledge in installments and submits credit card or
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debit card payment information at the time the pledge is created, the Pay link in the Transaction
Manager does not appear. The Raiser's Edge automatically charges the next pledge installment
payment to the account provided. For information about pledge payments in the Transaction
Manager, see Transaction Manager on page 215.

2 Design Donation Form: Donor Options

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Donor Options, select the options to make available to donors.

a. To allow a company to donate, select Allow corporate gifts. When you select this checkbox,
This donation is on behalf of a company appears on the donation form.

b. To allow donors to give anonymously, select Allow anonymous gifts. When you select this,
| prefer to make this donation anonymously appears on the donation form.

c. To allow donors to enter comments on the donation form, select Allow comments.

Information from the Comments field on the donation form downloads to the Attributes tab
on a gift record in The Raiser's Edge.

d. To allow donors to provide matching gift company information, select Allow matching
gifts. When you select this checkbox, My company will match my gift appears on the
donation form. Donors can select the checkbox and enter the company name in the
Company field. If you use MatchFinder Online, Look it up appears next to the checkbox.
Visitors click the link to access MatchFinder Online and search for the company.

Note: Blackbaud hosts the MatchFinder Online search page separately; it is not a page on your
Blackbaud NetCommunity website. Therefore, the page does not inherit the styles your site uses by
default. Blackbaud can apply styles from your Web Developers to the search page so it integrates
with your website. To contact Support about this, visit Blackbaud's website.

MatchFinder Online contains information about matching gift companies, such as the
minimum and maximum gift details and match ratio. It also integrates this data with The
Raiser's Edge. For information about MatchFinder Online purchasing options, send an email
to solutions@blackbaud.com.

For information about downloading matching gift information, see the “Download
donations - single transaction process” procedure in the Blackbaud NetCommunity & The
Raiser’s Edge Integration Guide.

For information about matching gifts in The Raiser's Edge, see The Raiser's Edge Gift Records
Guide.

Note: The program does not support matching gifts for pledges and recurring gifts.
2. To create a tribute section on the donation form, select Allow tribute gifts (one-time gifts
only).

Note: If you use Honor/Memorial Tracking in The Raiser's Edge, select the Allow tribute gifts
checkbox.

a. To allow the donor to enter the tribute information, select General.
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Select the checkbox for each tribute type to include in the tribute section. The tribute types
listed are entries from the Tribute Types table in The Raiser's Edge.

b. To have all tributes from the donation form go to a specific tribute, select Specific. When
you select this, Honor/Memorial appears with a Tribute field.

To select an honor or memorial individual, click Honor/Memorial. A search screen appears
so you can search for the individual.

In the Tribute field, select the tribute type and description to use. Information in this field is
from the Honor/Memorial tab in The Raiser's Edge. The selections are a combination of the
data from the Tribute type and Description fields.

c. To remove the Description field from the Tribute section on the donation form, select Hide
tribute description field.

If you select Hide tribute description, in the Tribute Introductory Text field on the
Language tab, you can enter the text to appear at the beginning of the Tribute section on
your donation form, such as “This gift is made in honor of someone special.”

d. If you select General so users can enter tributes themselves, you can select Display tribute
name fields as two fields (first/last name) to improve data entry. When you select this
checkbox, the Tribute section of the donation page displays First name and Last name
fields so donors can enter information.

Note: If you do not select Display tribute name fields as two fields (first/last name), the Full name
field appears in the Tribute section of the donation form.

e. Select Display acknowledgee name fields as two fields (first/last name) to create separate
name fields for the acknowledgee. When a donor selects Mail a letter on my behalf on the
donation page, the First name and Last name fields appear so the donor can enter an
acknowledgee.

Note: If you do not select Display acknowledgee name fields as two fields (first/last name), the
Full name field appears on the donation form when a donor selects Mail a letter on my behalf.

Note: When you include tribute information on your donor page, Mail a letter on my behalf
automatically appears on the page. When a donor selects this checkbox, name and address fields
appear for the donor to enter information for use in a tribute letter.

2 Design Donation Form: Designations and Giving Levels

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

1. Under Designations, click Add Designation to choose each fund donors can associate with
gifts. The Fund Search screen appears.

a. After you select a fund, in the Display Name field, enter the name of the fund to appear on
the website.

b. Select the Default checkbox for the fund to apply gifts to if donors do not select funds.


https://www.blackbaud.com/files/support/helpfiles/bestpractices/donationforms/donationform.htm

PARTS 571

2.

a.
b.

C.

To provide multiple funds for users to select from, click Add designation and repeat these
steps to create another entry. When you do this, the Support multiple designations
checkbox appears.

To allow users to write in funds other than those provided, select Allow other designation.

To include in the list the funds the donor has previously contributed to, select Include
donor’s prior gift designations.

If you select this checkbox, the list displays funds from the donor’s last 50 gifts.
To allow users to donate to multiple funds, select Support multiple designations.

When you select this checkbox, Add to Cart appears on your website. Similar to purchasing
items from a store, users select the funds to donate to.

Under Giving levels, to select a giving level for your donors, click Add giving level.

When you include giving levels and select Support multiple designations, each donation
made to a fund is considered for the giving level. For example, if a $500 donation is required
for Gold status, and a donor donates $250 to the 2008 Annual Fund and $250 to the Building
Equipment Fund, the donor does not receive Gold status. If the gift is one $500 donation to
the 2008 Annual Fund, the donor receives the Gold giving level status.

In the Display name field, enter the name of the giving level as it will appear on the website.
In the Amount field, enter the gift amount for the giving level.

To include a blank $ Other field on the Donation page, select Allow other amount.

2 Design Donation Form: Sources (Appeals) and Required Fields

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.

a.

Under Sources, to select an appeal for the gift, click Add source. With this information, your
organization can manage how donors learn about donating through the website.

To include an appeal, click the binoculars in the Appeal column. The Appeal Search screen
appears so you can select an appeal.

When you select source information, a How did you hear about our site field appears on
the donation page. In this field, users can select from the appeals you select in this step.

In the Display name field, enter the name of the appeal as it will appear on the website. By
default, the text entered in the Appeal Name field on the appeal record defaults in the
Display name field.

In the Default column, select the checkbox for the appeal to use when the user does not
select an appeal.

To hide an appeal from the How did you hear about our site field, clear the checkbox for
the appeal in the Display column.

When you do this, you can add source information to the end of a system generated URL in
an email that navigates the recipient to your donation page. For example, create a link to
your donation page in an email message. At the end of the system generated URL, add
&source=camp. When the recipient clicks the link, the How did you hear about our site
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field does not appear on the page. The appeal stores the source information automatically
based on the system generated URL.

Warning: To track source information this way, you must use a system generated URL. You cannot
use unique URLs or friendly URLs created by a user.

The source information must include the appeal ID from The Raiser's Edge. For example, if
the appeal ID in The Raiser's Edge is Annual2008, add &source=Annual2008 to the end of the
system generated URL. If the appeal ID includes a space, replace the space with a %20. For
example, if the appeal ID is CAMP LETTER add &source=CAMP%20LETTER.

If the Display checkbox is selected for the appeal and a user navigates to the donation page
via a URL without source information, the How did you hear about our site field appears on
the page.

e. To require users to select a source, select Source is a required field. If you select this
checkbox, you must select the Display checkbox for at least one appeal.

To add additional appeals, click Add source. Another row appears in the grid for you to
select another appeal.

2. Under Required fields, select the checkbox for each donor field to make required on the
donation form. To ensure you download complete constituent information, we recommend
that you make all of these fields required.

2 Design Donation Form: Additional, Spouse, and Attribute Information

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Additional fields, select the additional donor fields to include on the form.

a. Inthe Include column, select the checkbox for each additional field you want to appear on
the form. If you require a field, you must also include it.

b. In the Required column, select the checkbox for each additional field website users must
complete to submit the form.

Tip: We recommend you include Middle name so your organization meets the Canadian Revenue
Agency's requirements for donation receipts.

2. Under Attributes, select gift attributes to associate with the donation page.
Tip: The gift attributes that appear in this frame are created in The Raiser's Edge. After you process a
donation transaction, the attributes you select appear on the Attributes tab of a gift record.

3. In the Display column, select the checkbox beside the gift attribute to associate with the part.
To make the attributes required, select the checkbox in the Required column. To change the
text of the attribute on the donation page, enter the text to display in the Caption field.

2 Design Donation Form: Payments and Pledges

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Payment setup, select the payment options for website users.
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a. To allow website users to pay for multiple transactions at one time, select Use payment
part. The Payment frame appears. In the Payment page field, select the web page to use to
process donations. The Payment part on the selected page determines the payment
methods and merchant account used to process donations. For information about the
Payment part, see Payment on page 168.

In the box, enter the text to appear on the payment page after a donation is added. To
format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

b. To require website users to pay for donations one at a time, select Proceed directly to
payment. Additional frames appear for you to select merchant account, payment type, and
confirmation screen information.

2. Inthe Merchant account field, select the merchant account to use to process credit card
transactions received through the donation form, such as your organization’s IATS account. The
system administrator sets up merchant accounts in Administration. For more information, see
the Administration Guide.

3. Select the payment types donors can use to contribute to your organization.

Note: Donation forms that allow pledge payments must include credit card or direct debit as a
payment method. For information about how to accept pledge payments, see Transaction Manager

on page 215.
4. Select options for the donation summary that appears after a user submits a donation.

a. To use the program’s default confirmation screen, select Use default confirmation screen.

b. To customize a confirmation screen, select Use custom confirmation screen. The HTML
editor appears with the default confirmation screen. You can edit it as necessary.

In the box, edit the content for the donation summary. To format the appearance and layout,
use the HTML editor toolbar. To include personalized information, use merge fields. For
more information, see the Program Basics Guide.

Tip: Customizations for the confirmation screen remain even if you select Use default confirmation
screen. To remove your customizations for the screen, select Use custom confirmation screen and
click Restore default content. The program’s default confirmation screen appears in the HTML
editor for you to customize again.

5. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part T

Select how to display the consent options: @

Inline

® Overlay

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

6. Under Pledge payment, select whether to display information about the next installment on
the pledge payment donation form.

When donors access their giving history information with the Transaction Manager part,
certain pledges with an outstanding balance include a link to the selected Donation Form
page. Donors can use this link to enter a pledge payment. For information about how to link a
page that includes a Donation Form part to the Transaction Manager part so donors can pay
outstanding pledges, see Transaction Manager on page 215.

Note: If your organization accepts electronic fund transfer (EFT) payments and the donor selects to
pay a pledge in installments with a credit card or debit card at the time the pledge is created, the link
to the donation form page does not appear. The link also does not appear if the pledge currently has
a payment pending or if the pledge balance is zero.

Note: If a donor enters an amount greater than the installment amount due, the program
automatically applies the overpayment to the next scheduled installment. If the a donor enters an
amount greater than the total remaining pledge amount due, the program automatically creates a
new gift with the overpayment.

+ Select Show next installment due date for pledges to include information about the next
scheduled installment. When you select this checkbox, a donor who selects to pay an
outstanding pledge from the Transaction Manager can view the Current balance, Amount
due, and Due date fields on the donation form. If you clear this checkbox, these fields do not
appear.
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* In the Minimum pledge payment amount field, enter the minimum amount a donor can pay
toward an outstanding pledge. Enter “0" or leave this field blank to allow donors to enter any
amount.

2 Design Donation Form: eCards

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under eCard options, to associate an eCard with the donation web page, select Include
eCards. For more information about eCards, see eCards on page 66.

Note: When you edit a Donation Form part, click eCard Email to access the eCard design screen. You
can use the default text provided or enter different text.

2. Click Next. The Acknowledgement Email screen appears.

3. Create an acknowledgement email for website users who use the donation form to donate to
your organization. You can use the default text provided or enter different text.

Note: To include eReceipt information in an acknowledgement, use the eReceipt Number and
eReceipt Download URL merge fields. If you include the eReceipt Number field, a receipt number
is assigned to the donation. This number downloads to The Raiser's Edge. If you include the eReceipt
Download URL field, the eReceipt contains a URL to a saved copy of the eReceipt PDF. For
information about how to design the eReceipt, see Design Donation Form: eReceipts on page 55.

Tip: To access the Acknowledgement Email screen, click Acknowledgement Email when you edit a
Donation Form part. For information about how to design an acknowledgement, see the Email Guide.

4. To save the email, click Save. You return to the Edit Part screen.
5. Click Save. You return to Parts.

If receipt stack and number information exists for eReceipts on the Settings tab in Sites &
settings, Next appears. To create and design the eReceipt for the part, click Next.

2 Design Donation Form: eReceipts

After you create and design the eReceipt, a Click here to view your eReceipt link appears at the
bottom of the donation confirmation screen. To view and print a PDF of the eReceipt, donors click
this link.

1. From the Parts screen, select the Donation Form part for which you want to design an
eReceipt.

2. Inthe Action column, click Click here to edit this part. The Edit Part screen appears
displaying the Design tab.

3. Click eReceipt. The eReceipt design screen appears.

Note: To create eReceipts, you must establish the receipt stack and number information in Sites &
settings. For more information, see the Administration Guide.

4. Inthe eReceipt Options frame, select whether to create an eReceipt for a Credit card or
Debit card. You can create the eReceipt for both payment methods.
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5. To mark the gift as receipted when you download it to The Raiser's Edge, select the Mark gift
as receipted in The Raiser's Edge checkbox.

When you select this checkbox, the receipt stack and receipt number from Blackbaud
NetCommunity default in the Receipt Stack and Receipt no. fields on the gift record in The
Raiser's Edge. Also, the URL for a copy of the eReceipt pdf defaults as a gift attribute.

Warning: If you use the Canadian version of The Raiser's Edge, the Receipt Stack field appears on
the gift record. If you use the U.S. version of The Raiser's Edge, the receipt stack data does not appear
on the gift record.

Warning: The program does not create a receipt number unless you include the eReceipt Number
or eReceipt Download URL merge fields when you include eReceipt information in the
acknowledgement.

6. Inthe eReceipt Content frame, enter the text to appear on the eReceipt. If you include the
eReceipt Number field, the eReceipt contains the receipt number for the donation. To format
the appearance and layout, use the HTML editor. For information about the HTML editor, see
the Program Basics Guide.

To preview the eReceipt, click Preview PDF.
To save the eReceipt, click Save. You return to the Edit Part screen.

Click Save. You return to Parts.

Donation 2.0

The Donation 2.0 part is a Blackbaud NetCommunity donation form that provides a new simplified
checkout experience for campaign-based donations. The form has a modern, responsive HTML design
that automatically adjusts to the device size, such as a smart phone or tablet, on which the page is
being viewed.

When you create a Donation 2.0 part, you can customize the message displayed on the donation form,
specify suggested giving levels, select a single designation and appeal to associate with donations
made on the form, and customize the confirmation screen and email.

This new part allows donors to make a quick, basic donation by selecting a predefined giving level or,
if configured, to enter their own gift amount. Because the form uses PCl-compliant Blackbaud
Checkout, customers can be assured that credit card and merchant account information is processed
and stored on a Blackbaud-hosted secure server.

Digital wallet options are available on the Donation 2.0 part for BBMS customers only.

Visa Checkout and Masterpass are automatically available to donors as secure checkout options. Both
support the same currencies as BBMS: USD, CAD, GBP, and EUR.

Apple Pay is available to donors as a secure checkout option.

See the Blackbaud Checkout FAQs for more information.

You download and manage transactions from the Donation 2.0 part in The Raiser's Edge the same way
you download and manage transactions from the standard Donation Form. For information about how
to process donation transactions in The Raiser's Edge, see the Web Transactions Guide.


https://www.blackbaud.com/pci-compliance/
https://www.blackbaud.com/support/netcommunity/v7_1_2016/us/bbnc/index.html#SecureCheckoutFAQ.html
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For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

2 Design Donation 2.0

1. Under Donation form message, enter a custom message to display on the donation form.

Donation form message
Enter a custom message to display to website users on the donation form.

9« Formatting Insert View Image
& Cut Fontfamily =  Fontsize MR =R ® &4 Find and replace
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[ Paste <2 Remove formatting

Make a donation

Select your gift amount and click Donate Now.

Path: h1

The HTML editor shows the default message that displays on the donation form. You can use
the default message or customize the content according to your needs.

2. In the Designation section, select the funds from The Raiser's Edge that you want associated
with donations made using this form. The designations you specify display on the donation
form in a drop-down list that users can select from.

Click the binoculars, search for the funds from The Raiser's Edge, then select the one you want
to use.

For each additional fund to include, select Add designation, then browse to select the fund
and enter a Display Name. You can select a designation to use as the default when users don't
select one on the form. In the drop-down list on the form, the designations display in the

order shown on the Design tab. To change the display order, select a designation's iiiii and
drag it to the desired position. To delete a designation, select Remove.


https://www.blackbaud.com/files/support/helpfiles/bestpractices/donationforms/donationform.htm
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Designation

Set up the designation{s) available to donors when gifts are made. Click Add designation to add a new designation. Then, enter the Display Name
that donors will see and select its corresponding fund from The Raiser's Edge. Also, indicate which designation to use as the Transaction Default if
one is not selected by the donor.

Display name Fund Default
#3017 Annual Fund * Annual Fund - Library Services 8 * v
#E - Student Support * annual Fund - Student Support 4 * -

3. To include an option on the form enabling donors to make recurring donations, select Allow

4.

recurring gifts under Donor gift scheduling options. By default, all frequency options —
Monthly, Quarterly, Semi-Annually and Annually — are selected. If desired, you can clear
any of the frequency options that you don't want to include on the donation form. You can
also change the order in which the options display on the form and modify the name that
displays for the frequency type.

Donor gift scheduling options
Select which gift scheduling options to make available to donors on this Donation Form.

) Allow one-time gifts

1#| Allow recurring gifts Donor selects an amount that is applied on a specified freguency.

Select the frequency to include the option on the donations form.

Include Field Display Name
HH 4 Monthly Give every one month *
s 2 Quarterly Give every three months *
s 3] Semi-Annually Give every six months *
i ] Annually Give every year *

#! Allow donor to enter starting date

#! Allow donor to select when the recurring gift will end

You can also choose to include options on the form so donors can enter the start date and/or
end date for their recurring gift. Select Allow donor to enter starting date so enable users to
specify when they want to start their recurring donation by entering either the current date or
a future date. If you don't select this option, by default the starting date is the current date.
Select Allow donor to select when the recurring gift will end to enable users to specify
when they want to stop their recurring donation.

To include an option on the form enabling donors to indicate that they're making a corporate
donation, select Allow corporate gifts under Donor options. You can customize the option's
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caption that displays on the form by modifying the Corporate gift checkbox text on the
Language tab.

When donors select this option on the form, they must also provide the name of the company
on whose behalf they are making the donation.

5. To include an option on the form enabling donors to indicate they're making an anonymous
donation, select Allow anonymous gifts under Donor options. You can customize the
option's caption that displays on the form by modifying the Anonymous gift checkbox text
on the Language tab.

When donors select this option on the donation form, their donation is not recognized
publicly but their information is available to the organization. The Anonymous gift

subcaption default text — which you can modify — displays below the option to provide this
explanation.

Donor options
Select the options to present to website users on the donation form.

#| Allow corporate gifts

#| Allow anonymous gifts

Giving levels
You may set up one or more suggested giving levels for this Donation Form. Click Add giving level to add a new level. Then, enter the Display Name and its corresponding gift Amount.

Amount ($) Display name Default

25.00 * Remove
100.00 * v Remove
500.00 * Remove

Add giving level

#| Allow other amount Donor enters in the amount of the gift.

Minimum gift amount:
0 Specify the minimum amount that a donor must give. Enter 0 or leave blank for no minimum amount.

6. To enable donors to make a donation in honor of another individual, select Allow tribute
gifts to display configuration settings for the tribute section on the donation form.
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Allow corporate gifts

Allow anonymous gifts

¥ Allow tribute gifts

® Allow donor to enter tribute information(At least one tribute type must be added)

Tribute Type Display Name Make Default
= In Honour OF In Honour OF * i Remove
@i In Memory Of In Memory Of * Remove

331 In Special Recognition Of

In Special Recognition Of * Remove

Add Tribute Types

¥ Display tribute name as two fields (first/last name)

Use existing tribute record
Hide tribute description field

¥ Display acknowledgee name as two fields (first/last name)

o] 0 nts . r‘\ -

o To allow donors to enter their own information, select Allow the donor to enter tribute
information. Then, select Add Tribute Types and choose the types you want to include. The
tribute types listed are entries from the Tribute Types table in The Raiser's Edge. The tributes
types you select will display in a drop-down on the donation form. You can specify which tribute
type to display as the default, change the display names, or change the order in which the tribute
display in the drop-down.

When you select Allow the donor to enter tribute information, you can also select Display
tribute name fields as two fields (first/last name). When you select this option, the section of
the donation form displays First name and Last name fields so donors can enter information.

Note: If you do not select Display tribute name fields as two fields (first/last name), the Full
name field appears in the Tribute section of the donation form.

« To have all tributes from the donation form go to a specific tribute, select Use existing tribute
record. Then, select Search Honor/Memorial records to find records from The Raiser's Edge —
or you can search for an individual — and choose the record you want to use. You can then
select a Tribute Description from the drop-down. On the donation form, the individual's name,
tribute type, and tribute description display when donors specify that their donation is a tribute
gift.

You can remove the Description field from the Tribute section on the donation form by selecting
Hide tribute description field. Then, in the Tribute Introductory Text field on the Language tab, you
can specify alternate text to appear at the beginning of the Tribute section on your donation form,
such as “This gift is made in honor of someone special.”
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Select Display acknowledgee name fields as two fields (first/last name) to create separate name
fields for the acknowledgee. When a donor selects Mail a letter on my behalf on the donation page,
the First name and Last name fields appear so the donor can enter an acknowledgee.

Note: If you do not select Display acknowledgee name fields as two fields (first/last name), the
Full name field appears on the donation form when a donor selects Mail a letter on my behalf.

Note: When you include tribute information on your donation form, Mail a letter on my behalf
automatically appears on the page. When a donor selects this option, name and address fields appear
for the donor to enter information for use in a tribute letter.

7.

10.

To enable donors to provide feedback and comments on the donation form, select Allow
Comments. Users can enter comments or feedback using a maximum of 255 characters. You
can change the Comments caption that displays on the donation form by editing the text on
the Language tab. When the donation transaction is processed, the tribute information is
downloaded to the gift record in The Raiser's Edge.

Donor options
Select the options to present to website users on the donation form.

Allow corporate gifts
Allow anonymous gifts

Allow tribute gifts

#| Allow Comments

To add a giving level, click Add giving level, then enter the gift Amount (required) for the
giving level. You can also specify a Display name (optional) to show on the form for any of
the giving levels. To have a specific giving level preselected on the donation form, select the
corresponding Default option.

To add a giving level, click Add giving level, then enter the gift Amount (required) for the
giving level. You can also specify a Display name (optional) to show on the form for any of
the giving levels. To have a specific giving level preselected on the donation form, select the
corresponding Default option.

To remove a giving level, click Remove next to the one you want to remove.

To include a blank $ Other field on the donation form, select Allow other amount to allow
donors to contribute any gift amount. On the form, donors can enter the gift amount in the
Other field. In Minimum gift amount, enter the minimum amount that donors must give. To
specify no minimum amount, either leave the field blank or enter 0.

Under Appeals, select an appeal that you want to associate with all donations made using this
form. This field is optional.
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Appeal

Select the appeal to be associated with all denations made from this form. Note that the appeal can be overridden by the URL used to access the donation form.

Appeal

Direct Mailing 34 ¥ | Remove

Click Add Appeal, then click the binoculars. You can search for appeals from The Raiser's Edge,
then select the one you want to use.

To remove the appeal, click Remove.

You can customize the text that displays on the donation form for this option using the
Language tab.

11. Under Payment Setup, select the merchant account, such as your organization’s Blackbaud

Merchant Services (BBMS) account, to use to process credit card transactions received through
the donation form.

Note: All merchant accounts support the Donation 2.0 part except for iATS and IP Payments. iATS
and IP Payments will display as disabled in the Merchant account list.

Note: To take advantage of digital wallets like Apple Pay, Visa Checkout, and Masterpass, you must
use BBMS. If your merchant account isn't BBMS, the system administrator can set it up in
Administration. For more information, see the Administration Guide.

Payment setup

Merchant account:*

BBIS-BBMS Select the merchant account to use to process donation transactions.

12. Under Confirmation Screen, you can customize the message that displays to donors after
their donation payment is made.

Confirmation Screen
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The HTML editor shows default content you can use for the confirmation screen message. If
desired, you can customize it according to your needs. To format the content’s appearance
and layout, use the HTML editor toolbar. To include personalized information, use merge
fields. Note that Amount, Designation, and Appeal are the only merge fields that can be
displayed on the confirmation screen.

To remove your customizations for the screen, click Restore default content. The program’s
default confirmation screen appears in the HTML editor.

13. Optionally, under Additional payment fields, select Include to have a reCAPTCHA checkbox
display on your Blackbaud Secure Payments form below the credit card payment fields. Users
must select the reCAPTCHA checkbox before they can submit the form.

Additional payment fields
Select the additional payment fields to display on the Blackbaud Secure Payments form.

Field Include

reCAPTCHA @ v

14. Click Next. You can design the email acknowledgment that's sent when a donor completes
the payment transaction. You can select the fields to appear and format content appearance
and layout.

For information about how to design an email to acknowledge a payment, see the Email
Guide.

15. Click Save.

Blackbaud Checkout FAQs

Visa Checkout

> What is Visa Checkout?

Visa Checkout is a secure checkout option for donors accessing your website on any device. This
secure payment option allows donors to skip filling out lengthy forms usually associated with online
credit card transactions. For more information about Visa Checkout, visit https://usa.visa.com/pay-with-
visa/visa-checkout.html.

> What do | need to do to enable Visa Checkout?

Nothing! Visa Checkout is automatically an available option for all BBMS customers. And, there’'s no


https://usa.visa.com/pay-with-visa/visa-checkout.html
https://usa.visa.com/pay-with-visa/visa-checkout.html
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onboarding process required. Once you enable Blackbaud Checkout in Blackbaud NetCommunity, any
donor making donations through that donation experience will have the Visa Checkout option
available to them.

If you do not see the digital wallet options, you may not be using valid Blackbaud Payment Service
(BBPS) credentials in the BBMS Web Portal.

To confirm:

« Log in to the Web Portal at https://bbms.blackbaud.com.
« Navigate to the Virtual Terminal using the top menu.
« Select one of the two options, either Card Present or Card Not Present.

If you receive an error message, you need to update your credentials before the digital wallets will
appear on the checkout screen.

2 What does it cost our organization to offer Visa Checkout?

There is no extra charge to use Visa Checkout. All transactions are processed via Blackbaud Merchant
Services (BBMS) and are subject to the BBMS OneRATE.

2 Will all donors see the Visa Checkout option?

Any donor accessing the donation form you create that uses Blackbaud Checkout will see the Visa
Checkout payment option.

2 Do my donors need Visa to use Visa Checkout?

Visa Checkout works with Visa, MasterCard, American Express, or Discover credit or debit cards. Donors
can simply tap or click the Visa Checkout logo to enroll or make the purchase or donation.

2 Does Visa Checkout work on any device?

Visa Checkout works on just about any device that can access the web, so your donor will see iton a
smartphone, tablet, or computer.

Masterpass

2 What is Masterpass by Mastercard?

Masterpass is a secure checkout option for donors accessing your website on any device. This secure
payment option allows donors to skip filling out lengthy forms usually associated with online credit
card transactions. For more information about Masterpass, visit https://masterpass.com/en-us/.

2 What do | need to do to enable Masterpass?

Nothing! Masterpass is automatically an available option for all BBMS customers. And, there’s no


https://bbms.blackbaud.com/
https://masterpass.com/en-us/
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onboarding process required. Once you enable Blackbaud Checkout in Blackbaud NetCommunity, any
donor making donations through that donation experience will have the Masterpass option available
to them.

If you do not see the digital wallet options, you may not be using valid Blackbaud Payment Service
(BBPS) credentials in the BBMS Web Portal.

To confirm:

« Log in to the Web Portal at https://bbms.blackbaud.com.
« Navigate to the Virtual Terminal using the top menu.
« Select one of the two options, either Card Present or Card Not Present.

If you receive an error message, you need to update your credentials before the digital wallets will
appear on the checkout screen.

2 What does it cost our organization to offer Masterpass?

There is no extra charge to use Masterpass. All transactions are processed via Blackbaud Merchant
Services (BBMS) and are subject to the BBMS OneRATE.

2 Will all donors see the Masterpass option?

Any donor accessing the donation form you create that uses Blackbaud Checkout will see the
Masterpass payment option.

2 Do my donors need Mastercard to use Masterpass?

Any major credit or debit card can be added to the Masterpass account.

2 Does Masterpass work on any device?

Masterpass works on just about any device that can access the web, so your donor will see it on a
smartphone, tablet, or computer.

Apple Pay

2 What is Apple Pay?

Apple Pay is a secure checkout option for donors who access your website on a device that supports
Apple Pay.

Donors can use Touch ID or double-click an Apple Watch to provide their payment, shipping, and
contact information to securely check out with just one touch.

Offering this option provides your donors the simplicity of Apple Pay, while enabling your mission to
leverage increased user adoption and conversion rates.


https://bbms.blackbaud.com/
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2 How do | set up Apple Pay as a payment option?

The Apple Pay Early Adopter Program (EAP) is now closed and we are no longer onboarding any
clients.

2 What are Apple's Terms and Conditions for our donation pages?

To offer Apple Pay as a checkout option, you must adhere to at least the minimum required Terms and
Conditions by Apple.

If you implement the recommended method, you cover the minimum requirement as well.

Minimum requirement implementation

On a one-time donation form, display the Apple Pay payment mark next to other payment options.

The Apple Pay payment mark should be a link that directs the donor to the page that supports the
Apple Pay donation experience.

Recommended implementation

On the homepage, include the detection code recommended by Apple to determine if the donor is
on a device that supports Apple Pay. If the donor is on an Apple device and has set up Apple Pay, when
they click the Donate button on the form, they'll be redirected to the page that supports the Apple Pay
donation experience.

Contact Blackbaud for assistance, if needed.

2 What does it cost our organization to offer Apple Pay?

There is no extra charge to use Apple Pay. All transactions are processed via Blackbaud Merchant
Services (BBMS) and are subject to the BBMS OneRATE.

2 Will all donors see the Apple Pay option?
No, only donors using an Apple Pay-enabled environment will see the option.

Donors who access your page from another environment can make a payment using a credit or debit
card.

eCards

With the eCards part, your organization can enable website users to browse, personalize, and send
eCards to others from your website. An eCard is an electronic greeting card that contains content from
a selected template. Your users can send an eCard as an email message or as a printed copy in the mail.
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eCards can promote your organization and drive new visitors to your website to help build your online
community. You can offer eCards as a free service for your website users or as an incentive to donate
to your organization.

On your website, the eCards part includes multiple screens to step the user through the process to
select, personalize, and send an eCard.

« Choose - On this screen, the website user selects the template to use to create an eCard. When you
design the eCards part, you select the available eCard templates and how they appear on your
website. Before you can add a template to the eCards part, the template must be available in eCard
Templates. For information about eCard Templates, see the Email Guide.

+ Confirm — After the website user selects an eCard template, this screen displays a preview of the
selected template to verify it is the one to use to create an eCard. The website user can select to
continue to create the eCard or return to the previous screen to select another template.

Note: When you design the eCard template, you can use merge fields to create additional content to
appear when the preview of the template appears. For example, you can display a watermark you
create over the preview of the eCard to prevent users who attempt to copy and send the free preview
of the eCard to avoid a donation.

» Personalize — On this screen, the website user enters the recipients and email addresses to receive
the eCard. The user can also enter a personal message for the recipients, select whether to send or
print the eCard, and request to receive copies of the eCard email messages the program sends to
each recipient.

« Preview - On this screen, the website user can view a preview of the personalized eCard before
the program sends it. The website user can continue to send the eCard or return to the previous
screen to adjust its personalization. From this screen, the user can print or generate a portable
document format (*.pdf) file of the eCard preview. If the user logged in to your website and you
do not require a donation to send an eCard, the website user also sends the eCard from this screen.

« Send - If the user is anonymous or did not log in to your website, this screen appears. To help
prevent automated abuse of your website, the Send screen provides a completely automated
public turing test to tell computers and humans apart (CAPTCHA).

Note: The eCards part requires a completely automated public turing test to tell computers and
humans apart (CAPTCHA). Visit http://recaptcha.net/ to obtain free CAPTCHA functionality with
reCAPTCHA. When you sign up for reCAPTCHA, you receive public and private keys, which your system
administrator must enter on the Settings tab in Sites & settings. Without CAPTCHA functionality, you
leave your website vulnerable to automated abuse. For more information, see the Administration
Guide.

« Donation - If you require a donation from a user who sends an eCard, this screen appears. On this
screen, the website user enters information about the donation. When you design the eCard part,
you select the options that appear on this screen. After the website user completes the donation,
the confirmation screen or Payment part page you select when you design the eCards part appears.

« Finish - If you do not require a donation to send an eCard, this screen appears to thank the user
and confirm the program sent the eCard. From this screen, the user can select to print or generate
a *.pdf file of the sent eCard. The user can also select to create another eCard.

Tip: To create reports about the eCards your users send through your website, design a Report
(Email) part. For information about the Report (Email) part, see Email Reports on page 73.
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2 Design eCards

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: eCards do not apply to the web.config setting BlockScheduledEmails. Therefore, if you have
this setting set to True to prevent email from sending from a test environment, recipients will
continue to receive them.

1. From the Design tab, under Available eCards, browse the eCard template categories in eCard

Templates and select the templates to make available to website users. The templates you
select here appear on the Choose screen of the eCards part on your website.

Available eCards

Select which eCard templates from =ach category will be available to website users.

|_B[Mo category] - 0 templates
| JHoliday - 1 template

| >

Select all | Select none

Holiday 2008

Happy Holidays!

<

Note: eCard Templates provides the eCard templates that appear under Available eCards. To add a

template to an eCards part, the template must be in eCards Templates. For information about how to
create an eCard template in eCard Templates, see the Email Guide.

2. Under Display options, enter how the selected templates appear on the Choose screen of the
eCards part on your website.
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Display options
Select whether templates will be selected from a single listing that spans all categories, or a listing for each
category.

Specify the status of the survey:

@ Display the templates in a single listing
© Display the templates in separate listings by category

Select whether the personal message field will be plain text or rich text:
@ Plain text
@ Rich text

Enter the maximum size for template thumbnails.

Maximum height (px):=®
150

Maximum width (px):*
150

Sender and recipient options

Maximum recipients:
5 Enter the maximum number of recipients per eCard. This number
must be between 1 and 100.

Select whether to display sender and recipient name fields as single or separate fields:

@ Display all as single fields
@) Display all as separate first and surname fields

[ require ecard recipient's name

a. Select how the selected eCard templates appear on the part's Choose screen on your
website.

To display all the eCard templates together, select Display the templates in a single listing.

To display the eCard templates by category, select Display the templates in separate
listings by category. When you select this option, your website users can browse for a
template by its category.

b. Select whether the personal message field on the part’s Personalize screen on your website
generates plain text or rich text.

Note: All email clients can easily read the plain text format, but it does not allow users to adjust the
text’s color, font, or format. With rich text, users can adjust the text's format and embed pictures and
links, but not all email clients can easily read the rich text format. Email clients that do not support the
rich text format convert the text to the plain text format.
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C.

In the Maximum height and Maximum width fields, enter the maximum size, in pixels, of
the thumbnail preview image of each template.

3. Under Sender and recipient options, you determine the maximum number of eCard

a.

recipients and whether to provide first and last name fields for senders and recipients.

In the Maximum recipients field, enter the maximum number of recipients for an eCard. You
can allow website users to send eCards to a maximum of 100 recipients.

To provide one name field for the sender and one name field for recipients, select Display
all as single fields. To provide First name and Last name fields for both the sender and
recipient, select Display all as separate first and last name fields.

To require website users to enter first names for eCard recipients so merge fields are not
blank, select Require eCard recipient's name.

4. To require website users to make a donation to send an eCard, select Require a donation.

The options for the Donation Form part appear. For information about these options, see
Donation Form on page 46.

Under Donation options, select Require a donation to associate gift attributes with eCards
for the part, under eCard Attributes, select attributes in the Send date, Recipient first name,
and Recipient last name fields. Each field creates its own attribute in The Raiser's Edge.
Website users do not view these attributes on the donation page.

Warning: If your eCard allows for multiple recipients and you select an attribute for the Recipient
first name and Recipient last name fields, only the first recipient name information in the recipient
list downloads to The Raiser's Edge. If the user enters one word for a recipient name, it downloads as
the recipient first name attribute.

8.

When you download a donation, some gift attributes can automatically add to the gift record.
These attributes include NetCommunity Comments, NetCommunity Corporate Donation
Contact, NetCommunity Email Source, NetCommunity Email Source ID, NetCommunity Page,
and NetCommunity Page ID. You do not view these gift attributes in the Attributes frame or
on the NetCommunity page in The Raiser's Edge. After the gift downloads, you can view the
information on the gift record.

When website users send an eCard, the recipient receives an email message with the
personalized content from the selected template or a link to a web page that contains the
content. To create the email message for the eCards this part generates, click eCard Email. The
eCard Email screen appears.

For information about how to create an eCard email message, see the Email Guide.

To customize the messages and labels that appear for the eCards part on your website, select
the Language tab. For information about the Language tab, see Lanqguage Tab on page 17.

Click Save. You return to Parts.

Email Forwarding Form (Deprecated)

Note: The Email Forwarding Form part is now deprecated. While the deprecated part continues to
operate for backwards compatibility on your website, you can no longer create or copy Email
Forwarding Form parts.
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With the Email Forwarding Form part, website users can establish an email address that never changes.
With this part, users can sign up and create a lifelong email address that is forwarded to an address
they select. If their address changes, they can change the forwarding address and other users never
know and do not need to keep up with changes. To configure your organization’s email forwarding
email domain, review the Technical Requirements document provided by Blackbaud Professional
Services.

Note: The program shares email forwarding data between the Email Forwarding Form part and the
Email Forward tab on a user record in Users. On the Email Forward tab, you can set up address
forwarding information for a website user. The website user can change the addresses from the Email
Forwarding Form part on a web page. For information about the Email Forward tab, see the Users &
Security Guide.

2 Design Email Forwarding Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter a name to identify the Email Forwarding form.
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2.

Email Forwarding part

With the Forwarding Form, website users can create a lifelong email address that includes your
organization’s domain name. Messages sent to the lifelong address are forwarded automatically to another
email address the user specifies. If their primary address changes, the user can change the forwarding
address on the lifelong account and avoid notifying others about the change of address.

Title:
Email Forwarding Enter the title to display above the Email Forwarding form, such
as "Create a Lifelong Email Address.”

Help message:
Enable email forwarding. Enter the tooltip message to display when the user moves their
mouse cursor over the enable email forwarding option.

Enable caption:
Yes, | want email forwarding. Enter a caption for the enable email forwarding option.

Select this option to allow users to edit the lifelong email
Clallow users to edit address address. If vou do not select this option, they must use the
address provided by your organization.

After update navigate to:
#h Select the page users are redirected to after making updates.

In the Help message field, enter the tooltip message to display when users move their mouse
cursors over the enable email forwarding option.

In the Enable caption field, enter the text to appear on the website for the checkbox users can
select to enable email forwarding. By default, "Yes, | want email forwarding.” appears.

To allow users to create their own forwardable email addresses, select Allow users to edit
address. When a user edits an email forwarding address, the program creates a Profile Update
transaction for the user.

In the After update navigate to field, browse to the page you want to appear for website
users after they update their email forwarding. If you do not select a page, the home page
from the Settings tab in Sites & settings appears by default.

Click Save. You return to Parts.
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Email Reports

Using the Report (Email) part, you can create reports about email sent through the website.

Email Revenue Summary — The Email Revenue Summary displays the amount of donations collected
through a link in the email to a donation page. Website users can filter the report results by date range,
message type, and revenue type.

Email Activity Report — The Email Activity Report displays details for each email sent including the
email title, type, sender’'s name, and date sent. Other details include the number of opened and
bounced emails, and the number of page visits generated by each email. The report also contains a bar
graph that shows the total number of opened, bounced emails, and page visits for all emails included
in the report. Website users can filter the report results by email type, date range, and action.

Note: After you add the part to a page and send emails through the website, the report automatically
generates results when you access the page.

This table explains the items included in the Email Activity Report.

Type Type of message sent — Email, Acknowledgement, Newsletter,
Fundraiser, Chapter, Personal Page, Campaign Appeals, and Scheduled

Sent Number of emails sent

Opened Number of emails sent that were tracked as opened
Bounced Number of emails sent that were not delivered successfully
Page Visits Number of web page visits generated by a link in the email

2 Design Email Reports

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Report Type field, select the type of report to create. Select Email
Revenue Summary or Email Activity Report.

To view a pop-up preview of the report, click on the report type.
2. Inthe Report Title field, select the title to use for the report.
 To use the report’s name for the title, select Default.
« To enter a custom report title, select Other and enter the title in the field.
3. To display the report title above the report, select Show Report Title.
4. To save the report, click Save and Close. You return to the Report (Email) design screen.

5. Click Save. You return to Parts.
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Email Signup Form

The Email Signup Form part allows website users to sign up to receive email communication from your
organization. After users complete the form, the program creates sign up requests in The Raiser's Edge
so you can add their information to your constituent database. You use this part if your organization
sends recurring emails from Messages and you want to allow users to sign up to receive them, but not
register for the website. When you configure the form, you include the constituent attributes from The
Raiser's Edge that correspond to the lists you generate for recurring messages.

Note: The email sign ups create database constituent records, not website user records. The program
only creates website user records when users sign up through the User Login, Personal Page Manager,
or Fundraiser parts. It is possible for constituents to inadvertently complete the form multiple times,
so we recommend you clear the Send a unique email to each constituent who shares the same
email address checkbox in Sites & settings. When you clear the option, you prevent sending the same
messages to duplicate constituents. For information about the checkbox, see the Administration
Guide.

To configure the form, select the fields to appear and the constituent attributes to associate with the
new records. Also select the page to appear after users submit the form and, if necessary, a constituent
code to automatically apply to records.

When you select the fields, the Email Address and Last Name fields are required and selected by
default because they are the minimum required fields to subscribe a new constituent to emails in The
Raiser's Edge.

When you select the attributes, you select whether to display them on the form. Typically, you display
attributes when you have multiple options and you want users to subscribe to emails that match their
preferences. When you do not display attributes, the program automatically associates the attributes
you select to new records. Constituent attributes are not required to configure the form, but we
recommend you include them to comply with email opt-in best practices.

Note: When registered website users who are logged into your website complete the form, the
program automatically populates their biographical information. The form adds constituent attributes
to their records, but does not remove previous selections. To allow existing users to update their
preferences, we recommend you include the User Email Preferences Form part on your website.

In The Raiser's Edge, you can look at the transactions for Sign-up Requests to see who subscribed to
emails from your organization. In the Sign-up Requests Transactions window, use the new Email Sign
up Transactions filter to view all transactions that originated from the email signup form. If there's no
existing constituent, you can create a new constituent for linking, and then process the transaction. The
constituent's information and any attributes entered on the email signup form are saved in the
constituent record in The Raiser's Edge.

> Design Email Signup Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Fields, select which fields to include on the signup form and
whether they are required. The Last Name and Email Address fields are required and are
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selected by default because they are the minimum required fields to subscribe a new
constituent to emails in The Raiser's Edge.

Fields
Select the fields to include in your form.
Include Field Name Label Required
HiH (] Title 1 |T|t|e 1 | O
G @] First Name [First Name | -
i 5] Middle Name [Middle Name | -

i 5] Maiden Name [Maiden Name | -

HHH i Last Name

..... |Last Name | ‘
e 7 Email Address |Emai| Address | T
HHH (] Confirm Email Address |Confirm Email Address | ()]
HHH o Formatted Address |Formatted Address | ]
G 5] Home Phone [Home Phone | -
i @] Gender [Gender | -
aaz2: (] Class of

|Class of | a

BEE ] School Name |School Name |

B |} Birth Date |Bir‘th Date | -

i o Constituent ID

|Constituent D | (]

You can change the order in which the fields display on the form by clicking the field's row
and dragging up or down in the list.

2. Under Attributes, select Include for each constituent attribute you want to display on the
form, and specify if it is a Required field. Typically, you display attributes when you have
multiple options and you want users to subscribe to emails that match their preferences.

Note: All the constituent attributes you select in Sites & settings with a type of Yes/No are available,
but we recommend you only include those your organization uses for recurring emails sent from
Messages.

Attributes
Select the constituent attributes to display during the user registration process.
Constituent attribute options View a video tutorial
Include Field Name Label Required
i O Availability |Availability | O
e O Origin [Origin | u

3. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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Note: Communication consent options are only visible to anonymous users — the options do not
display on the Email Signup form for logged-in users.

a.

7.

a.

Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part v

Under Consent part, select a saved Communication Consent part to include on the form.
This part can only be included inline on the Email Signup form and not as an overlay.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

Optionally, you can select Enable reCAPTCHA login to display reCAPTCHA on the form or
specify a Constituent Code to apply to users who sign up using the form.

Under Constituent code, select a constituent code to apply to new records.

Under Navigation, select the web page to display to users when the form is completed. Click
the binoculars to display the list of pages on your site to choose from. This field is required.

reCAPTCHA

¥| Enable reCAPTCHA login Select this option to display reCAPTCHA on the Email Signup form.

Constituent Code

Select which constituent code you will apply to users who sign up through this form.
Constituent Code:

Added in Blackbaud NetCommunity v

Navigation

Select the page that will appear after a user completes the sign up form.

MNavigate to:*
Home x|

et R N P VP SR S an SO NP Y

Configure the confirmation email that displays after users complete signing up.

Click New Signup Confirmation Email, then configure the email for your organization.

The Name of email, Subject, From address, and From name fields are required.

b. Edit the default text for the email message.
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The Raiser's Edge, their communication consent preferences are written directly to their
record in The Raiser's Edge.

8. Click Save. You return to Parts.

Event Calendar

You can use the Event Calendar part to add a calendar to your website. Event Calendar parts can:

» Act as standalone calendars. For example, the academic departments at your school manage their
own calendars on your website. Each department can create and maintain a separate Event Calendar
part for its calendar.

« Work as sub-calendars that feed events to a larger organizational calendar. For example, your
website has a main calendar that lists events for all areas of the school. With the Event Calendar
Group part, each departmental calendar can feed events from their Event Calendar parts into the
main calendar for the school. For more information about Event Calendar Groups, see Event
Calendar Group on page 82.

When you include events from The Raiser's Edge on your website event calendar, you can also publish
registration links to the website calendar directly from the corresponding Event Registration Form
parts. For more information about how to publish event registration links, refer to Design Event
Registration Form on page 95.

You can use Event Calendar part properties to manage who views and manages each calendar. For
example, a school may have a sub-calendar of faculty events that only users assigned to Administrator
or Faculty roles can view or edit. You can also use Event Categories to manage the types of events
added to the calendar and who manages them. For example, a soccer calendar may have categories
such as Registration, Practice, and Games, and only users in the Coaches role have rights to add, edit, or
delete events in these categories.

Calendar managers can create recurring events. When you edit recurring events, the manager can select
whether to change all occurrences in the series, only the selected occurrence, or all future occurrences
in the series including the selected occurrence. When you change an occurrence of an event, you
cannot later make that occurrence part of a recurring series.

Calendar managers can select a time zone for the event. If an event does not have a time zone, the
logged-in user's time zone setting determines the date and time displayed for the event. For
anonymous users or any user who does not have a time zone specified, the event displays the time and
date based on the system’s setting. If your website users are all in the same time zone, we recommend
managers leave the time zone field blank. If your website users are in multiple time zones, we
recommend you set the time zone to the user’s setting.

When you enter an address for the event, you can select to include a Google or Yahoo! map link to the
location. On the Events screen, you can click Preview map under Event Information to verify that the
location you entered is correct. Calendar managers can also use the HTML editor to add pictures and
hyperlinks to the event listing and to format text.

To cancel an event, a manager can select Mark Canceled. In the List View and Calendar Highlights, the
event title is appended with “- Canceled.” In the Calendar View, the event name is struck through. For
the calendar weblog, “Update” or “Removed” is added to the title, and readers who subscribe to the
calendar weblog receive an updated calendar event posting through their RSS feed.
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Website users have four views of the calendar: the Calendar View, the List View, Published Events, and
Event Details View.

» The Calendar View displays a large monthly calendar. Dates with scheduled events are colored and
list the events that occur that day. Users can click Filter Events to customize the categories of
events that appear. Event names are hyperlinked so users can click them to read more information
about the event. In this view, icons indicate whether an event is recurring, occurs in a time zone, or
lasts longer than one day.

» The List View displays a list of all the events scheduled for the selected period of time. Event
names are hyperlinked so users can click them to read more information about the event. Users can
filter events by date or click Filter Events to select the types of events to view.

« If you enable the RSS (Really Simple Syndication) Event Publishing capabilities, calendar managers
can post “stories” in a weblog form with details about upcoming events. Site users click Published
Events to view the calendar weblog. Posted events also appear in site search results. Website users
can subscribe to the RSS feed so they receive updates in their RSS reader about upcoming events.

« The Event Details View is the page that appears when a website user clicks on an event in the
Calendar View or List View. It displays the details for the selected event.

In the Calendar View, List View, and the Event Details View, users can click Print View to open a
window displaying the printer-friendly version of the calendar or event.

Also in the Calendar View, List View, and the Event Details View, users can click Export as iCalendar to
export events in the iCalendar format (*.ics) so they can be opened in other calendar programs, such as
Microsoft Outlook or Apple iCal. The export file includes only the events appearing currently in the
calendar; if the calendar is filtered, filtered out events are not exported. If an event is time zone
specific but not recurring, the event time is converted to UTC time in the export file. If an event is time
zone specific and recurring, the export file includes the event time zone as well as the daylight savings
rules for that time zone. The export file includes any *.html event descriptions but does not include
event graphics. In the Event Details View, additional buttons appear so users can add the single event
to their Windows Live, Google, or Yahoo! calendars.

Note: When using a version of Microsoft Outlook older than version 7, users should save the exported
*ics file to their local machine and use the Import an iCalendar file function in Outlook. If users with
an older version attempt to import by double-clicking the saved *.ics file, it imports only the first
event and discards any others. Users with Outlook 7 can double-click the saved *.ics file to import all
events with no issues.

In the Calendar View and List View, users can click Import Events to add multiple events to the
calendar at one time. On the Select import file screen, in the File field, users browse to a *.csv file that
contains header columns and the values to import. Only the Start Date, End Date, and Title fields are
required, but the import file can include values for all fields that appear on the Add Event screen,
except Recurrence.
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Map imported fields

Import Field
Event Category
All Day Event
Time Zone

Start Date

Start Time Hour
Start Time Minute

Start Time AM PM

EventCategory %
AllDayEvent b
TimeZaone hd
StartDate b
StatTimeHour  +
StartTimeMinute
StatTimeAMPM »

File Field

RSPV SEORY SR SR Y TS ¥ s

After selecting the import file, the user must map the import fields to those in the program. However,
if the *.csv file's column headers use the same names as the corresponding fields in Blackbaud
NetCommunity, the program automatically maps the import file fields to the event fields.

Note: You can import data for all event calendar fields, except Recurrence. After you import the *.csv

file, you can manually set an event's recurrence.

Use the table below to set up *.csv files with values the program can automatically map to the
corresponding event fields in Blackbaud NetCommunity.

Field Name Field Values

Event Category Enter a category for the event. Your entry must match a category you
previously created on the Code Tables page in Administration,

All Day Event Enter “Yes” or “No,” “True"” or "False” to indicate whether the event

will last the entire day.

Time Zone Enter the geographical location associated with the time zone where
the event occurs, such as “Chicago” or “Los Angeles,” so the start and
end times accurately reflect the scheduled time of the event for a
viewer in a different time zone.
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Field Name

Field Values

Start Date

Start Time Hour

Start Time Minute

Start Time AM/PM

End Date

End Time Hour

End Time Minute

End Time AM/PM

Title
Subtitle

Location

Map Link

Details

Fees

Contact Info

More Info URL

Enter the start date in any standard date format. For example, you
can enter January 1,2011 as “01/01/11" or “1/1/2011." This field is
always required.

Enter a whole number for the hour. If you entered “No"” or “False” in
the All Day Event column, this field is required.

Enter “0,” “15,” "30,” or "45." When you manually create an event in
Blackbaud NetCommunity, you must enter this time in fifteen-minute
increments. If you entered “No” or “False” in the All Day Event
column, this field is required.

Enter "AM” or "PM." If you entered “No” or “False” in the All Day
Event column, this field is required.

Enter the end date in any standard date format. This field is always
required.

Enter a whole number for the hour. If you entered “No” or “False” in
the All Day Event column, this field is required.

Enter “0,” “15,” “30," or "45.” When you manually create an event in
Blackbaud NetCommunity, you must enter this time in fifteen-minute
increments. If you entered “No” or “False” in the All Day Event
column, this field is required.

Enter “AM” or "PM.” If you entered “No” or “False” in the All Day
Event column, this field is required.

Enter the name of the event. This field is always required.
If the event has a subtitle, enter this information.

Enter the address for the event. If you plan to include a Google or
Yahoo! map link, enter the street address, state, and zip code so the
program includes accurate directions to the event'’s location.

If you entered a location for the event, you can enter "Google” or
"Yahoo" as the web mapping service. After you import the event, a
Map link appears next to the location in the event'’s details.

Enter information about the event.

Enter the fees associated with the event as a number ($10.00) or as
text (ten dollars).

Enter a contact name or email address.

Enter the URL that includes additional information about the event.
This entry appears as a More info link when you open the event from
the calendar.
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2 Design Event Calendar

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, refer
to Create and Edit Parts on page 10.

1.

From the Design tab, under General options, enter a name for the calendar in the Calendar
title field.

Under Default display, select the default view of the calendar. You can select Calendar view
or List view. Website users can always select a different view when they open the calendar.

To integrate the calendar with events that have been created in The Raiser's Edge, select
Include events from The Raiser's Edge. Click the binoculars to select an existing event query
in The Raiser's Edge. When you include events from The Raiser's Edge on your website event
calendar, the events appear after the next integration. To integrate the calendar with events
from the query, include frequency information under The Raiser's Edge integration in
Administration. The calendar updates according to the frequency unless you click Refresh
events to immediately integrate the calendar with events. For information about frequency
settings, refer to the Administration Guide.

Tip: We recommend that you add an event attribute to the event records in The Raiser's Edge that
you want to display on your website event calendar. You can then create an event query for events
with that attribute.

4. Under Uncategorized events management rights, select the roles with rights to manage any

events not associated with a category.

Under Event Categories, select the event categories to associate with the calendar. After you
add a category, click Assign rights to the category. The Event Category Security screen
appears so you can assign rights to users and roles for the event category. For example, a
Soccer calendar may have the Registration, Practice, and Games categories, and only users in
the Coaches role can add, edit, or delete events in these categories. Also, when the coach adds
a new event, they can assign its category from those you select for the calendar. For example,
the coach specifies whether the new event is Registration, Practice, or Games. You can use
these categories to filter the types of events that appear in calendar groups and calendar
highlights. For example, you can set a calendar highlights part to display only events included
in the Game category. For information about how to add event categories, refer to the
Administration Guide.

To include a weblog for the Event Calendar part, select Enable RSS. Additional fields for the
weblog appear.

In the Date format field under Appearance, select a date format for the weblog.
Under RSS publishing properties, in the Title field, enter a title for the weblog.

In the Link URL field, enter a website address news readers can use to link to the calendar
weblog. Also, if your website has a News Reader part, add this link to your news reader so it
displays new events when they are posted. For more information about the News Reader
part, refer to News Reader on page 147.

d. Inthe Description field, enter a description for news readers about the types of events

posted on the calendar. For example, if your organization supports the environment, enter
“Upcoming Local and National Events Supporting the Environment.”
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e. Inthe Copyright field, enter a copyright notice for the weblog, if you have one.

f. In the Editor’s email field, enter the email address for the person responsible for the content
of calendar postings.

g. To approve weblog posts before they appear on your site, select Moderated.

7. To add a picture to the calendar weblog, click Select Image under Image properties. The
Select Image from Image Library screen appears. For information about how to insert an
image, refer to the Program Basics Guide.

8. Inthe Link URL field, enter the web address to open when a user clicks the image. The link can
access another page on your site or an outside website.

9. Under Security rights, define the roles with post and manage rights for the published events.

a. Inthe Post column, select the checkbox to assign post rights for users and roles allowed to
post to the weblog. This does not include rights to edit or delete postings.

Note: If the list is marked Moderated, posts are pending until a user with Manage rights approves
them. A user with Post rights views his or her pending posts, but not those of other Post users. Only
users with Manage rights view all pending posts.

b. Inthe Manage column, select the checkbox to assign manage rights for users and roles
allowed to add, edit, and delete weblog postings. If the list is marked Moderated, this
grants rights to approve postings.

c. Toinclude additional users and roles, select Add users and roles.
10. Click Save. You return to Parts.

Event Calendar Group

You can use the Event Calendar Group part to create a top-level calendar that receives events from
smaller sub-calendars. For example, the academic departments, athletic department, and alumni
association at your school each maintain a calendar on your website. Your website also has a main
calendar that includes events for all areas of the school. In this scenario, the departments and alumni
association create their own calendars with the Event Calendar part. You can then create an Event
Calendar group for the main school calendar and assign the department and alumni calendars as sub-
calendars of that group. For more information about the Event Calendar part, see Event Calendar on

page /7.

2 Design Event Calendar Group

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in Calendar group title field, enter a name for the calendar group.

2. Under Pick source calendars, select the calendars to include in this group. You can choose
from any calendars created with the Event Calendar part.

a. Inthe Display column, select each calendar to include in the calendar group.
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b. Inthe Color column, select a color for events included in the selected calendar. When a user
views the calendar group in the List View or the Calendar View, hyperlinks to events included
in the selected calendar appear in the selected color. For example, if you select red for the
soccer calendar, all hyperlinks to soccer events are red.

c. Inthe lIcon column, select an icon for events included in the selected calendar. The program
resizes the selected image to 16x16 pixels automatically. Icons appear next to the hyperlinks
to events included in the selected calendar. For example, if you select a soccer ball for the
soccer calendar, a soccer ball icon appears next to all hyperlinks to soccer events in the
calendar group.

3. Under Pick category filters, select the categories of events to use in the calendar group. For
example, if this is a school’s main athletics calendar, you could include only the Game
category. This would filter out any events included in other categories from the selected
calendars, such as practices or scrimmages. You create Event Calendar categories on the Code
Tables page in Administration.

4. Click Save. You return to Parts.

Event Calendar Highlights

You can use the Event Calendar Highlights part to display short descriptions of upcoming or prior
events on any web page. The part displays event names, dates, and times, and it may also include links
to the event calendars where users can view more details about the events. You can select the
calendars that feed into the highlights and when to include the events.

2 Design Event Calendar Highlights

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Pick source calendars, select the calendars to include in the
calendar highlights. You can choose from any calendars created with Event Calendar parts.

In the Display column, select each calendar to include in the calendar highlights.

In the Color column, select a color for events included in the selected calendar. When a
website user views the highlights, the titles of events from the selected calendar appear in
the selected color. For example, if you select red for the soccer calendar, the titles of all
soccer events are red.

c. Inthe lIcon column, select an icon for events included in the selected calendar. The program
resizes the selected image to 16x16 pixels automatically. Icons appear next to the event
titles. For example, if you select a soccer ball for the soccer calendar, a soccer ball icon
appears next the titles of soccer events in the calendar highlights.

2. Under Pick category filters, select the categories of events to use in the calendar highlights.
For example, if this is the school’s main athletics calendar, you could include only the Game
category. This would filter out any events included in other categories from the selected
calendars, such as practices or scrimmages. You create Event Calendar categories on the Code
Tables page in Administration.
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3. Toinclude a section that displays highlights of upcoming events, under Additional options,
select Show upcoming events.

a. Inthe Upcoming events title field, enter a title for the upcoming events section.

b. Inthe Show next field, select the period of time to include events in the display, such as
events that occur within the next 5 days or next month.

4. Toinclude a section that displays highlights of previous events, select Show recent events.
a. Inthe Recent events title field, enter a title for the recent events section.

b. Inthe Show last field, select the period of time to include events in the display, such as
events that occurred within the previous 5 days or previous month.

5. To include the Print View button on the highlights display, select Show print view button.
When website users click Print View, a window appears displaying a printer-friendly version
of the event highlights.

6. Inthe URL for more information field, enter a URL to another page on the website or to a
separate site that contains more information about events. If you add a URL, More
Information appears on your website.

7. Click Save. You return to Parts.

Event Registration Form

If you use The Raiser's Edge Event Management, use the Event Registration Form part to allow website
users to register for events online. When you create an Event Registration Form part, you can select to
include one or more event records from The Raiser's Edge on the part. After users submit event
transactions online, you can download registration information directly to the event record.

Note: This new Event Registration Form part includes improvements such as organization registration,
enhanced free event support, and an optimized registration experience. The original Event
Registration Form is now called Event Registration Form (Classic) and it remains available. Consider
using Event Registration Form (Classic) when your event requires a shopping cart (Payment 2.0 part
integration).

Note: We recommend you design the page to include the same look and feel as your third party site
so that users seamlessly transition to the page.

Event Registration Steps on Your Website

When you place the Event Registration Form part on a web page, registration options appear on three
separate pages. Each page includes a status bar so website users can view their progress as they
complete the event registration process. Users can return to the previous or next page by clicking the
button in the status bar.
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Step 1 Step 2 Step 3
Selection Registration Payment

Note: The Step 3 Payment button appears when a user selects a paid event type on the Step 1
Selection page and then clicks Continue.

Step 1 Selection — The first page of the event registration process displays event details from The
Raiser's Edge such as the descriptions, start dates, and times for events. Website users select events to
attend and the number of registrants, and if you include a field for donations, they can also make
additional gifts. The summary of the user's selections at the bottom of the page dynamically updates
as the user enters information.

If the Event Registration Form is configured to do so, website users can optionally select to register as
an organization. This allows users to make multiple ticket purchases for the same event. In The Raiser's
Edge, the payment for the event is tied to the organization.
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Step 1 Selection l Step 2 Registration

= Afternoon Tea
Saturday June 20 ) 2:00 PM-5:00 PM

We will be meeting af the playground site for & brief meeting and infroduction. We will then be taking the shuttle
to Cobblestone House for tea and desserts

I 0 ) —

Child
Pl $50.00
Adult =
PR e 2 57500

= Winter Ball
Monday December20 () 5:00 PM-9:00 PM

Winter Ball to be held st the People's Palacs

Corporate Sponsor

p 3225.00
s r gt
Individual - ,
S raciadea 2 5100.00
Event registration summany
Aftermoon Tea Adult 2 57o.00
Winter Bail Individual 2 $100.00
Total: $350.00

" Register as an organization
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Step 2 Registration — On the second page, website users enter details for all registrants. This includes
entering contact information and selecting registrant options that are participant attributes in your
database. For example, a registrant may select a T-shirt size or a diet preference for your event.

To copy contact information, users can select the Use this address for all registrants checkbox and
click the Apply to all registrants link for certain fields. After users enter registrant information for an
event, links for the registrants appear on the next event, and users can click the links to autofill
registrant information.

If users select Register as organization, the Step 2 Registration page displays with the Organization

information fields that were configured on the Event Registration Form part. If users forget to register
as an organization on the Step 1 Selection page, they can click Register as an organization? at the top
of the Step 2 Registration page and the applicable organization registration fields appear on the page.

Users can click Register as individual? if they did not intend to register as an organization on the Step
1 Selection page.

In the following screenshot, you can view the checkboxes and links that allow users to autofill
additional registrant information.
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Step 1 Selection

Step 2 Registration

Step 3 Payment

Afternoon Tea
Saturday June 20 2:00 PM - 5:00 PM

Cobblestone House for tea and desseris

Register as an organization?

We will be meeting at the playground =ite for a brief meeting and introduction. We will then be taking the shuttle o

-

Afternoon Tea
Registrant 1 - Adult

Address
Country:
United States  |»| ™
Address lines:
124 Maple Street -

City:

Charleston

State:
ES

ZlP:

El:&

|25492

2 Use this address for all registrants

2 Usze this as my billing information

First name: Last name: Apply to all registrants
Elizabeth Smith *
Email: Apply to all reqistrants Phone: Apply to all registrants
ssmithi@abc 123.0rg

Afternoon Tea
Registrant 2 - Adult

[ Register later (The guest can provids this information when checking in to the event.)

B8 Use this as my hilling information

Firzt mame: Last name: Same az above
Julian Smith

Email: Same a2 above Phone: Same a3 above
j=mith@@abc 123.0rg
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In the following screenshot, you can see that in addition to the checkboxes and quick links that are
available on the first event, the next event also includes links for previously entered registrants. When
users click these links, registrant information autofills in the registrant's box.
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Winter Ball

Monday December 20 5:00 PM - 9:00 PM
Winter Ball to be held at the People's Palace

#

Winter Ball

Registrant 1 - Individual
Same as a previous registrant?

Elizabeth Smith Julian Smith

First name: Last name: Apply to all regisfrants
Elizabeth Smith

Email: Apply to all regisiraniz Phone: Apply to all regisirants
esmithi@abc123.0rg

Address
Country:
| United States  [» | ™

Address lines:
124 Maple Street p

City:
Charleston

State:

|sc ==
ZlIP:

20462

=3 Use thiz addrass for sl registrants

i_ Use thiz as my billing information

Winter Ball

Registrant 2 - Individual
Zame as a previous registrant?

Elizabeth Smith Julian Smith

i Register later (The guest can provide this information when checking in to the event.)

First name: Last name: Same az above
Julian Smith

Email: Same as above Phone: Same as above
jemith@@abc123.0rg

1 Use thiz a3 my billing information
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Winter Ball

Monday 19 December 19:00 - 02:00
Winter Ball to be held at the People's Palace

e

Winter Ball

Registrant 1 - Individual
Same as a previous registrant?

Elizabeth Smith Julian Smith

First name: Last name: Apply to all registrantz

Elizabeth Smith

Email: Apply to all registrants Phone:
esmithi@abec123.0mg

Apply to all registrants

Address
Country:
| | *

Address lines:

City:

' Use this address for al registrants

o Usze thiz as my hilling information

Winter Bzl
Registrant 2 - Individual

Same as a previous registrant?

Elizabeth Smith Julian Smith

r Register later {The guest can provide this information when checking in to the event.)

First name: Last name: Same as above
Julian Smith *
Email: Same as above Phone: Same as above
jemithgbabe 123.0rg

r Use this as my hilling information
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When you select to include participant attributes for an event type, users select these options for each
registrant for each applicable event on the page.
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w‘hmeHWWV

-

Winter Ball
Registration options

Regisrant 1:
Handicap:

Shirt Size:

Diatary Preference:

"] LowFat

] Low Sodium
[l vegan

- Vegetarian
[] Diabetic

Regisrant 2:
Handicap:

Shirt Size!

Diatary Preference;

| Low Fat

L] Low Sodium
] vegan

|| Vegetarian
[] Diabetic

-

Event registration summary
Afternoon Tea: Adult
Winter Ball: Individual

Total:

575.00
5100.00

£350.00
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Winter Ball
Registration options

Regisrant 1:
Handicap:

Shint Size:

Dietary Preferanca:

"] LowFat

[ Low Sodium
[ vegan

[ Vegetarian
[C] Diabetic

Reqgisrant 2;
Handicap:

Shirt Siza:

DCietary Preference;

| Low Fat

L] Low Sedium
] vegan

|| Vegetarian
[ Diabetic

=

Event registration summary

Aftermoon Tea: Adult
Viinter Ball: Individual

Total:

2 £75.00
2 £100.00
£350.00
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Step 3 Payment — On the third page of the event registration process, the program renders the
secure payment page on the Blackbaud server to process transactions for event registration payments.
When website users select multiple events with multiple charges, the total cost automatically defaults
on the secure payment page. For information about the secure payment page, refer to Secure Payment

Page on page 178.

Step 1 Step 2 Step 3
Selection Registration Payment

amount: 150.00 ot

Email: Mame on card:
Phone: Card number:
(D HSCo
Country: v m{;?u- _r_\-: m VisA
Address: Expiration: month ¥ year - C5C: 1_[__]
City:
State & 28 v
o |

I'm not a robot

Cancel Complete payment

Note: When you include free events on the part and a website user registers only for free events, this
page does not appear.

2 Design Event Registration Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, refer
to Create and Edit Parts on page 10.

Show Me: Watch how to create an event reqgistration form for complex events.

1. From the Design tab, to publish a link to the registration form directly on your website event
calendar, select Publish to online event calendar. When you select this, a Register Now
button appears when visitors on your website view an event on the online calendar. For more
information about the website event calendar, refer to Event Calendar on page 77.

2. To select an event to use for the part, click Add an event under Add events. The Event Search
screen appears for you to select an event. After you select one, the Edit configuration screen
appears.


http://www.blackbaud.com/files/support/guides/demo/redirects/bbisAlumniEventRegistration.aspx
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a.

b.

Event configuration: Alta Tennis Tournament

Event display options

Name:#
Alta Tennis Tournament Enter the event information to appear on the web page.

Description: #

This year's tournament will be held at the Garfield Tennis Center.

Select this option to use the event capacity from The Raiser’'s Edge as the

[ use event capacity . o
& ’ registration limit. The event's capacity is 1000.

Event price options
Select the event types to include on the web page and enter information for each type. The types appear on the page in the
same order that they appear in the arid. To reorder them, drag the dotted button.

Type Include Name Price Mo. registrants @
HH . Group = Group §50.00 5
#i 7 Foursome Foursome $40.00 4
B Individual Individual $20.00 1

In the Name and Description fields, enter the event name and event description to appear
on the web page. This information defaults from The Raiser's Edge event record, but you can

change it for the web page.

To use the capacity from The Raiser's Edge as the maximum number of registrations the
form can accept, select Use event capacity. Under Sold out message, enter the text to
appear after all the registrations are reserved. If you do not configure a message, the
program uses a default.

Note: The sold out message appears when the number of processed and unprocessed
registrations in The Raiser's Edge and the number of in-progress registrations online are greater
than the event capacity on the The Raiser's Edge event record.

The program reserves in-progress registrations after users complete the Step 1 Selection
page of the form. For each additional step, the program indicates the length of time users
have to submit their information before it releases the reservations to other users. The
program also releases registrations when users return to the Step 1 Selection page.

Note: When website users select to process payments by credit card, they must submit
information within 10 minutes on the Step 2 Registration page and 15 minutes on the Step 3
Payment page. If users need to return to the Step 2 Registration page from the Step 3 Payment
page, then the form continues the 10 minute timer. When users select Bill Me Later, they must
submit information for the Step 2 Registration and Step 3 Payment pages within 10 minutes.

C.

Under Event price options, the event's types, names, and prices default from The Raiser's
Edge event record. In the Include column, select the types to make available on the web
page. In the Name column, enter the type name to appear on the page. In the No.
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registrants column, enter the number of registrants for the type. For example, enter "2" for a
Couple type. Next, click the arrow beside the type. In the Description field that appears,

enter a type description to appear on the page. For example, you can enter VIP package
information.

Tip: You can enter HTML in the Description fields to format and style text. For example, enter
"<i>Family</i> packages include <b>5</b> tickets and <b>free</b>admission to the hospitality
room" so that "Family packages include 5 tickets and free admission to the hospitality room"
renders on page.

To limit the availability of an event type, click the arrow beside the type and select Limit
date availability. Specify the dates and times for it to appear on the web page. For example,
create an event type with a discount price for individuals who register early and indicate the
date to remove it from the web page. To inform website users of the dates the event type is
available, enter them in the event's Description field under Event display options.

For information about the event record, refer to the The Raiser's Edge Event Management
Data Entry Guide.

d. Under Registrant options, the price types for the event appear. For each event type you
include, select the arrow beside it to include fields and participant attributes for the type.

Note: Types in these grids appear as the original default regardless of your selections in the Event
price options grid. For example, when you remove a type or reorder the list in the Event price
options grid, it does not affect the types in this grid. If you do not include a type in the Event
price options grid, disregard it in this grid.
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Registrant options

To select registrant options for each event type you include on the web page, dick the arrow beside it. Types in this arid appear
as the original default regardless of your selactions in the Event price options grid. For example, when you remove a type or
reorder the list in the Event price options grid, it does not impact the types in this grid.

Type

-

Group

To allow the person who pays to register additional registrants as anonymous,

St select this checkbor

Field options

Include Field Caption Required
#iE [ Participant  1te Title Participant
Guest Guest
#i ¥ partiipant  First Name First Mame Participant
*| Guest Guest
HiE ¥ participant  Last Name Last Mame ¥ Participant
¥ Guest ' Guest
""" Participant ~ Email Email Participant
Guest Guest
#i @ partiipant  Address Address Participant
¥ Guest Guest

Additional options

Include Field Caption Required
#5 O participant Seg_l_:_ia_l__ﬂequest Special Reguest Participant
Guest o Guest
T! Individual

e. To allow users who pay to register additional registrants as anonymous, select Allow
anonymous. When you select this, a Register later checkbox appears on the web page for
each additional registrant. When users do not know who is attending the event, they select
the checkbox and the biographical fields and participant attributes remove so the
registration page does not require the information.

f. Under Field options and Additional options, select the biographical fields and participant
attributes to appear on the web page in the Include column. To change the text to appear
on the web page, enter it in the Caption field and to make it required, select its checkbox in
the Required column. To reorder a field or attribute in the list, click and drag the dotted
button on the far left.

Tip: Constituent attributes are not available for the Event Registration Form. You can only select
one-per-record participant attributes with a type of Date, Text, Number, Currency, and Yes/No.
Table type participant attributes are available without being marked as one per record. Fuzzy Date
and Constituent Name types are not available for the part. If you recently added a new participant



ParTs 99

attribute in The Raiser's Edge and it does not appear in the Participant attribute options grid or
in Sites & settings for you to make it available on the web page, click Refresh code tables in Code
tables. This updates code tables from The Raiser's Edge in Blackbaud NetCommunity. For more
information about how to update code tables, refer to the Administration Guide.

g. To save your event options and return to the Design tab, click Save.

You can use this part for more than one event. To add another event to the form, click Add an
event and repeat these steps.

3. To include an attendee list for an event:
Note: Before configuring the Event Registration Form part, you first need to specify a participant
attribute in The Raiser's Edge to use for tracking attendee list opt-ins. This participant attribute

must have a type of Yes/No. In Administrator, Sites & settings, on the Settings tab, select Enable
the attendee list for events and then specify the desired participant attribute.

a. Under Add events, select the Include Attendee List checkbox for the event.

b. Under Attendee List options, clear Registrants will be opted in by default if you do not
want users to automatically be included in the attendee list.

c. From the drop-down list, select the Directory Page to use for the attendee lists.

The attendee list is implemented using the existing Directory functionality. You should set
up one directory part with the desired fields, add it to a page, and then use that same
directory page for all attendee lists across multiple event registration forms.

Once you've included the Event Registration Form part on a web page, you can click Copy
Link to copy the attendee list URL for the event and publish it elsewhere on your website.

d. Click the Language tab, then select Registration in the Category drop-down to edit the
default text for the Attendee list link and the Attendee list -- opt-in option that display on
the Event Registration Form.

The attendee list link displays on the Event Registration Form above each event. When there
are multiple events, a corresponding attendee list link displays for each event. However, you
can't customize the link name per event; the same text displays for all events.

4. Under Fund, click the binoculars to select the fund to associate with the event.

5. To select additional information for the part, click Options.
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a.

W Options

Total registrants

Maximum registrants available per checkout:

50

Select constituency

Apply a constituency to registrants:

Additional donations

Allow additional donations

Under Total registrants, enter the maximum number of registrants to allow a user to enter
on your website during a single transaction. You cannot enter a number greater than 50.

Under Select constituency, select a constituency to apply to registrants. For more
information about constituent codes, refer to the Program Basics Guide.

Under Additional donations, to include an additional contribution field on the event page,
select Allow additional donations. In the grid that appears, click the binoculars in the Fund
column to select a fund. In the Display name column enter the fund name. To include a
Designation field so participants can select from a list of funds, click Add designation and
select a fund for each option. In the Default column, select the checkbox for the fund to use
when the user does not select a fund. The gift links to the participant’s constituent record,
but not to the event record.

To include the Gift Aid option, select Allow Gift Aid capture. The Gift Aid option displays
beneath Make an additional donation on the Event Registration Form. If desired, edit the
default caption, checkbox text, and confirmation text for the Gift Aid option using the
Language tab.

Note: When you enable Gift Aid, ensure that you select a different fund for the additional
donation than the one used for the event registration fee. Otherwise, the gift will include the full
amount of the event registration fee plus the additional donation. Since event registration fees are
exempt from Gift Aid, your organization won't be able to claim any Gift Aid for the donations.

Note: You can allow users to select from a list of up to twenty-five designations.

d. Under Organization options, select Allow individual to register on behalf of organization

SO users can register as an organization. In the grid below, select the fields to appear on the
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web page in the Include column. To change the text to appear on the web page, enter it in
the Caption field and to make it required, select its checkbox in the Require column.

When you allow organization registration, the person who pays the registration fee links to
the organization in The Raiser's Edge.

Note: In the corresponding batch in The Raiser's Edge, two new columns are included for the
organization: Organization name and Linked organization auto-match. In Web Transactions >
Configure Integration, on the Auto-match tab, you can specify matching criteria for the batch to
auto-match and update the Linked organization auto-match column. After you commit the
batch, the Registrations tab on the Event record displays the organization record.

e. Under Free events, select whether to display the Price column and enter text to appear in
place of the price.

Free evenis

The part displays prices in the Price column. For free events, select whether to display the column and enter text to
appear in place of the price.

When every type you include for the event is free, select Hide
[ Hide column column to remove the Price column from the page. If one or more
types for an event have a fee, the column cannot be removed.

Enter the text to appear in the Price column for free events. For

[ Display text example, you can enter "Free.”

Enter the text to display for free event prices.

To remove the column from the page when every type is free, select Hide column. If one or
more types for an event have a fee, the column cannot be removed. To enter your own
custom text, select Display text. In the field below, enter the text to appear in the column
for free events. For example, you can enter “$0" or “Free.”

f. Under Additional fields, select the additional fields to include on the form. In the Include
column, select the checkbox for each additional field you want to appear on the form. If you
require a field, you must also include it. In the Required column, select the checkbox for
each additional field website users must complete to submit the form.

Note: When you select Hide column and a website user selects all free events on the Step 1
Selection page of the event registration process, prices and the total amount also do not appear on
the selection summary at the bottom of the Step 1 Selection and Step 2 Registration pages.

6. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part T

Select how to display the consent options: @

Inline

® Overlay

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

7. Under Payment options, select the payment options for website users.

Payment options

Merchant account: *
BBMS Gateway |Z| Select the merchant account to use to process event transactions.

Select at least one payment method for event registrants to use.

Credit Card

[Clrledge (Bill me later)

a. Inthe Merchant account field, select the merchant account to use to process credit card
transactions received through the event registration form, such as your organization’s
Blackbaud Merchant Services account.

The system administrator sets up merchant accounts in Administration. For more information,
see the Administration Guide.

b. For the payment method, select Credit Card, Pledge (Bill me later), or both payment
options.

When you select to include pledges, a Bill me later checkbox appears on the Step 2
Registration page. When a user selects it and navigates to the Step 3 Payment page, the user
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enters biographical information for billing purposes, but the credit card fields do not appear
so the transaction submits successfully.

Note: When a website user selects Bill me later on the Step 2 Registration page, the Step 3 Payment
page does not render the program's secure payment page because a credit card payment is not
included in the transaction.

8. Select whether the default confirmation screen or a custom confirmation screen displays the
summary after a user registers for an event.

Specify whether to use the default acknowledgement page or a custom one.

‘2! Use default confirmation screen Use custom confirmation screen

The default acknowledgement page will be used.

If you select Use custom confirmation screen, the HTML editor appears and displays the
default confirmation screen. Customize the default confirmation screen according to your
needs. To format the content’s appearance and layout, use the HTML editor toolbar. To
include personalized information, use merge fields.

The date and time merge fields do not display schedule information for events with a
category of Class in The Raiser's Edge. As you design your confirmation screen for classes, we
recommend you enter schedules in the content.

Tip: If you customize the default confirmation screen, the customizations remain even if you later
select Use default confirmation screen. To remove your customizations for the screen, select Use
custom confirmation screen and click Restore default content. The program'’s default confirmation
screen appears in the HTML editor.

9. Click Next. The Acknowledgement Email screen appears.
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Name: |Evem Registration Acknowledgement |*
Subject: |Event Registration Acknowledgement |*
From Address: | |* From Name: |*
L Formatting Insert View
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10. Create the email to acknowledge the registration. You can use the default text provided or
enter different text.

The date and time merge fields do not display schedule information for events with a
category of Class in The Raiser's Edge. As you design your event acknowledgement for classes,
we recommend you enter schedules in the content of your email.

For information about event registration loop merge fields, refer to Event Registration Loop
Merge Fields on page 115.

You can design your email to include a link to the event that populates the registration page
with the recipient's biographical details such as name, address, phone number. To do this,
select Use email links to autofill forms in Sites & settings and make sure the message's query-
based email list uses Constituents as the data source. When a recipient navigates to the event
from the email, the recipient's name appears as a link on the registration page. The recipient
clicks the link to autofill the biographical details. For more information about how to use an
email to autofill a form, refer to the Administration Guide.

Tip: When you edit an Event Registration Form, you can click Acknowledgement Email to access the
Acknowledgement Email screen.

11. Click Save. You return to Parts.

Event Registration Form (Classic)

Note: The original Event Registration Form is now called Event Registration Form (Classic). This part
still exists for you to use on your website, but we encourage you to use the Event Registration Form
on page 84. There are a few features the Event Registration Form (Classic) includes that the new Event
Registration Form part does not, such as Payment 2.0 part integration and the ability to link to
another page from the event. You may want to consider this when you create the new part.
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To allow website users to register for events online, you can create event registration forms. You can
link your online and offline events and download online registration information directly to event
records.

Note: If you use The Raiser's Edge Event Management, use the Event Registration Form part type.

You can set up the event registration form so that when members register for events online, their
relationships from The Raiser's Edge appear as available participants, making online registration easy
for members and adding personal details to their registration forms.

When the Event Registration Form part is added to a web page, the registration options appear on
separate pages. You can include a status bar for the user to view their progress while they complete
the event registration process.

« Step 1: Start — This is the Event Selection page. Information about each event appears, including
the description, date, and time of the event. By default, the website user selects their events on this
page and enters the registration quantity and pricing information on another page. If your Event
Registration form includes only a few events, you can exclude the first step of registration to
minimize steps for your registrants. When you exclude the first step, the progress indicator
displays the event registration as four steps: Prices, Attendees, Register, and Finish. In a four step
registration, the user selects the events and enters the quantities of event units as part of the Prices
step.

« Step 2: Prices — This is the Quantity and Pricing page. The pricing options and units for the
selected events appears. On this page, the website user enters the quantities of event units to
register. If you exclude the first step of registration, the user selects their events on this step too.

« Step 3: Attendees — This is the Attendees page. On this page, the website user enters who will
attend the selected events and selects any participant attributes you add to the Event Registration
form.

« Step 4: Register — This is the Payment page. A summary of the event registration appears. On this
page, the website user verifies the registration options selected are correct and enters any billing
and payment information.

« Step 5: Finish — This is the Confirmation page. A summary of the billing and payment information
appears.

Note: To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or The Raiser's Edge, select Test mode
on the Properties tab. For example, you can complete the fields on an Event Registration Form to
ensure the confirmation page is styled and working properly. Although you submit the registration
and receive a confirmation, a transaction does not appear on the NetCommunity page in The Raiser's
Edge. Use Test mode to verify the user’s experience, not to test data processing. Test mode does not
validate credit card numbers and merchant accounts. Only users with supervisor rights can view parts
in Test mode.

Note: We recommend you design the page to include the same look and feel as your third party site
so that users seamlessly transition to the page.
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2 Design Event Registration Form

Tip: For optimal performance, include only one Event Registration Form part for each web page.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Fund from The Raiser’s Edge, select the fund to associate with
the event.

Fund from The Raiser's Edge

For registration fees that are collected, select the fund to use when registration fee gifts are created.

Fund:
(no Fund selected) iy

When you download information, registration fees paid online through this form apply
directly to the designated fund. For more information, see the Event Registrations section of
the The Raiser’s Edge and Blackbaud NetCommunity Integration Guide.

2. Under General Options, select a constituent code to apply to registrants. For more
information about constituent codes, see the Program Basics Guide.

General options

Constituent Code:

| “w The constituent code specified will be applied to both new and
existing constituents.

Note: If a registrant already exists in the database, the constituent record updates to include gift and
event data from the downloaded event.

3. Under Donor options, specify whether to allow website users to provide matching gift claims
through the website. If you select Allow matching gifts, the My company will match my gift
checkbox appears on the web page. Site visitors can select this checkbox and enter the
company name in the Company field. If you use MatchFinder Online, a Look it up link appears
next to the checkbox. Visitors click the link to access MatchFinder Online and search for the
company. MatchFinder Online contains information about matching gift companies, such as the
minimum and maximum gift details and match ratio.

Donor options

Allow matching agifts

Data from MatchFinder Online integrates with The Raiser's Edge. For information about
MatchFinder Online purchasing options, send an email to solutions@blackbaud.com.

For information about how to download matching gift information, see the Event


mailto:solutions@blackbaud.com
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Registrations section of Blackbaud NetCommunity & The Raiser's Edge Integration Guide. For
information about matching gifts in The Raiser's Edge, see the The Raiser's Edge Gift Records

Guide.

4. Under Registration Options, select Display progress indicator to display a progress status
bar for the user to view during the event registration.

Registration options

[ pisplay progress indicator

[IExclude first step of registration

Check to display a progress status bar for the user to view during the event
reqgistration.

Check to exclude the first Event Info/Selection page from the registration
process. If the registration contains one or few events, you can remove this
page to minimize steps for registrants.

5. To allow the website user to select both events and registration options on one page, select
Exclude first step of registration. If you do not select this option, a five step progress
indicator appears at the top of the event registration form and the website user selects the
events to register for on one page and enters the registration quantity and pricing information

on another page.

Tip: If you select Exclude first step of registration, Step 1: Start does not appear on the progress
indicator. The progress indicator displays the event registration as four steps: Prices, Attendees,
Register, and Finish. In a four step registration, the user selects the events and enters the quantities of

event units as part of the Prices step.

Note: If your Event Registration form includes one or few events, we recommend you select Exclude
first step of registration to minimize steps for your registrants. If your Event Registration form
includes multiple events, a second event information and selection page may be helpful to your

website users.

6. Under Required fields, select the checkbox for each donor field to make required on the
event registration form. To ensure you download complete constituent information, we
recommend that you make all these fields required.
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Required fields

[IFirst Name
Oitle

[Orhone

Captions

Item name

Previous Button

Mext Button

Register Button
Registrants/Unit Label
MNo Charge Label

Sold Out Label

Specify whether the following registrant fields are required.

Provide captions for the following form items.

Text
Previous
Mext
Register
Attendees
Mo Charge

(Sold Out)

7. Under Captions, for each button or label listed, enter the text to appear on the Event

Registration form.

8. Under Events from The Raiser’s Edge, select the event to use.

Select event:

Events from The Raiser's Edge
Set up the event(s) for this Event Registration Form. Click Add event to search for an event.

|Aﬂernonn Tea

w | = Add event

Event category:
Dinner

s ol . it "\.,_‘-u’“‘\ ot 'J | r"\., Y gl

To add an event to the field list, click Add Event. The Event Search screen appears so you can

select an event.

You can use this event registration form for more than one event. To add another event to the

Date:

Saturday, June 20, 2009 at 2:00
FM

# Remove event

Description:

We will be meeting at the
Playground Site for a brief
meeting and introduction. We
will then be taking the shuttle
to Cobblestone House for tea
and desserts.

form, click Add Event and select an additional event. After you select an event, additional
options appear for you to set up how its registration appears on the form.
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a. Under Event options, in the Display Name field, enter the name of the event as it will
appear on the website.

Event options

Display name: *
Afternoon Tea Enter the name of the event as it will appear on the website.

Display description: *

We will be meeting at the ~ Enter the description of the event as it will appear on the website.
Playaground Site for a brief =
meeting and introduction. We will —
then be taking the shuttle to v
Page link:
4 Create a link from Afternoon Tea to another web page.

Select this option to limit registrants based on the

Restrict registrations to capacit i . R
B s SESL event's capacity. Capacity for event is 50.

Select to display any relationship records linked to a member's

[¥] Display relationships : :
[Misplay i constituent record for selection.

b. In the Display Description field, enter the description of the event as it will appear on the
website.

By default, the text in the Description field appears in the Display Description field.

c. Under Page Link, to add a link to another web page, click the binoculars. The Create Page
Link screen appears. For information about how to create a page link, see the Program Basics
Guide.

d. The help text displays the capacity entered offline for the event. To limit how many
registrants can sign up for the event using the event registration form online, select Restrict
registrations to capacity.

e. To display any relationship records linked to a member’s constituent record in The Raiser's
Edge for selection in participant fields, select Display relationships.

For example, Mark Adamson has a constituent record. His wife Vicki has a relationship linked
to Mark's constituent record. If you select Display relationships, when Mark registers for the
Annual Golf Tournament on your website, Vicki's name appears in the drop-down list when
Mark assigns participants. He can select Vicki or enter another name.

f. Under Pricing Options, select the prices to appear on the registration page for each event
unit. To display a listed price, select its checkbox in the Include column.
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Pricing options

. S - - Max Allow Price {gift Receipt
Include Unit Description Registrants/Unit o s T
Adult [Adult E: * O $75.00 $60.00
0  chid [Chid EXRE O $50.00 $40.00

In the Description column, enter the text to appear on the registration page for each event
unit, such as “Individual” or "Couple.”

In the Registrants/Unit column, enter the number of people allowed for the unit.

In the Max units column, select the maximum number of each unit allowed for each
registration. By default, this value is “4."

To allow participants to register for an event unit anonymously, select its checkbox in the
Allow anonymous column. When you select this checkbox, the Name field is not required
when the website user registers for the event unit.

In the Price (gift amount) and Receipt amount columns, data from the Prices tab of the
event record appears and is disabled. You cannot change this information on the website. To
change the price or receipt amount, edit the event record offline.

g. Under Attributes, select the participant attributes to appear on the event registration page.
To display a participant attribute, select its checkbox in the Display column.

Attributes
Select the participant attributes to display.
Display Attribute Required Caption
F Special Requests F |Specia| Requests |
FI Dietary Preference F |Dietary Preference |
F Source F |Sc|urc:e |
F Partner Request F |F'artner Request |

Tip: Constituent attributes are not available for the Event Registration Form. You can only select one-
per-record participant attributes with a type of Date, Text, Number, Currency, and Yes/No. Table type
participant attributes are available without being marked as one per record. Fuzzy Date and
Constituent Name types are not available for the part. If you recently added a new participant
attribute in The Raiser's Edge and it does not appear in the Participant attribute options, grid or in
Sites & settings for you to make it available on the web page, click Refresh code tables in Code
tables. This updates code tables from The Raiser's Edge in Blackbaud NetCommunity. For more
information about how to update code tables, see the Administration Guide.

To make a selected participant attribute required, select its checkbox in the Required
column.
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To change the text of the participant attribute on the registration page, in the Caption field,
enter the text to appear.

Note: When you download an event registration, the Online registrant? participant attribute
automatically adds on the participant record. You do not view this attribute in the Attributes frame
or on the Web Transactions page in The Raiser's Edge. After the event registration downloads, this
information appears on the Attributes/Notes tab of the participant record. “Online registrant?”

appears in the Category column, “Yes" appears in the Description column, and “Blackbaud Internet
Solutions” appears in the Comments column.

9. When you include more than one event, Display order appears so you can change the event
display order. To do this, click and drag an event to the desired location.

10. Under Additional Donations, to include an additional contribution field on the event
registration page, select Allow additional donations. In the field that appears, select the fund
to credit for additional donations. The gift is linked to the participant’s constituent record, but
not directly to the event record.

Additional donations

{(no Fund selected) FERE Select a fund to assign to that portion of the event registration gift.

11. Under Payment Options, select the payment options for website users.

a. To allow website users to pay for multiple transactions at one time, select Use payment
part. The Payment frame appears.
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Payment options

@ Use payment part © Proceed directly to payment

Payment page: #
:<please select> lz‘ Select the page with the shopping cart to process transactions.

Define the text that will be shown on the payment page after an event transaction is added.

9 o Formatting Insert View
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In the Payment page field, select the web page to use to process event registrations. The
Payment part on the selected page determines the payment methods and merchant account
used to process event registrations. For information about the Payment part, see Payment on-

page 168.

Note: If your payment page uses a Payment 2.0 part, the payment method for it and this part must
match. For example, you cannot select a payment page that accepts direct debits because this part
only accepts pledges and credit cards.

In the box, enter the text to appear on the payment page after an event registration is added.
To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

b. To require website users to pay for event registrations one at a time, select Proceed directly
to payment. Additional options appear.
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Payment options

O use payment part ® Proceed directly to payment

Merchant account: #

| =please select> v| Select which merchant account to use to process event transactions.

Select which payment methods to make available on this Event Registration Form.

Credit Card

il Fledge (Bill me later)

Specify whether to use the default acknowledgement page or a custom one.

(® Use default confirmation screen O Use custom confirmation screen

The default acknowledgement page will be used.

In the Merchant Account field, select the merchant account to use to process credit card
transactions received through the event registration form, such as your organization’s
Blackbaud Merchant Services account.

The system administrator sets up merchant accounts in Administration. For more information,
see the Administration Guide.

Select the payment methods that website users can use on the Event Registration Form. You
can select Credit Card or Pledge (Bill me later).

Select whether the default confirmation screen or a custom confirmation screen displays the
summary after a user registers for an event. If you select Use custom confirmation screen,
the HTML editor appears and displays the default confirmation screen. Customize the default
confirmation screen according to your needs. To format the content’s appearance and layout,
use the HTML editor toolbar. To include personalized information, use merge fields.

Tip: If you customize the default confirmation screen, the customizations remain even if you later
select Use default confirmation screen. To remove your customizations for the screen, select Use
custom confirmation screen and click Restore default content. The program’s default confirmation
screen appears in the HTML editor.

12. Click Next. The Acknowledgement Email screen appears.
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Name: |Evem Registration Acknowledgement |*
Subject: |Evem Registration Acknowledgement |*
From Address: | |* From Name: |*
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13. Create the email to acknowledge the registration. For information about how to design an
email acknowledgement for an event registration, see the Email Guide.

For information about event registration loop merge fields, see Event Registration Loop
Merge Fields on page 115.

Tip: When you edit an Event Registration Form, you can click Acknowledgement Email to access the
Acknowledgement Email screen.

14. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part v

Select how to display the consent options: @

Inline

® Overlay

a. Under Consent part, select a saved Communication Consent part to include on the form.

Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.
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After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

15. Click Save. You return to Parts.

Event Registration Loop Merge Fields

Several merge fields output the same registration data, but in different ways. To merge all registration
data into one table without the ability to format and change labels, select the Registrations Block
merge field. To merge registration data in loops for multiple events, registrant types, and attendees,
select the Event Item loop merge fields, Pricing loop merge fields, and Attendee loop merge fields.
These loop fields merge data so you can change labels and use format options to customize the
information.

For example, you create an email acknowledgement for a golf tournament that includes attendees in
the Individual and Family registrant type. When you use the loop merge fields, the program makes the
following loops to merge data.

« Event Item loop merge fields — The program first checks the number of events to include in the
acknowledgement. In this example, there is one loop because your merge includes data for just
the golf tournament event.

+ Pricing loop merge fields — Next, the program merges data through loops for registrant types. In
this example, the program makes two loops, one for the Individual type and one for the Family

type.

« Attendee loop merge fields — Lastly, the program loops the actual list of attendees for each
registrant type. This happens multiple times depending on the number of attendees. The program
first loops through the Individual registrant type to merge data for the attendee list. Next, the
program loops through the Family registrant type to merge data for the attendee list.

Event registration loop fields must be nested in the order they appear in the merge field list. The
nesting order is Event Item loop fields, Pricing loop fields, and Attendee loop fields. If you list the
fields out of order, for example you list the Attendee loop fields outside of the Event Item loop
fields, or as standalone fields, the data does not merge correctly.

< Event Item Loop.Begin Section = Event Item Mame > Pricing Loop.Begin Section

£ Pricing Description > &ttendee Loop.Begin Section
< Attendee Name = Attendee Loop.End Section

< Pricing Loop.End Section
Event Item Loop.End Section™
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Flash Player

With the Flash Player part, you can display dynamic, multimedia content on your website with Flash
technology. Flash files can support audio and video to add interactivity to web pages. You can use the
Flash Player part to add animation or integrate video into your website.

Note: The website requires Macromedia Flash Player version 7.0.19.0 or later.

2 Design Flash Player

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see

Create and Edit Parts on page 10.

1. From the Design tab, select a Flash file under Select File.

Select file
Upload file:
| [ Browse... ]

e Dr oK
Provide URL:
http:/f

Name of file:

Upload the Flash file to display on yvour website or enter the URL
of the file's location.

« To search for a file on your network or computer, click Browse. The Choose file screen

appears.

« To use a URL to point to the file, enter the location of the file in the Provide URL field.

File properties
Height:
| px ¥
Width:

px ¥

Display method:
| Opaque V|

2. In the Height and Width fields, enter the size for the Flash Player part. In the corresponding
fields, select a valid CSS length unit, such as “%" or "px.”

3. Inthe Display method field, select how to display the Flash Player.
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 To display the Flash Player in a separate window, select “Window.” In Window mode, the Flash
file appears to be on the web page but is actually on a separate window above the browser
window.

« To display the Flash Player in the browser window with an opaque background, select
“Opaque.”
« To display the Flash Player in the browser window with a transparent background, select
“Transparent.”
4. After you select a Flash file, it appears under Preview.

5. Click Save. You return to Parts.

Form Display

You use the Form Display part to create a landing page for users to access online forms. With these
online forms, you can collect various data from your website users.

Tip: You create forms in Forms. For information about how to create and design forms, see Online
Forms Guide.

On the Form Display part, you select the online forms to include on the web page, enter display names
for the forms, and set the display order. You also configure user login options for the web page. To
ensure the data you collect is associated with user profiles, we recommend that you require website
users must log in to your site to access forms.

On your website, users access the page with the Form Display part to view a list of available forms. To
fill out a form, users click a link beside it. A second list on the page displays the forms that users
started. In this list, the status of each form appears, along with links to resume, delete, and print the
forms.

2 Design Form Display

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, click Add Form under Forms to add an entry to the list of forms on the
part.

Forms

Select the forms to include on the form landing page. To add a form, click Add Form, and then click Select
under Form. Under Display Name, enter a form title to display on the page. Under Action, use the arrows
to adjust the display order, and click Remove to remove a form from the list.

Display Name Form Action

| |# (no Form selected) da | * + 4+ X

[ Add Form ]
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2. To select aform, click the binoculars in the Form column. The Select a Form screen appears.
Locate the form and click Select. The form appears in the field.

Note: To save the Form Display part, you must add at least one form to the part. You create and
manage forms in Forms. If you create a Form Display part before you create the forms for it, you must

select an existing form as a placeholder. For information about how to create and design forms, see
the Forms Guide.

3. Under Display Name, enter a name for the form to appear in the list of available forms on
your website.

4. Under Captions and Properties, select whether to include links for users to request forgotten

passwords and user IDs. By default, the program includes links for users to log in or register
for the site.

Captions and Properties
Select form titles and hyperlink captions to include. Their contents may be edited via the Language tab.

Enabled
Login
Mew User Registration
Forgotten Password/User ID
Forgotten Password
Forgotten User ID F

Note: The Form Display part requires you to configure a new user registration email message and a
forgotten password/user ID email message. The part requires these email messages even if the forms
you include on the part do not require users to log in or register.

To change the text for the links, select the Language tab. For information about the Language
tab, see Language Tab on page 17.

5. Under Constituent Code, select the constituent code to assign to users who register for your
website through this part.

Constituent Code
Constituent Code:
| vl

Select a constituent code to assign to users who sign up via
this form.

For information about constituent codes, see the Program Basics Guide.

6. Under Navigation, browse to the web page you want to appear after users log out. If you do
not select a page, the home page from the Settings tab in Sites & settings appears by default.
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Navigation
Select which page to present to the user upon successful completion of the specified task.
Logout:

Sample Default Page g | *

7. Under Additional Fields, select the biographical fields to include on the new user registration
form. In the grid, select Include for each field to include on the form. To make a field
required, select Required. When you select Include for the Address block and Gender fields,
they are automatically required.

Additional Fields

Select which additional fields will be displayed during the user registration process.
Field Include Required
Title 1 O O
Address block ¥
Home Phone Fl Fl
Gender F]
Maiden name F Fl
Class of Ol A
Birth date Fl Fl
ID O |

8. In the Role Assignment frame, select Member for each role to assign to users who register

for your website through this part.
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Role Assignment

Select which roles to assign to users registering or joining via this form.

Role Member
All Rights Fi
Content Authaors
Create Forms

Form Gallery Access
Members

Site Administrators

O 0000

9. Click Save. You return to Parts.

Formatted Text and Images

To include text and images from Image library on your web pages, such as your organization’s mission
statement and logo, use the Formatted Text and Images part. You can also use the Formatted Text and
Images part to create a footer for your website that includes your webmaster's contact information. On
the Content tab of the Formatted Text and Images part, use the HTML editor to create and format the
text and images to appear.

On the Options tab, you can specify whether website users can copy the content from your website,
such as from a personal page, to use on another web page. For example, the site user can copy the
HTML code necessary for the content on her personal page to appear on a social networking profile
page, family website, or weblog.

Each new and revised Formatted Text and Images part must pass a content approval workflow to
appear on your website. For information about the content approval workflow, see the Administration
Guide. You can add approved Formatted Text and Images parts to each web page in Pages &
templates. For more information about how to add content parts in Pages & templates, see the Website
Design Guide.

With Blackbaud NetAdvocacy, you can download advocacy action data. This data includes alerts, email
information, and attributes. Blackbaud NetAdvocacy is used with Capwiz subscription service to include
pages on your site where users can email influential individuals (such as Congressional, state, and local
officials) to encourage their influence on particular causes, such as grant funding for a nonprofit. To
include links to landing pages on your website for advocacy functionality, use the Formatted Text and
Images part. In addition, when you send advocacy alert email from the website, the advocate’s actions
automatically link to their record in The Raiser’s Edge after the action is complete. For information
about how to use Blackbaud NetAdvocacy and Capwiz and to set up action alerts on your site, see your
Capwiz Site Control page.

Warning: You cannot use HTML to embed your own form via HTML in a Formatted Text and Images
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part.

The Formatted Text and Images (Secured) part is the same as the Formatted Text and Images part with
the additional ability to secure the page’s content using encryption such as Secure Sockets Layer (SSL)
or Transport Layer Security (TLS). When the secured part is on a page, the page’s URL starts with
"https”. To design a Formatted Text and Images (Secured) part type, follow the same steps as the
Formatted Text and Images part.

2 Design Formatted Text and Images

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.

From the Design tab, select the Content tab.

o™ Formatting Insert View
=5 # Cut Font family =  Font size - = -i=-5E S @
*—j 53 Copy

Have you ever wanted your own personal PPMC health care expert?
Now you can hawve one - just sign up today for PPMC’s free e-newsletter!

"Your Best Health” issues feature articles by the premier experts on common medical conditions and the latest
health care issues. "Your Best Health"” is e-mailed to subscribers regularly.

You will also receive information on health education opportunities at PPMC! We will send yvou the latest
medical resear

]
ub.l

X
4

B 7 U =# A-W.-= = =
Paste wm. Code S— | m—

tudi hich you can apply. Of course, vou'll always be the life of the party

In the HTML editor content area, enter the content and format its appearance and layout. For
example, you can manually enter or copy and paste your organization’s mission statement. For
more information about the HTML editor, see the Program Basics Guide.

To allow site users to copy and paste the content's HTML code:

Select the Options tab.

| Content || Options

— Gives the web page visitor the ability to copy and paste the HTML code for
[“Enabie HTL code publishing = ' & e

this piece of content.

Help text:

Copy and Paste the following code Enter custom text to appear on the web page to help website visitors
where you would normally publish

HTML content. understand how and why to copy the HTML code.
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b. Select Enable HTML code publishing.

c. Inthe Help text field, enter custom text to appear on the web page to help site users
understand how and why to copy the HTML code. By default, the message “"Copy and Paste
the following code where you would normally publish HTML content” appears.

4. Select the content approval workflow to use with the part and its approval status in the
workflow.

a. On the Edit Part screen, select the Content Approval tab. For information about the items on
this tab, see Content Approval Tab on page 21.

Content Approval

Set approval status and workflow for this part.

Approval Status: |Draﬂ i |
Warkflow: | Default for FT&I * ¥ | * denotes default workflow
Activitys | action Version Status Status Updated On Status Updated By
2 1 Draft 8/6/2009 3:41:50 PM Supervisor

1 version meets selected criteria

b. If you have rights to manage workflows, the Workflow Name field appears. In this field,
select the workflow to apply to the part.

When you create a workflow in Workflows, you can select whether it is the default workflow
for the selected part type. When you design a part and select its workflow in the Workflow
Name field, an asterisk (*) appears next to the default workflow. For more information, see
the Administration Guide.

c. When you complete the design of the part and its content, in the Approval Status field,
select "Ready for Approval.” Until the part is complete and ready for approval, select the
approval status of “Draft.”

5. Click Save. You return to Parts.

Formatted Text and Images (Secured) -
(Deprecated)

Note: The Formatted Text and Images (Secured) part is now deprecated. While the deprecated part
continues to operate for backwards compatibility on your website, you can no longer create or copy
Formatted Text and Images (Secured) parts. Instead, you can use the Formatted Text and Images part.

The Formatted Text and Images (Secured) part is the same as the Formatted Text and Images part with
the additional ability to secure the page’'s content using encryption such as Secure Sockets Layer (SSL)
or Transport Layer Security (TLS). When the secured part is on a page, the page’s URL starts with
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"https”. To design a Formatted Text and Images (Secured) part type, follow the same steps as the
Formatted Text and Images part. For more information, see Formatted Text and Images on page 120.

Giving Search

Create a Giving Search part to provide an online fund search for donors. Donors use the search to find
a fund and make a donation. When the search results appear, a donor clicks the fund to navigate to the
donation page. When you create the Giving Search part, you can select a query of funds so donors do
not search all funds in your database.

2 Design Giving Search

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Records to Include, specify the funds to include in the giving
search.
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| I:3'3$iEIf'I| Language || Froperties || |Jzage || Targeting&Securityl

rRecords to Include

Lirnit to query: (&l Funds)

~Search Form

Split search fields inta: |1 "I column(s).

rResults

Show navigation controls: IEinth above and below the resultsj

Fesults per page:
IS vl

Linked donation page: I

~Fields to Include

Available Fields:

E] [ Awvailable Figlds
El CgFund
FrRndin
Descripkion
}3 Cakegory
p Type
A2 start Date
}3 End Date
}3 Carmpaign Descriptions
,O Campaign IDs
[ JFund Attributes

Ll

}3 Search Form Fields:

Listing Fields:

&l annl

&l Duwnl

a. The Limit to query field displays the query of funds to include in the giving search. To
include all funds in your database, leave the default “All Funds.”

For a query to appear as a selection, you must first create it offline. When you create a query,

you may need to refresh the website for it to appear as a selection. To refresh, select View,

Refresh from the menu bar.

b. To select another query of funds to use as the giving search, click Change. The Query Search

screen appears.

2. Under Search Form, in the Split search fields into field, select how many columns of search
fields to include in the criteria table. You can display up to five columns.

3. Under Results, set up how search results appear in the giving search.

a. Inthe Show navigation controls field, select whether the navigation buttons appear above

the results, below the results, or both.
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b. Inthe Results per page field, select the maximum number of funds per page in the search
results. You can display up to 50 results per page.

The giving search can return up to 200 funds that match the criteria entered by a site user.

c. The search results link to a donation page on your website. In the Linked donation page
field, select the donation page.

4. Under Fields to Include, select the fields to use in the giving search. To move a field from the
Available Fields box to the Search Form Fields box, select the field and click the right arrow.

To move a field in the Search Form Fields box, select the field and click the Up or Down
button. The search fields on the web page appear in the same order as the fields in the box.

Note: The fields in the Search Form Fields box and the Listing Fields box do not have to match.

5. Select the fields to appear in the search results. To move a field from the Available Fields box
to the Listing Fields box, select the field and click the right arrow.

To move a field in the Listing Fields box, select the field and click the Up or Down button. It
is important to remember the following about the fields listed in the box.

« The donation automatically applies to the fund selected in the search results.
 Result fields on the web page appear in the same order as the fields in the box.
 The first field becomes a link to the donation page.

 The first field is disabled in the Designation field on the donation page. The user cannot
change it.

« If included, the donation confirmation screen includes the value from the first field when the
Designation merge field appears on the screen.

Tip: You can use the link in the search results to include a URL to your donation page in an email. To
obtain the URL for the donation page, right click on the link. From the menu that appears, select Copy
Shortcut. Go to your email to paste the URL into your email message. When a recipient clicks the
URL, the donation page appears. The field selected first in the Listing Fields box, which is the link in
the search results, is disabled in the Designation field on the donation page and the website user
cannot change the information in the field. To link to a donation page this way, it is best to include
fields such as Fund ID or Description first in the Listing Fields box. These are logical fields to appear
in the Designation field.

6. Click Save. You return to Parts.

Job Board

The Job Board part creates an area on your website for users to post and search job postings. With this
part type, you can customize the name, captions, and messages for the job board. Users with manager
rights can approve and delete postings.

Tip: To post ajob, a website user must log into your site. However, a user does not have to log in to
search for a job posting.

You can display a Job Board part on any web page. The initial landing page includes the job board
name and hyperlinks that link website users to the appropriate search or post web page of the job
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board. You can customize additional messages to explain job board functionality to your website
users.

2 Design Job Board

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Board Name field, enter the name for the job board for your
website, such as “Working at ABC Learning Center.” This field is required and limited to 225
characters.

2. Inthe Legend Message box, enter the message to appear below the name of your job board,
such as “The Working at ABC Learning Center job board provides a way to post your
organization’s job openings as well as search for current available jobs posted to this site.”
This field is required and limited to 225 characters.

3. Inthe Search Link Caption field, enter the information to appear when a website user moves
the mouse over the search hyperlink, such as “Click here to search for available jobs.” This field
is required and is limited to 150 characters.

4. In the Search Message box, enter a message that appears under the search hyperlink and
explains to website users the purpose of this section, such as “Search available jobs by
entering specific criteria you would like to have in a job.” This field is required and is limited
to 225 characters.

5. In the Post Link Caption field, enter the information to appear when a website user moves the
mouse over the post hyperlink, such as “Click here to add a job posting.” This field is required
and limited to 150 characters.

6. Inthe Post Message box, enter a message that appears under the post hyperlink and explains
what website users can do in the job posting section, such as “Add a job posting for your
organization.” This field is required and limited to 225 characters.

7. In the Post Job Message box, enter the information to appear at the top of the job posting
form that appears when a website user enters information for the available job. For example,
enter "Post your job using this form. To preview your post, click Preview. To add your job
posting to the website immediately, click Post Job.” This field is required and is limited to 225
characters.

Note: The Post Job form website users use to create a job post contains standard job criteria fields.
For example, job type, description, and salary range are included on the form. The website user has
the option to post the company name and a name and email address for the applicant to contact. A
red asterisk designates required fields on the form.

8. If you select Require Approval for Posts Made to This Board, jobs posted by user roles with
Manage rights appear on your website immediately. A user with manager rights must approve
other job postings.

Warning: If you do not select Require Approval for Posts Made to This Board, all topics appear
immediately on your website.
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9. Under Security Rights, in the Manage column, select the checkbox to assign Manage rights
for job posting users and roles. Managers can approve or delete any postings added to the
website.

10. To include additional users and roles, select Add users and roles.

11. Click Save. You return to Parts.

Language Selector

With the Language Selector part, you can allow website users to select language preferences for your
website. Users select their preferences from the languages available on your website. You can make
languages available in the Supported Languages section on the Settings tab in Sites & settings. The
website renders text for selected languages based on the Language tabs of the parts on your website.

Tip: For the Language Support part to be effective, you must localize text on the Language tab
before you use the part.

After users select languages, the website localizes text on the parts on your website. For example, if a
user selects Spanish as the preferred language and goes to a donation form, the Donation Form part

displays localized Spanish text from the Language tab. For more information about the Language tab
and international pages for your website, see Add Localized Text For Web Pages on page 18.

Language preferences remain in place when users return to your website. For registered users, the
program associates language preference with user logins. For anonymous users, the program
associates language preferences with cookies on their machines.

2 Design Language Selector

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. On the Design tab, the Language Selector part does not contain design options.

Design Language Properties  Usage  Targeting & security  Tags

This part does not have any design-time options.

2. Select the Language tab. You can edit default text and localize text for other languages. The
tab appears on parts such as the Donation Form and Giving Search. For more information
about the Language tab, see Lanquage Tab on page 17.
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Design | Language | Properties Usage  Targeting & Security  Tags

Specify any part text to be replaced with alternate text for a specific language.

Category: Language:
Form fields v| | English (United States) v
Item name Item type Default text Text
Language Caption Field label Language: |My Language |

3. The Category field lists the areas on the part that you can edit. For the Language Selector part,
you can only edit the Form fields category.

4. In the Language field, select the language to localize. You can make languages available in the
Supported Languages box on the Settings tab in Sites & settings.

5. Inthe Text column, enter text to rename the language field or localize it for other languages.

Note: The default language selection is based on the primary language for the website user’s Internet
browser. If you do not support the browser language in the Supported Languages section on the
Settings tab in Sites & settings, the default selection is based on your default language.

6. Click Save. You return to Parts.

LinkedIn Group Join (Deprecated)

Note: Due to LinkedIn APl changes, the LinkedIn Group Join part has been deprecated and no longer
works on your website. If the part exists on any of your websites, we recommend you remove it as
soon as possible.

Membership Form

With the Membership Form part, you can design a membership web page and solicit new members on
your website. When you design the membership page, you select the membership categories to
advertise online. You can create links to renew existing memberships, allow gifts of membership, and
customize your confirmation message for web users.

Note: In Pages & templates, we recommend you do not add more than one Membership Form part
on a page. We recommend you design the page to include the same look and feel as your third party
site so that users seamlessly transition to the page.

From a membership form on your website, users enter the appropriate information for each section of
the membership process. The user then clicks Next to complete the next section of the membership
form.

« Current Membership displays a website user’s current membership information. You can select not
to display this page on your website.

« Join/Renew contains the available membership categories you select to display on your website.
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« Cards/Guest Pass displays the options the user can select to include additional cards or guest
passes. You can select not to display this page on your website.

« Transaction displays the member's name and financial information.

» The acknowledgement message displays the message you created on the Membership Form part
so the site user can read the message once the membership has been submitted. The website
automatically sends an acknowledgement email to the member.

To generate a Membership Form part from the beginning, start with Design the Current Membership
section on page 129. After you complete the steps in this procedure, follow the remaining procedures
for this part to create your membership form.

Note: If you use The Raiser's Edge Membership Management, use the Membership Form part.

2 Design the Current Membership section

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter the title for the membership screens on your
website, such as “Smith Museum Membership Program.”

Note: The Membership Options frame affects the Join/Renew page. For more information about this
frame, seeDesign the Join/Renew section on page 130.

2. To display the member’s current membership, select Show Current Membership(s).

If you do not select this checkbox, the membership form on your website starts with the
Join/Renew section. For more information, seeDesign the Join/Renew section on page 130.

3. To allow members to view program and subcategory information, select Include Program
and Include Subcategory.

4. Inthe Caption field, enter the text to appear on your website to explain what is being viewed,
such as “Your Current Membership Information.”

5. In the Message box, enter any additional information to provide for website users, such as “If
you have questions about your current membership, please contact us at 323-555-5555."

6. Inthe Join Button and Renew Button fields, enter the text to appear on each button, such as
“Join Now" and “Renew Now," respectively.

7. Inthe Program - Category table, select the membership categories to include on your
website. To include a membership category, select the checkbox in the Show column. To
allow a membership category to be renewed, select the checkbox in the Allow Renew
column.

8. To display current benefits for your memberships, select Show Benefits. To show details of
the benefits, select Show Quantity, Show Total Value, Show Comments, or Show Notes.

Note: The Raiser's Edge determines the available membership benefits.

If you select Show Benefits and a member waives benefits, a message appears on your
website to inform the member that the benefits have been waived.
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2 Design the Join/Renew section

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.

From the Design tab, to allow members to enter comments, select Allow Comments. When
you select this checkbox, a text box for user comments appears in the Transaction section.

If you mark this checkbox, comments appear in the Comment field on the Membership tab on
a membership record.

Note: The Join/Renew section displays the available membership categories you select for your
website. This way, a website user can select the membership to join or renew from the available
categories in the list.

Note: If you do not display the Current Membership section, your member cannot renew a
membership on your Membership Form part. For more information about Current Membership, see
Design the Current Membership section on page 129.

2.

To allow matching gifts, select Allow Matching gifts. Site visitors can select My company
will match my gift and enter the company name in the Company field. If you use MatchFinder
Online, a Look it up link appears next to the checkbox. Visitors click the link to access
MatchFinder Online and search for the company. MatchFinder Online contains information
about matching gift companies, such as the minimum and maximum gift details and match
ratio.

Data from MatchFinder Online integrates with The Raiser's Edge. For information about
MatchFinder Online purchasing options, send an email to solutions@blackbaud.com.

For information about how to download matching gift information, see the Blackbaud
NetCommunity & The Raiser's Edge Integration Guide. For information about matching gifts in
The Raiser's Edge, see The Raiser's Edge Gift Records Guide.

To renew memberships on your website, select Allow the donor to automatically renew a
membership.

When you select Allow the donor to automatically renew a membership, an Auto Renewal
section appears. If the website user selects direct debit for the payment method, the Starting
on field appears. For more information about processing renewal memberships automatically,
see the Blackbaud NetCommunity & The Raiser's Edge Integration Guide.

Tip: When you select Allow pledge installment gifts and a user creates a pledge and defines a
pledge installment schedule, the Auto Renewal information no longer appears.

4,

In the Donor message box, enter a message to appear on the website to notify users the
automatic membership renewal option charges direct debits and credit cards for future
renewals. For example, you can enter "By selecting this option, | understand that my account is
charged automatically when my membership expires.”

To allow members to create a pledge and define a pledge installment schedule, select Allow
pledge installment gifts. An Installments option appears under Type of gift on the
membership form. When a member selects Installments, a Number of Installments field and
frequency options appear on the membership form.
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Note: Members cannot enter a number that goes beyond the term of the membership in the
Number of Installments field. For example, a member cannot select to pay an annual membership in
15 monthly installments; the member may enter only 1 through 12 in the field.

To allow the member to determine the frequency of the pledge payments on the
membership form, select General. Members can select to make payments in weekly, monthly,
quarterly, or yearly installments.

To define the pledge installment schedules members can choose, select Specific.
a. Select "Weekly,” "Monthly,” "Quarterly,” or “Annually” as the frequency.

b. Inthe On field, select a day or date members can choose to schedule the installments.

Tip: If a constituent donates a recurring gift and selects a start date that is not today’s date, the
transaction downloads to The Raiser's Edge. However, the transaction is not sent to your bank
merchant when the donor submits the recurring gift. The merchant receives the transaction from the
batch output you send to your bank for processing from The Raiser's Edge. For more information
about bank merchants, see the Administration Guide.

c. To add multiple frequency options to the membership form, enter each custom schedule
and click Add Frequency to add the new schedule to the list. The selections you make
appear in the Frequency grid on the web page.

The program calculates the installment amount and end date based on the number of
installments, frequency, and date the member specifies and displays this information on the
donation page. For example, a member may contribute $100 in four monthly installments
and select to pay each installment on the first day of the month beginning January 1. This
generates four scheduled payments of $25 ending April 1. No installment payments occur
after the end date.

Note: If the number of installments for the pledge does not result in equal payment amounts, the
final scheduled payment contains the remainder. For example, a $100 pledge with three installments
has two payments of $33.33 and a final payment of $33.34.

Warning: If a constituent selects a pledge installment start date that is not today’s date, the
transaction is sent to the merchant account when the gift is processed. For more information about
bank merchants, see the Administration Guide.

Note: The Show Current Membership(s) options appear in the Current Membership section. For
more information about these options, see Design the Current Membership section on page 129.

6. Under Required Fields, select the checkbox for each donor field to require on the donation
form. To ensure you download complete constituent information, we recommend that you
make all fields required.

7. Under Additional fields, select the additional fields to include on the form.

a. Inthe Include column, select the checkbox for each additional field you want to appear on
the form. If you require a field, you must also include it.

b. Inthe Required column, select the checkbox for each additional field website users must
complete to submit the form.

8. In the Constituent Code field, select a constituent code to add for new members. Your
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10.

Note:
11.

Note:

website users do not view the constituent code, but you can download it. For more
information, see the Program Basics Guide.

To allow website users to purchase gifts of membership, select Allow gifts of membership.
You can select a constituent code for these membership recipients and allow the donor to
decide whether the member or the donor receives the benefits and renewal notices. You can
also include a text box on your website so donors can include a special message for the gift of
membership recipient.

When you download the membership to The Raiser's Edge, the gift of membership message
appears on the site user's membership record in the Special message field. This field can
contain 255 characters in The Raiser's Edge.

To include an additional contribution field on the membership page, select Allow additional
donations. In the grid that appears, click the binoculars in the Fund column to select a fund. In
the Display name column enter the fund name. To include a Designation field so participants
can select from a list of funds, click Add designation and select a fund for each option. In the
Default column, select the checkbox for the fund to use when the user does not select a fund.
The gift links to the participant’s constituent record, but not to the membership record.

You can allow users to select from a list of up to twenty five funds.

In the Button Text field, enter the text to appear on the button for users to click to purchase a
gift of membership, such as “Give a gift of membership.”

The button that users click to purchase gifts of membership appears in the Current

Membership section. When users click this button, the Join/Renew section appears.

12.

13.

Note:
14.

15.

16.

17.

When you select Allow additional donations, an additional contribution field appears on
your website. For members who contribute an additional donation, in the Fund field, select
the fund to credit.

To include the Gift Aid option, select Allow Gift Aid capture. The Gift Aid option displays
beneath Make an additional donation on the Membership Form. If desired, edit the default
text in the Gift Aid checkbox label, Gift Aid checkbox text, and Gift Aid confirmation label
fields.

To track why a website user joins the membership, select Include Join Reasons. Select the
reasons to show as possible answers for your website users, such as Interested in supporting
the program.

The Raiser’s Edge determines the available join reason information.

To track why a website user renews a membership, select Include Renew Reasons. Select the
reasons to show as possible answers for your website users, such as Special Interest.

In the Join Message box, enter a message that appears when the website user clicks your join
button, such as "Welcome to the ABC Museum!”

In the Renew Message box, enter a message that appears when a website user clicks your
renew button, such as "Welcome Back!”

In the Submit Button field, enter the text to appear on your submit button, such as “l want to
join now!”
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2 Design the Transaction section

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Memberships to Include, select the membership to appear on
your website.

Note: The Transaction section displays options for your member to join or renew a membership,
request additional cards and guest passes, and view benefit information.

Note: When a website user completes the Transaction section before the membership card
information.

a. Click Insert New. The Membership Categories screen appears.

b. Beside the membership category to include on your website, click Select. The Membership
Categories screen closes, and you return to the Membership Form part.

Note: You must add each membership category separately for your Membership Form part.

To remove a membership category from your website, click Remove next to the category
name selected in the Membership Category field.

2. For each membership category you select, membership category data appears on the
Membership Form part design screen. The Raiser’'s Edge stores this data. View the integrated
data and select whether to include the program and subcategory information (if it exists) on
your website, enter a text message, and enter a dues amount.

3. Select Allow member to specify the card/guest pass information so members can request
additional cards and guest passes.

Note: An individual membership Cards/Guest Pass section on your site uses the information created
in this procedure. If you create the Membership Form part for the first time, the information in this
section does not appear on the Membership Form until you select a membership in the
Memberships to Include frame.

Note: Card and guest pass creation is not a one time task for the Membership Form. To provide this
for your website users, you must create card and guest pass information for each membership
category included on your Membership Form.

4. In the Message box, enter the text to appear for the website user to read, such as the
maximum number of cards each primary member should have.

5. Enter the number of additional cards available to the member in Maximum no. of cards for
primary member.

6. To allow members to identify who the additional cards or guests are, select Allow member to
specify the names and relationships of additional members.

You can designate the maximum number of additional members in the No. of additional
members field and select the relationship types to include as options for your website users.
The Raiser’s Edge determines the available relationship types.

Select the fund to credit the dues amount.

To allow your members to view subcategory information, select Include Subcategories.
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10.

11.

12.

13.

In the Caption field, enter the text to appear on your website to inform the member that the
subcategory is being viewed, such as “Membership Subcategory.”

Select the checkbox for each subcategory you want to appear on your website. The offline
membership record determines the available subcategories.

Select the benefits included with this membership category.

Benefits appears next to the membership category on your website. To view benefit details,
the site user can click this link.

Select Show Quantity, Show Total Value, and Show Comments to display these details for
the benefits of your membership categories. The Raiser’s Edge determines the available
membership benefit information.

In the Benefits Form Message box, enter the text to appear on the Benefits screen. When a
user clicks Benefits, the text appears on the screen that appears under the membership
category name.

To display benefit notes on the Benefits screen, select Show Benefit Notes. In the view only
box, the benefit notes text from the membership record in The Raiser’s Edge displays.

14. Under Payment Options, select whether to allow website users to pay for memberships with

15

Tip:

other transactions, such as donations or event registrations.

a. To allow website users to pay for multiple transactions at one time, select Use payment
part. The Payment frame appears. In the Payment page field, select the web page to use to
process donations. The Payment part on the selected page determines the payment
methods and merchant account used to process memberships. For information about the
Payment part, see Payment on page 168.

In the box, enter the text to appear on the payment page after a membership is added. To
format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

b. To require website users to pay for memberships one at a time, select Proceed directly to
payment. The Confirmation Screen, Merchant Account, and Payment Methods frames
appear. Enter the necessary information in these frames, as described in the following steps.

. Under Confirmation Screen, select options for the membership summary that appears after a
user submits a membership.

a. To use the program’s default confirmation screen, select Use default confirmation screen.

b. To customize a confirmation screen, select Use custom confirmation screen. The HTML
editor appears. The program’s default confirmation screen appears in the HTML editor for
you to customize according to your needs.

In the box, edit the content to appear for the membership summary. To format the content's
appearance and layout, use the HTML editor toolbar. To include personalized information,
use merge fields. For more information, see the Program Basics Guide.

Customizations for the confirmation screen remain even if you select Use default confirmation

screen. To remove your customizations for the screen, select Use custom confirmation screen and

click

Restore default content. The program’s default confirmation screen appears in the HTML

editor for you to customize again.
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16. Under Merchant Account, select the merchant account to use to process credit cards, such as
your Blackbaud Merchant Services account.

The system administrator sets up merchant accounts in Administration. For more information,
see the Administration Guide.

17. Under Payment Methods, select the payment methods to offer to website users.

18. Click Next. The Acknowledgement Email screen appears.

19. Create an acknowledgement email for website users who use the membership form to join or
renew a membership. You can use the default text provided or enter different text.

Tip: When you edit a Membership Form, you can click Acknowledgement Email to access the
Acknowledgement Email screen. For information about how to design an email to acknowledge a
membership transaction, see the Email Guide.

20. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part v

Select how to display the consent options: @

Inline

® Overlay

a. Under Consent part, select a saved Communication Consent part to include on the form.

Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

21. Click Save. You return to Parts.

Menu (Deprecated)

Warning: The Menu (Deprecated) part was replaced with the more powerful Menu part. The Menu
(Deprecated) part type appears in Parts only if you have saved Menu (Deprecated) parts. While the
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deprecated part continues to operate for backwards compatibility on your website, you can no
longer create or copy Menu (Deprecated) parts. The Menu part includes all the functionality of the
Menu (Deprecated) part. In addition, the Menu part supports standards for Website Accessibility (WAI)
and includes a number of standard style options without the use of CSS. It also includes an import
tool to help upgrade your Menu (Deprecated) parts. For more information, see Menu on page 136.

Menu

With the Menu part, you can create a menu and a popup menu for your website. For example, when
you visit Blackbaud's website and hover over the Products menu, a popup menu appears. The popup
menu includes menu items such as Internet Solutions and Fundraising. You can create a similar menu

for your website using Menu.

Note: Some mobile devices do not support popup menus. If you use popup menus on your website,
we recommend that you also create an alternate menu for mobile devices. In Layouts, you can insert a
content placeholder pane for the menu with popups on a layout for desktop browsers. And on a
layout for mobile devices, you can insert a content placeholder pane for the menu without popups.
You can then select the layouts for a template and place only the appropriate Menu part in each pane.
This way, only the correct menu will appear in desktop browsers and mobile devices. For information
about how to create layouts and select them for templatess, see the Website Design Guide.

You create the Menu part in two steps. One step is to add the menu definitions, such as Home and
About Us. For each main menu item, you can define popup menu items. The second step is to create
the style and format for the menus using tables or an unordered list. For table-based menus, you can
select a color and font size to appear for a menu item when a website user hovers over the menu item.
You select standard CSS style options easily on the Edit Part screen in fields such as Border color and
Font color. You can also create custom styles if necessary. For menus based on unordered lists, you

assign the custom class for the menu.

Note: You can add log in and log out links to your menu. On the menu part for the log in link, use the
Create link to special page option to select a page that includes a User Login part. For the log out
link, use the Create link to Blackbaud NetCommunity page option to select the log out page that
includes the User Login part. Users view these links in the menu based on whether they are logged in

or out.

2 Upgrade a Menu (Deprecated) part

To upgrade a Menu (Deprecated) part for Website Accessibility and more style options, import the
part in a Menu part. When you upgrade a Menu (Deprecated) part, be aware that some style
options may not convert to Menu. Also, additional styles may be required for Menu. We
recommend you fully test a converted menu and re-create style options if necessary.

1. From the Design tab, select the Build tab. The Import Menu (Deprecated) Items frame
appears.
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| Design I Properties " IUsage “ Targeting & Security

| Build | Style
(kY

The menu is currently empty. Click the [ button to begin
adding menu items.,

Use this option to import all of the menu structure items from a Menu
(Deprecated) part. All items and their existing hisrarchy will be imported under
"Menu Items",

Note that Menu may require additonal styles that will not be imported.

Menu (Deprecated) part: |Sample Logout Menu v| [ Import Structure

[ Import/Overwrite compatible styles

h\_’“— \N‘_hﬂ""‘\.__"#\ "\“ J"A‘M“M
2. In the Menu (Deprecated) part field, a list of the existing Menu (Deprecated) parts appear.
Select the Menu (Deprecated) part to upgrade to Menu.

3. To import CSS styles from the Menu (Deprecated) part, select Import/Overwrite compatible
styles. If you do not select this checkbox, only the menu items and structure upgrade to Menu.

4. Click Import. The Menu (Deprecated) part upgrades to Menu.

5. Select the Style tab. The Styling Options frame appears. For more information about these
options, seeDesign a Menu definition on page 137.

6. Click Save. You return to Parts.

2 Design a Menu definition

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Show Me: Watch a video about how to add a web page to a menu.
1. From the Design tab, select the Build tab.

2. To add a menu item, click Add item. The menu item appears under the top-level parent menu
item, and the Menu item properties frame appears.


http://www.blackbaud.com/files/support/guides/demo/page3.aspx
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* 4 Add item Menu item properties
g-Menu items Label:
MNew menu item| New menu item
Tooltip:
Link:

Target window:

Styling class:

Apply to sibling menu items

Apply to all menu items at this level

Tip: To rearrange menu items, select them and click the arrows.

In the Label field, enter a menu item name to display in the menu.

In the Tooltip field, enter a description to display when the cursor hovers over the menu
item.

In the Link field, click the binoculars to link the menu item to a web page. The Create Page
Link screen appears. For information about how to create a page link, see the Program Basics
Guide.

If you enter a window in the Open in another window named field on the Create Page Link
screen, the Target window field displays the name of the window. To change the window,
click the binoculars in the Link field.

If you select Use unordered list menu on the Style tab, the Styling class field and two links
appear. In the Styling class field, enter the class name from your style sheet for the menu
item. For example, you can enter "red" or "blue" to change the item’s color.

For more information about style sheets, see the Website Design Guide.

+ To apply the class to sibling menu items within the same menu node, click Apply to sibling

menu items.

» To apply the class to all menu items in the part on the same level, click Apply to all menu

items at this level.
For example, enter "red" for Level 1 and click Apply to sibling menu items.
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E! @ E Menu item properties
E-Menu items Label:
= |Level 1 |
et Tooltip:
i i.Sublevel B | |
é---LeveI 2 Link:
E----Sublevel A | lﬁ
i..Sublevel B .
: Target window:
=-Section 2 | |
E-Level 1
© L Sublevel A fétvll'ng class: 1\
. i-Sublevel B red |
& Level 2 \-_AQQH{_' to sibling menu itemsj
;....Sublevel i A to all menu items at this level
...Sublevel B
Then enter "blue” for Sublevel A and click Apply to all menu items at this level.
E Menu item properties
E-Menu items Label:
& Section 1 Sublevel A |
| Bl .
Tooltip:
g-Level 2 Link:
E----Suhlevel A | 'ﬁ_“
i..Sublevel B .
; Target window:
=-Section 2 | |
B-Level 1

...Sublevel A

T~

’:E.t','ling class: \

_|_b|ue __} |

Apply to all menu items at this level

On your web page, the Level items are red in Section 1 only. Level items in Section 2 are not
because you only applied the style to siblings within the same node. All Sublevel items are
blue because you applied the style to all items on the same level regardless of the parent

node.
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+ Section 1
Level 1
Sublevel A
Sublevel B
Level 2
Sublevel A
Sublevel B
* Section /
> Level 1
Sublevel A
Sublevel B
o Level 2
Sublevel A
Sublevel B

3. To add an additional menu item, click Add item, and repeat the steps in this procedure. You
can add as many menu items as necessary.

4. On the Style tab, select whether to style the menu with tables or with an unordered list
formatted by CSS.

5. To style the menu with tables, select Use table-based menu.
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& Use table-based menu ) Use unordered list menu
Category:
| General v| Select whether to apply style options to the entire menu,
submenus, menu items or submenu items. For example, select
"Main Menu" to apply a background color to the entire menu,
and select "Main Menu Selected Item” to apply a background
color to menu items after users select them.
COrientation: Text wrap:
|Vertica| V| |ND V|
Display popup image on main menu; Display popup image on submenus:
|N|:| V| |Yes V|
Static levels: Static level indent:
K v 20px |
Preview background color: Custam glyph:
B | (White) x| [#
Mo image
selected
Preview: Apply changes

In the Category field, select a style category to apply style options. For information about
the style categories, see Style Categories for the Menu on page 144,

To create a custom class for CSS style options, select Enable custom CSS.

In the Custom class field, enter a custom class such as “.navMenultem.” You enter the CSS for
the custom class in Style sheets. For information, see the Website Design Guide.

To select standard CSS style options, select Enable standard CSS.



142 CHAPTER 1

The available style options depend on the style category. For information about the standard
CSS styles, see Standard CSS Style Options for Menu on page 142.

d. After you select style options for a style category, select another style category. The program
saves your changes.

6. To style the menu with an unordered list formatted by CSS, select Use unordered list menu.

) Use table-based menu (&) Use unordered list menu

Taop level class name:

7. Inthe Top level class name field, enter the custom class name. You enter the CSS for the
custom class in Style sheets.

For information, see the Website Design Guide.

8. Click Save. You return to Parts.

Standard CSS Style Options for Menu

Standard CSS style options vary depending on the category you select. Refer to the following tables
for standard CSS styles for each Menu category. For information about applying standard CSS style
options, seeDesign a Menu definition on page 137.

Style category: General

Orientation Display popup
image on
submenus

Static levels Custom glyph

Static level indent | Preview
background
color

Display popup Text wrap

image on main

menu

Style category: Main Menu or Popup Menu
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Background color

Font size

Border color

Font underline

Border style Font color

Border width Height

Bold Horizontal
padding

Italic Vertical padding

Font name(s)

Width

Style category: Main Menu Item or Popup Menu Item and Main Menu Selected Item or Popup Menu

Selected Item

Background color

Font size

Border color

Font underline

Border style Font color
Border width Height

Bold Item spacing
Italic Width

Font (names)

Style category: Main Menu Item Hover or Popup Menu Item Hover
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Background color

Font name(s)

Border color

Font size

Border style Font underline
Border width Font color
Bold Height

Italic Width

Style Categories for the Menu

In the Category field of the Menu part, you select style categories to apply style options. Style
categories include the various menu types. This table describes the available style categories.

Style Category

Description

General

Main Menu

Main Menu ltem

Main Menu Item Hover

Main Menu Selected
[tem

Popup Menu

Popup Menu ltem

This applies to your entire menu. For example, Blackbaud's menu is
horizontal at the top of every web page.

This is your main menu. For example, Home, Products, and Services are a part
of the main menu on Blackbaud's website.

This is your main menu in its natural state. For example, you browse
Blackbaud'’s website, but you are not currently hovering or clicking a menu
item.

This applies to a main menu item when a user hovers the cursor over it. For
example, when you hover the mouse over Blackbaud’s Products menu item,
the menu button changes to a darker shade of grey.

This affects a main menu item after a user clicks it. For example, when you
click Blackbaud's Products menu, you land on the Products page and the
Products menu button has a bright yellow background to indicate it is for
the current web page.

This applies to your popup menu. For example, when you hover over
Blackbaud's, Products menu, a popup menu appears with menu items such
as Fundraising, Forms, and Solutions by Industry.

This is your popup menu in its natural state. For example, you hover over
Blackbaud'’s Products menu to view the items on the popup menu for it, but
you are not currently clicking or hovering over a popup menu item.
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Style Category Description

Popup Menu Item This applies to a popup menu item when a user hovers over the popup menu

Hover item. For example, you hover your mouse over Blackbaud'’s Fundraising
popup menu item. When you do this, the popup menu button changes to a
lighter shade of blue.

Popup Menu Selected  This affects a popup menu item when a user navigates to the web page for

ltem that menu item. For example, you click Blackbaud's Fundraising popup menu
item. You land on the Fundraising page. You can select to style the
Fundraising popup menu button with a bright yellow background to
indicate to a user he or she is on the web page for that popup menu item.

Navigation Buttons

To create a navigation bar, use the Navigation Buttons part. Buttons on a navigation bar honor security.
For example, if you have a Board Members Only page, only a website user logged in as a board
member can view a button on the navigation bar used to access this page.

2 Design Navigation Buttons

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Orientation field, select the orientation to display the navigation
bar on your web page.

Orientation: | Horizontal bl

Preview with Stylesheet: | System Default b

Click an an item to =dit its properties.

« To display the navigation bar from left to right, select “"Horizontal.”
 To display the navigation bar from top to bottom, select “Vertical.”

Tip: Use the up and down arrows to sort your navigation buttons in the order they will appear on
your web page.
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2.

3.

In the Preview with Style Sheet field, select the style sheet to use for your navigation bar. For
example, to use the default style sheet, select "System Default.”

For more information about style sheets, see the Website Design Guide.

To add a button for your navigation bar, click Add Item. The Navigation Bar Item screen
appears.

Navigation Bar Item

4.

Caption:

Fage: ﬁ

Default Image:

Howver Image:

SN
A2

Selected Image:

oK Cancel

In the Caption field, enter the information to appear in a yellow box when your website user
moves the mouse over a navigation bar button.

Warning: All images used for navigation bar buttons must be previously created and saved using
graphics software such as Microsoft Photo Editor. You cannot create these images in the program.

To not use images for a navigation bar button, add a linked heading for navigation. In the
Caption field, enter the heading to link. The heading you enter appears on your web page and
is linked automatically. To select the web page to link to, complete the next step in this
procedure.

In the Page field, click the binoculars to select the web page where the navigation bar
appears. The Create Page Link screen appears. For information about how to create a page
link, see the Program Basics Guide.

In the Default Image field, view the image that automatically appears when your website user
accesses the web page, before the website user moves the mouse over or clicks the button.

To select a default image, click the Image button. The Select Image from Image Library screen
appears.
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7. In the Hover Image field, view the image that appears when your website user moves the
mouse over the button on the navigation bar but does not click the button.
To select a hover image, click the Image button. The Select Image from Image Library screen
appears.

8. In the Selected Image field, view the image that appears when your website user clicks the
button on the navigation bar.
To select a selected image, click the Image button. The Select Image from Image Library
screen appears. For more information about how to insert an image, see Program Basics Guide.

9. To save the images for your navigation bar, click OK. You return to the Edit Part screen. On the
Design tab, the selected images appear.

Note: To cancel the addition of the images for the navigation bar, click Cancel. You return to the Edit
Part screen.

10. Click Save. You return to Parts.

News Reader

The News Reader part type allows the system administrator to display Really Simple Syndication (RSS)
content or Atom content on your website. These are XML-based formats used to distribute web
information. For example, if your organization is health related, you can create a web page for health
tips and include a News Reader part type that includes news headline feeds from other health-related
websites. Using RSS or Atom and the News Reader part, you can include these headlines on your

website automatically.
The website supports RSS versions 0.9, 1.0, and 2.0 and Atom version .3.

2 Design News Reader
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.
1. From the Design tab, in the Source field, enter the website address that contains the XML

content to display on your website. Typically, sites that share content display orange XML
icons that are hyperlinks to their website feeds.

General
Source #
Link target:
blank Enter where to open linked pages. To open links in a new
window, enter "_blank.”
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2. Inthe Link target field, enter where to open the linked page. For example, to open the link in
a new window, enter “_blank.”

Display options
Mumber of articles to display:

0 Only the most recent articles appear. Enter "0" to display all
articles.

[ pisplay |10 | articles per page
[ bisplay headlines but not articles
Display graphics associated with the feed

Display dates for postings if available

3. Inthe Number of articles to display field, enter how many articles to display. To display all
recent articles, leave the default “0” in the field.

4. To display articles on multiple pages, select Display [ ] articles per page and enter the
number of articles per page.

5. To display article titles only, select Display headlines but not articles. Users can click links to
access articles.

6. To display any graphics associated with the website feed, select Display graphics associated
with the feed.

7. To display dates for the articles, select Display dates for postings if available.

Authentication options
Type:

| v| Basic authentication does not encrypt the user name and
password. It sends the credentials over the network in
plaintext. Digest authentication encrypts the user name and
password. It does not send them over the network in plaintext.

8. Under Authentication options, enter the authentication information for a website that
requires authentication to access its XML content.

a. Inthe Type field, select the authentication type that the news feed provider requires.
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Note: Basic authentication does not encrypt the user name and password and sends the credentials
over the network in plaintext. Digest authentication encrypts the user name and password and does
not send them over the network in plaintext.

b. Inthe User name and Password fields, enter your authentication information. To display
XML content that requires authentication, you must have a user name and password with the
news feed provider.

9. Click Save. You return to Parts.

Page Element Types

To add sections to a web page that are dynamic and customizable for an individual’s use, create page
element parts. The program contains multiple page element part types for the end users of personal
pages. These part types are Chapter Page Elements for chapter managers, Fundraiser Page Elements for
solicitors or participants for a team fundraiser, and Personal Page Elements for anyone who wants to
create a personal page on your site. One example is someone who is ill and wants to create a care
page for family and friends to visit. With web pages that contain page elements, the pages have
customization parts (the page element types) for use on a personal level. For more information about
these parts, see the Chapter Management Guide, Team Fundraising Guide, and Personal Page
Management Guide.

When someone has a personal page on your site, other people who support or know the individual
can visit the personal page to learn more about his relationship with your organization and make
donations. Web pages with page elements also contain static sections that are other parts. Use these
sections to create defaults for your organization to appear on every personal page. For example, use
the static parts to include your mission statement, graphics, or any other information to appear on
every personal page.

When you create a page element part, you select the type of page element to appear on a personal
page. The chart lists every page element type and the page element parts where they are available. For
example, for a Chapter Page or Personal Page Element, you can select a News Reader element type.
Page element types create various forms of customizable parts for pages. For information about each
page element type, review the procedure that applies to the type.

Page Element Chapter Page Fundraiser Personal Page
Type Element Page Element Element

Action X X X

Comments X X

Directory X

Donor List X

Event Calendar X

News X X

News Reader X X
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Page Element Chapter Page Fundraiser Personal Page
Type Element Page Element Element
Page Links X
Personal Notes X

Photos X X X

Profile X X

Profile (EE) X X

Rich Text X X X
Scrolling Donor X

Display

Team List X

Text X X X
Thermometer X

Action Page Elements

To include a Report Abuse button on a web page for a Chapter Manager, Fundraiser, or Personal Page
Manager part, you can create an Action page element type. Site visitors can click this button to report

activity that is inappropriate for your site. When a visitor clicks this button, your website administrator

automatically receives an email notification about the inappropriate activity.

> Design Action for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Action” in the Display As field.

Note: You can include the Action page element in a Chapter, Fundraiser, or Personal Page element
parts.

2. Inthe Display Name field, enter a name for the action section on the page.

3. Inthe CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements, such as to change the text on the Report Abuse
button. CSS is easier to use than other methods, such as HTML. Unless you specify a custom
style sheet, your website uses default style sheets.

For more information about CSS, see the Website Design Guide.
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4. Under Details, depending on the personal page type you create, such as Chapter Page

Element, different options appear in the Display As field. For more information about this
field, review the chart and steps.

Chapter Page Element Fundraiser Page Element Personal Page Element
Chapter Console Link Team Page Link Report Abuse
Report Abuse Report Abuse

5. Inthe Display As field, if you create the Action page element for a Chapter Manager part,

a.

b.

select "Chapter Console Link."” This creates a navigation link for content and data managers to
click to access his Home page on your chapter site. The link appears only for managers
contained in a role with rights to manage the chapter content or data. When you select
“Chapter Console Link,” a Link Text field appears. Enter the text to appear as a hyperlink on
your chapter site, such as “My Console Manager.” Managers of the site click the link to access
the Home page.

If you create the Action page element for a Fundraiser part, select “Team Page Link.” This
creates a navigation link to direct the site visitor to the solicitor's team page. When you select
this, a Text field appears on your site for the participant to enter link text for his personal
page, such as “Click here to visit my page.” If the solicitor is really a participant and not on a
team, the link to the team page does not appear.

U

If you create the Action page element for a Personal Page Manager part, select “Report Abuse’
to include a Report Abuse button on the personal web page. Additional fields appear.

In the Display Text field, enter the text to appear on the button on your website, such as
“Report Website Offense.”

In the Email field, enter your website administrator’'s email address. This address does not
appear on your site. However, if a user clicks the Report Abuse button on your site, your
administrator automatically receives an email notification about the inappropriate activity.

In the Confirmation Message field, enter the text to appear for a site user who clicks the
Report Abuse button. The default text is “This page has been reported to the administrator.”

6. Click Save. You return to Parts.

Comments Page Elements

To allow page owners to add a comments section to their personal page, create a Comments page
element type. When a personal page has this functionality, friends and family of the personal page's
“owner” can post comments, public or private, to the page.

Note: Website users with supervisor rights can edit and delete posts for the Comments page
element.

2 Design Comments for Page Elements

For information about page element parts, see Page Element Types on page 149.

1.

From the Design tab, select “Comments” in the Display As field.
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Note: You can include the Comments page element in a Fundraiser or Personal Page Elements part.
2. In the Display Name field, enter a name for the comments section on the page.

3. Inthe CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements, such as to change the text on the Post a Message
button. CSS is easier to use than other methods, such as HTML. Unless you specify a custom
style sheet, your website uses default style sheets.

For more information about CSS, see the Website Design Guide.
4. Under Details, in the Default Title field, enter a title for your comments box on your website.

a. Inthe Button Caption field, enter a label for the button that website users click to post a
comment.

b. To allow visitors to create private comments, select Allow Private Messages.

c. To display dates for comments, select Display under Date Column.
In the Caption field, enter a column header. The default header is Date.

d. To display comments, select Display under Message Column.
In the Caption field, enter a column header. The default header is Message.

e. To display the names of comment authors, select Display under Author Column.
In the Caption field, enter a column header. The default header is Author.

5. Click Save. You return to Parts.

Directory Page Elements

To allow chapter managers to access directories on chapter pages, use the Directory page element
type. This directory contains a list of the names in the Members role in the Chapter Manager part. For
more information about this role, refer to the Chapter Management Guide.

2 Design Directory for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, in the Directory title field, enter a name for the directory, such as “Class
of 2000 Directory.”
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Directory title: Directory
Records to Include
Limit to query: | (All Constituents) ;i
Include: Individuals Only -
Include Deceased: [
Search Form
Split search fields into: 1 * column(s).
[[]Load unfiltered results when this part is loaded
Results
Show navigation controls: Both above and below the results - Results per page: & ™
Show number of results: Both above and below the results -
Enable alphabetical index for individual and organization name
Display text: Last name index:
No records found message: Mo directory entries match your criteria
Linked profile page: -

Include a page link for: ¥ [(applies to Individuals only)

Include a send message link for: < Specify User Networking Manager = - [ Allow messages to non-users

R N T

2. Under Records to Include, specify the records to include in the directory search results.

a. The Limit to query field displays the selected query of records included in the directory. By
default, “All Constituents” appears.

Tip: For a query to appear as a selection, you must first create it in The Raiser's Edge. When you

create a query, you may need to refresh the website for it to appear as a selection. To refresh, select
View, Refresh from the menu bar.

To include information from all constituents in your database, leave the default "All
Constituents.” To select another existing constituent query to use as the directory, click
Change. The Query Search screen appears.

For information about how to use the Search screen, see the Program Basics Guide.

b. Inthe Include field, select the type of constituent records to include in the directory search
results. You can select “Both Organizations & Individuals,” “Individuals Only,” or
“Organizations Only.”

c. Toinclude deceased constituents in the directory search results, select Include Deceased.

3. Under Search Form, in the Split search fields into field, select how many columns of search
fields to appear in the criteria table. You can display up to five columns.

To process a search while the user browses your Directory part, select Load unfiltered results
when this part is loaded. When you select this checkbox, the directory search processes
before the user enters criteria and clicks Search on your website.

4. Under Results, set up how search results appear on your Directory part.

a. Inthe Show navigation controls field, select whether the navigation buttons should appear
above the results, below the results, or both above and below the results.
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b. The directory search can return up to 500 results that match the criteria entered by a site
user. In the Results per page field, select the maximum number of results to appear on a
page when a site user searches the directory. You can display up to 50 results per page.

¢. You caninclude in the search results the total number of records that met the user's search
criteria. In the Show number of results field, select whether to display the total number of
results above the results, below the results, or both above and below the results.

d. Inthe No records found message field, enter the message to appear if no records meet the
search criteria the user enters to search the Directory on your website. By default, the
message “No directory entries match your criteria” appears.

e. Directory results can link to a page containing a Profile Display part. In the Linked profile
page field, select the page to link to. The field you list first in the Listing Fields box
becomes the link to the page you select in Linked profile page field.

To display additional education profile information, link to a page that includes a User
Education Profile Form part under a Profile Display part. A Profile Display part contains
primary education information such as Campus, GPA, and Major. The User Education Profile
Form part includes this information for all education records.

f. To allow website users to view Team Fundraiser or Personal pages for individual constituents
included in the results, in the Include a page link for field, select the Fundraiser or Personal
Page Manager part to link to the directory results.

g. To allow website users to send personal messages to constituents in the results, in the
Include a send message link for field, select the User Networking Manager part to link to
the directory results.

Note: If constituents opt out of email in The Raiser's Edge, website users can send them personal
messages through the user networking site, but they cannot send them email messages.

h. To allow website users to send personal messages through the User Networking Manager
part to constituents who are not registered website users or who are registered but are not
members of the user networking site, select Allow messages to non-users.

Warning: Constituents who do not have user networking accounts receive personal messages
through email. To allow users to send email messages to these constituents, you must enable a
Directory Message Notification in Email and select the User Networking Manager part for it. Without
this notification, your users will not be able to send messages to constituents who are not registered
website users or to constituents who do not have social networking accounts. For more information
about notifications, see the Email Guide.

5. Under Fields to Include, select the fields the user uses to search the directory, such as First
Name or Last name. Right-click and drag the field from the Available Fields box to the
Search Form Fields box, or select the field in the Available Fields box and click the right
arrow to move it to the Search Form Fields box.
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Fields to Include

Available Fields: A search Form Fields:
Bl &2 profie Fields
=
i
[C Organization

[ Preferred Address
[ Phones and Email
[CRecord
[ 5pouse
[ Business
[ Primary Alumni
[ Education History

[C Constituent Attributes Listing Fields:

[ Primary Education Attributes
=

[ Education History Attributes

Note: The system administrator selects the attributes available on the Settings tab on the Settings tab
in Sites & settings. For more information, see the Administration Guide.

Note: The Education History and Primary Alumni search fields appear only if you use Alumni
Tracking in The Raiser's Edge. To allow website users to search only primary alumni information, use
the Primary Alumni search fields. To allow users to search primary alumni and education history at
the same time, use the Education History search fields and include the Alumni Info field.

To arrange the placement of a field in the Search Form Fields box, select the field and click
the Up or Down button.

Note: The fields in the Search Form Fields list and the Listing Fields list do not have to match.

6. Select the fields to appear when the search finds a match. To select a field, right-click and
drag it from the Available Fields box to the Listing Fields box. To move a field from the
Available Fields box to the Listing Fields box, you can also select it and click the right arrow.

To arrange the placement of a field in the Listing Fields box, select the field and click the Up
or Down button.

Warning: The listing field you put first for results acts as a link to the constituent record. However, if,
on the Profile Form, the field's data is marked Privacy edit and the user selects to hide the data, no
link exists. For example, if you select to list First name first, and the user selects to hide First name
data, no link appears.
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While you can link every field, the field you place first in the Listing Fields box automatically
links to the page you select in the Linked Page field. For example, you select to display the
alumni’s last name, first name, birth date, address, and whether the user wants to receive email.
In this case, the last name is the link. When results appear, to indicate the last name is a link, it
is underlined and changes color when you drag your mouse over it. When a website user clicks
the alumnus's last name, the published profile information for that constituent appears.

7. Click Save. You return to Parts.

Donor List Page Elements

To include a list of donors on a participant’s personal web page for a Fundraiser part, create a Donor
List page element type. When you include a Donor List on a page, there is no customizable part for the
participant to edit. However, this list allows you to recognize donors on your site.

2 Design Donor List for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Donor List” in the Display As field.

Note: You can include the Donor List page element in a Fundraiser Page Elements part.
2. In the Display Name field, enter a name for the donor list section on the page.

3. Inthe CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements, such as colors, fonts and styles, and spacing for your
part. CSS is easier to use than other methods, such as HTML. Unless you specify a custom style
sheet, your website uses default style sheets. For more information about CSS, see the Website
Design Guide.

4. Under Details, select the order of appearance for the donor names.

a. Inthe Sort By field, select whether to sort by date or amount or in ascending or descending
order.

b. Inthe Name Format field, select whether to display the full first and last names or by initial
only.

To display comments the donor enters on the donation page, select Display Comments.
d. To display the gift donation amount, select Display Amount.
5. Click Save. You return to Parts.

Event Calendar Page Elements

To include a calendar on your chapter site, create an Event Calendar page element type. Managers use
the calendar to post event dates and information to a web page.
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2 Design Event Calendar for Page Elements

For information about page element parts, see Page Element Types on page 149.

1.

From the Design tab, under General options, enter a name for the calendar in Calendar title
field.

Under Default display, select the default view of the calendar. You can select Calendar view
or List view. The website user can always select a different view when they open the calendar.

To integrate the calendar with events that have been created in The Raiser's Edge, select
Include events from The Raiser's Edge. Click the binoculars to select an existing event query
in The Raiser's Edge. When you include events from The Raiser's Edge on your website event
calendar, the events appear after the next integration. To integrate the calendar with events
from the query, include frequency information under The Raiser's Edge integration in
Administration. The calendar updates according to the frequency unless you click Refresh
events to immediately integrate the calendar with events. For information about frequency
settings, refer to the Administration Guide.

Tip: We recommend that you add an event attribute to the event records in The Raiser's Edge that
you want to display on your website event calendar. You can then create an event query for events
with that attribute.

4. Under Uncategorized events management rights, select the roles with rights to manage any

events not associated with a category.

Under Event Categories, select the event categories to associate with the calendar. After you
add a category, click Assign rights to the category. The Event Category Security screen
appears so you can assign rights to users and roles for the event category. For example, a
Soccer calendar may have the Registration, Practice, and Games categories, and only users in
the Coaches role can add, edit, or delete events in these categories. Also, when the coach adds
a new event, they can assign its category from those you select for the calendar. For example,
the coach specifies whether the new event is Registration, Practice, or Games. You can use
these categories to filter the types of events that appear in calendar groups and calendar
highlights. For example, you can set a calendar highlights part to display only events included
in the Game category. For information about how to add event categories, see the
Administration Guide.

To include a weblog for the Event Calendar part, select Enable RSS. Additional fields for the
weblog appear.

In the Date format field under Appearance, select a date format for the weblog.

Under RSS publishing properties, in the Title field, enter a title for the weblog.

In the Link URL field, enter a website address news readers can use to link to the calendar
weblog. Also, if your website has a News Reader part, add this link to your news reader so it
displays new events when they are posted. For more information about the News Reader
part, see News Reader on page 147.

d. Inthe Description field, enter a description for news readers about the types of events

posted on the calendar. For example, if your organization supports the environment, enter
“"Upcoming Local and National Events Supporting the Environment.”

e. Inthe Copyright field, enter a copyright notice for the weblog, if you have one.
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f. In the Editor’s email field, enter the email address for the person responsible for the content
of calendar postings.

g. To approve weblog posts before they appear on your site, select Moderated.

7. To add a picture to the calendar weblog, click Select Image under Image properties. The
Select Image from Image Library screen appears. For information about how to insert an
image, see the Program Basics Guide.

8. Inthe Link URL field, enter the web address to open when a user clicks the image. The link can
access another page on your site or an outside website.

9. Under Security rights, define the roles with post and manage rights for the published events.
a. Inthe Post column, select the checkbox to assign post rights for users and roles allowed to
post to the weblog. This does not include rights to edit or delete postings.

Note: If the list is marked Moderated, posts are pending until a user with Manage rights approves
them. A user with Post rights views his or her pending posts, but not those of other Post users. Only
users with Manage rights view all pending posts.

b. Inthe Manage column, select the checkbox to assign manage rights for users and roles
allowed to add, edit, and delete weblog postings. If the list is marked Moderated, this
grants rights to approve postings.

c. Toinclude additional users and roles, select Add users and roles.
10. Click Save. You return to Parts.

News Page Elements

When you add a News page element type to a personal page, users can include news on their page.
For example, a user who is ill creates a personal page that contains a News page element part. She can
write her own news article about her sickness for the personal page, or she can include links to news
articles from other websites to create awareness about her type of sickness.

2 Design News for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “News” in the Display As field.

Note: You can include the News page element in Chapter or Personal Page Elements parts.
2. Inthe Display Name field, enter a name for the news section on the page.
3. Under Details, in the Title field, enter a title for your news weblog. This name appears on the
personal page.
a. Inthe Link URL field, enter the website link that news readers such as NewsGator use to link

to your site. This link should direct the website user to your news weblog or a general
information page about your organization.

b. In the Description field, enter any additional information as required. For example, if your
organization supports the environment, enter “"Check weekly for updates.” To view the
information you enter in this field, click XML for the weblog. For this example, the XML
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information for your description reads " <description>Check often for weekly
updates</description>."

In the Copyright field, enter a copyright notice for the news, if you have one.

d. Inthe Editor’s Email field, enter your email address or the person who is responsible for the
content of your weblog.

4. Under Image Properties, click Select Image to add a picture. The Select Image From Image
Library screen appears. For information about how to insert an image, see the Program Basics
Guide.

5. In the Link URL field, enter a link to another website so you can share valuable information
from that website with your site users.

6. Under Security Rights, to assign your website members rights to edit the news weblog posts,
select Allow members to add, edit, and delete posts?

7. Click Save. You return to Parts.

News Reader Page Elements

With the News Reader page element type, you can display Really Simple Syndication (RSS) content or
Atom content on personal pages. These are XML-based formats used to distribute web information.
For example, if your organization is health related, users can create a personal page for health tips and
include a News Reader part that displays news headline feeds from other health related sites. With RSS
or Atom and the News Reader part, you can include these headlines on personal pages automatically.

2 Design News Reader for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “News Reader” in the Display As field.

Note: You can include the News Reader page element in Chapter or Personal Page Elements parts.
2. Inthe Display Name field, enter a name for the news reader section on the page.

3. Inthe Feed URL field, enter the website address that contains the XML content to display on
your website. Typically, sites that share this content display an orange XML icon that is a
hyperlink to their website's feed.

Note: The website supports RSS versions 0.9, 1.0, and 2.0, and Atom version .3.

4. Inthe Display only the [ ] most recent articles field, enter the number of recent articles to
display on your news reader. For example, to display five articles, enter “5.” To display all
recent articles, leave the default “0” in the field.

5. To display the XML content on multiple pages, select Use paged output, with [ ] articles per
page. In the field, enter the number of items per page.

If you do not select this checkbox, the articles display on one web page.
6. To display only the article title, select Display only the headlines in this feed.

If you do not select this checkbox, the complete article appears on the news reader.
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7. To display the graphic associated with the website feed, select Display any graphic
associated with this feed.

8. To include the date the feed posts to your website, select Display the date for each posting,
if available.

9. For awebsite that requires authentication to access its XML content, enter the authentication
information under News Reader Authentication.

a. Inthe Type field, select the authentication type that the news feed provider requires.
Note: Basic authentication does not encrypt the user name and password and sends these credentials

over the network in plaintext. Digest authentication encrypts the user name and password and does
not send them over the network in plaintext.

b. Inthe Username and Password fields, enter your authentication information. To display XML
content that requires authentication, you must have a user name and password with the news
feed provider.

10. Click Save. You return to Parts.

Page Links Page Elements

For users who have multiple personal pages, you can add Page Links to a personal page element to
create a list of links to the personal pages that are public.

2 Design Page Links for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Page Links" in the Display As field.
2. Inthe Display Name field, enter a name for the personal page element.

In the CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements, such as a border around an image. CSS is easier to use
than other methods, such as HTML. Unless you specify a custom style sheet, your website uses
default style sheets.

For more information about CSS, see the Website Design Guide.

Note: You can include the Page Links page element in a Personal Page Elements part.
4. In the Default Title field, enter a default title for the list of links.

5. Click Save. You return to Parts.

Personal Notes Page Elements

To display contents from the Notes tab of a constituent record on your site, create a Personal Notes
page element. This creates a list of notes for a user on a personal page in the Personal Page Manager
part. You select the note types to appear on the page.
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2 Design Personal Notes for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Personal Notes” in the Display As field.

Note: You can include the Personal Notes page element in a Personal Page Elements part.
2. Inthe Display Name field, enter a name for the notes section on the page.

3. Under Topics to Include, select the checkbox beside the note topic to include on your web
page.

The Notepad Type table in The Raiser's Edge determines the available note topics. To add or
edit a note topic, do this in The Raiser's Edge.

a. Inthe Display As column, enter the information to appear for the note topic on the web
page.
b. To allow users to create more than one note topic, select Multiple Submissions Allowed?

If you do not select this checkbox and the user has multiple note topics of the same type
existing on a constituent record, all notes can appear in note search results.

4. Under Heading, in the Default Title field, enter a name for the web page.

5. In the Default Instructions field, enter content to inform the user how to search for a note.
Leave the default instructions, or write your own instructions.

6. Under Listing Options, in the No records found message field, enter the message to appear
when a user does not have notes to display. Leave the default text, or write your own text.

To allow users to update their personal notes, select Allow users to edit/update their own
notes.

7. Click Save. You return to Parts.

Photos Page Elements

To upload graphics for a personal page, create a Photos page element. You can upload graphics for
individual use on a personal page, or you can upload a series of graphics to create a slideshow. Your
organization can upload all the graphics for personal pages and allow a user to select the images she
wants, or you can allow a user to upload an image of her choice. When you create a Photos page
element, you must select a default image to appear on the page. If a user does not upload an image to
the Photos part on her personal page, the default image appears.

2 Design Photos for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Photos” in the Display As field.

Note: You can include the Photos page element on a Chapter, Fundraiser, or Personal Page Elements
part.

2. In the Display name field, enter a name for the photos section on the page.
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In the CSS box, enter Cascading Style Sheets (CSS) to override the default style of this
element.

Use CSS to create unique elements such as a border for images. CSS is easier to use than other
methods such as HTML. Unless you specify a custom style sheet, your website uses default
style sheets.

For information about style sheets, see the Website Design Guide.
Upload each image.

a. Under Details, click Add Image. The Select From Image Library screen appears. For more

information about how to upload an image, see the Program Basics Guide.

b. To designate the default image that appears when users do not select one, select Default.

Under Slideshow Options, select whether to allow website users to add slideshow captions,
enter a default caption, and enter how long to display images during the slideshow.

Under Image Options, enter the maximum dimensions for a slideshow image in the
Maximum height/width field. This limit defines the height and width of the boundary that
contains images but does not directly alter the size of images.

Warning: An image's number of pixels cannot exceed the number you enter in the Maximum
height/width field. For example, if you have an image that is 200 pixels and set this boundary to
500 pixels, the image does not increase to 500 pixels. Conversely, if you have an image that is 500
pixels and set the height/width size to 200, the image shrinks to fit that boundary.

7.

In the Image tags field, select the tags to associate with images. Tags are keywords or phrases
to identify an image’s content. To create a tag for slideshow images, enter it in the And/or
new tag field. For more information about tags, see Tags Tab on page 23.

Click Save. You return to Parts.

Profile Page Elements

To allow personal page owners to create profiles of the individuals who visit their personal pages, add
a Profile page element to a Fundraiser or Personal Page Element part.

2 Design Profile for Page Elements

For information about page element parts, see Page Element Types on page 149.

1.

From the Design tab, select "Profile” in the Display As field.

Note: You can include the Profile page element in a Fundraiser or Personal Page Elements part.

2.
3.

4.

In the Display Name field, enter a name for the profile section on the page.

To format the email content’s appearance and layout, use the HTML editor. For more
information about the HTML editor, see the Program Basics Guide.

Click Save. You return to Parts.
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Rich Text Page Elements

To add a hypertext link, a remote photo hosted on another server, or formatted text to a personal
page, create a Rich Text page element. When you add include the Rich Text page element, remember
that it provides a lot of power to the owner of the page. The program automatically removes IFRAME
and SCRIPT tags from Rich Text page elements, but the potential remains for site abuse. With a Rich
Text page element, page owners can link to or display inappropriate content. However, visitors of the
page cannot edit the page element. When you use the Rich Text page element for remote photos, you
can only link to an existing image URL. You cannot upload images.

2 Design Rich Text for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Rich Text” in the Display As field.

Note: You can include the Rich Text page element in a Chapter, Fundraiser, or Personal Page Elements
part.

2. Inthe Display Name field, enter a name for the rich text section on the page.
Note: Details are not available for the Rich Text page element because it is not editable for visitors of
the personal page.

3. Click Save. You return to Parts.

Scrolling Donor Display Page Elements

The Scrolling Donor Display page element allows you to recognize donors for a participant in a Team
Fundraiser. If you include the Scrolling Donor Display page element on a personal page, the participant
accesses the scrolling list of donors (sometimes referred to as a donor wall) from the My Page button
on the participant dashboard. You can customize the list by options such as the scrolling direction, play
and pause buttons, and gift types to include

2 Design Scrolling Donor Display for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Scrolling Donor Display” in the Display As field.

Note: You can include the Scrolling Donor Display page element in a Fundraiser Page Elements part.
2. In the Display Name field, enter a name for the donor list section on the page.

3. Inthe CSS box, enter Cascading Style Sheet (CSS) text to override the default style of this
element.

Use CSS text to create unique elements such as colors, fonts and styles, and spacing for your
part. CSS is easier to use than other methods, such as HTML. Unless you specify a custom style
sheet, your website uses default style sheets. For more information about CSS, see the Website
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Design Guide.

4. In the Player options frame, in the Title field, enter a name for the donor wall. This title
appears on your site.

a. Inthe Width/Height field, enter the maximum dimensions in pixels for the donor wall. This
setting defines the height and width of the boundary that contains the donor list.

b. In the Scrolling direction field, select whether donor names scroll in ascending or
descending order.

c. Inthe Speed field, select how fast donor names scroll in the donor wall.

d. To include play and pause buttons for the donor wall on the web page, select Display play
and pause options.

5. Under Results options, select options for the part results that appear on the web page. You
can filter the list of donors for the donor wall and enter text to appear in the donor wall.

a. Inthe Number of results field, select the number of donors to include on the donor wall. To
include all donors, leave the default “All results.” You can filter the list of donors to 10, 25,
50, or 100 names.

Warning: The more donors the list includes, the more hardware space used. This degrades the
display load time. To avoid this risk, in the Number of results field, select “100” or lower.
b. In the Sort results by field, select how the donor list should sort. You can select Top
donations, Donor’s last name/organization name, or Most recent donations.

Warning: If you select "All results,” the part processes a maximum of 10,000 gifts. If the maximum is
met, the gifts that appear depend on the selection you make in the Sort results by field. For
example, if you select to sort by “Most recent donations,” the 10,000 most recent donations appear
on the page.

c. Inthe No results message field, enter the text to appear if the donor wall does not contain
donor names. For example, enter “No gifts found. The Fundraiser may not yet have donors.”

6. Under Gift types and labels, select the gift types to include in the donor wall. For example,
you can include accepted gifts and pledges and exclude pending gifts and anonymous gifts.
For each gift type, enter the text to appear for the gift type in the corresponding field.

Note: The Include pending gifts in results and display as checkbox includes gifts that have not
been downloaded to The Raiser's Edge.

a. To include gifts from organizations, select Include gifts from organizations.
b. To include the gift amount from the donor, select Display amount of gift.
c. Toinclude donor comments, select Display comments in results.

7. Click Save. You return to Parts.

Team List Page Elements

To include a list of team members on a participant’s personal web page, create a Team List page
element. If the participant is not a member of a team, the list does not appear on your site.
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> Design Team List for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Team List” in the Display As field.

Note: You can include the Team List page element in a Fundraiser Page Elements part.

2. Inthe Display Name field, enter a name for the team list section on the page.

Tip: When you include a Team List page element on a Fundraiser personal page, there is no
customizable part for the participant to edit. However, you can recognize team members on your
site.

3. Inthe CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements such as colors, fonts and styles, and spacing for your
part. CSS is easier to use than other methods, such as HTML. Unless you specify a custom style
sheet, your website uses default style sheets. For more information about CSS, see the Website
Design Guide.

4. Click Save. You return to Parts.
Text Page Elements
To allow users to enter general content text on a personal page, create a Text page element.

2 Design Text for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Text" in the Display As field.
Note: You can include the Text page element in a Chapter, Fundraiser, or Personal Page Elements
part.

2. In the Display Name field, enter a name for the text section on the page.

3. Inthe CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements such as colors, fonts and styles, and spacing for your
part. CSS is easier to use than other methods, such as HTML. Unless you specify a custom style
sheet, your website uses default style sheets.

For more information about CSS, see the Website Design Guide.

4. Under Details, in the Maximum Length field, enter the maximum number of characters for
the customizable text.

5. In the Default box, enter any default text to include in the part, such as a welcome message.
The maximum number of characters count includes the text you enter in this field.

6. Click Save. You return to Parts.
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Thermometer Page Elements

To allow solicitors to include a thermometer graphic on a Fundraiser personal page, create a
Thermometer page element. The thermometer visually shows progress toward the solicitor's goal.

2 Design Thermometer for Page Elements

For information about page element parts, see Page Element Types on page 149.

1. From the Design tab, select “Thermometer” in the Display As field.

Note: You can include the Thermometer page element in a Fundraiser Page Elements part.
2. Inthe Display Name field, enter a name for the thermometer section on the page.

3. Inthe CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements such as colors, fonts and styles, and spacing for your
part. CSS is easier to use than other methods, such as HTML. Unless you specify a custom style
sheet, your website uses default style sheets. For more information about CSS, see the Website
Design Guide.

4. Under Details, in the Type field, select the style of thermometer to display.
5. In the Default Color field, select a default color for the thermometer.
Click Save. You return to Parts.

Page Sharing

To allow website users to easily notify others about content on a web page, add a Page Sharing part to
a layout or template. Using this part, website users can use content sharing services such as Digg or
delicious to send a link to a web page to others and help promote your website. On your website, the
website user selects the sharing service from the page sharing caption and enters information about
the sender and recipient and a personal message for the recipient.

Warning: To prevent website users from sharing content that recipients may not be able to view, we
recommend you not add the Page Sharing part to pages that require specific security or contain
dynamic content such as Directory part search results.

> Design Page Sharing

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Content sharing services, select each social networking method,
such as Digg, that website users can use to share content on the web page.
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Content sharing services
Select the content sharing services you want to include on the page.

[¥]Facebook
[¥]Diga
Cpelicious
Jvahoao!

COMewsvine

Page Sharing caption

Caption: #

Share By default, this caption is hidden. To change this, edit the
PageSharingLink class in the Stylesheet Editor. For
information, see Page Sharing Caption Styles.

2.

Under Page Sharing caption, enter a caption to appear with the links that website users click
to share the web page.

Note: By default, the page sharing caption is hidden. To display the caption, you must edit its classes
in Style sheets. For information about how to style the caption, see Page Sharing Caption Styles on

page 167.
3. Click Save. You return to Parts.

Page Sharing Caption Styles

By default, the page sharing caption is styled to be invisible on your website. To display a caption that
website users can expand to display the selected sharing services, you must edit its classes in Style
sheets. In Style sheets, you can also specify whether the services appear horizontally or vertically.

2 Adjust the style sheet to display the page sharing caption

1.
2.

From Site explorer, click Style sheets. Style sheets appears.

Select a style sheet and click Click here to edit this style sheet under Action. The Style sheet
text editor screen appears.

To load the Page Sharing CSS selectors that allow you to edit the appearance of the part on
your web pages, click Insert CSS selectors. The Insert CSS Selectors screen appears.

In the Insert selectors for field, select Page Sharing. To include the Page Sharing default style
settings along with the names, select Include defaults.
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5. Click Insert. You return to the style sheet editor, and the Page Sharing selectors appear in a
new section within the editor.

6. Enter the styles to display the caption users can expand and collapse.
a. Under .PageSharinglLink, enter display:block.
b. Under .PageSharinglLinklmage, enter display:block.
c. Under .PageSharinglist, enter display:none.

7. By default, when website users expand the list at the caption, sharing services appear
horizontally. To display the sharing services vertically:

a. Under .PageSharingListitem, enter float:none.
b. Under .PageSharingListitemLinkimage, enter float:none;display:inline.

8. To apply your changes, click Apply. The styles apply to all layouts, templates, and web pages
that use the style sheet.

9. To save your changes, click Save. You return to Style sheets.

Payment

With the Payment part, website users can pay for multiple transactions with a single charge. For
example, when a user registers for an event, makes a donation, or renews a membership, the program
adds the transactions to a payment page. If the user leaves the website without paying, the transactions
remain on the payment page. To clear unpaid payment pages that have not been modified within a
specified time period, you can set an expiration date.

Note: Anonymous website users can create payment pages. When an anonymous user adds a
transaction to a payment page, the page remains after the user leaves the website. To identify
anonymous users, the program uses cookies. To access a payment page, an anonymous user must use
the same computer used to add the transactions. If multiple anonymous users add transactions from
the same computer, the program adds the transactions to the same payment page.

You can use a payment page with the Donation Form, Event Registration Form, and Membership Form
parts. To create a payment page, you add a Payment part to a web page. You can then link the payment
page to each form part. For information about the Donation Form part, see Donation Form on page 46.
For information about the event registration form, see Event Registration Form (Classic) on page 104.
For information about the membership form, see Membership Form on page 128.

When you add a payment page to a donation form, event registration form, or membership form, the
user does not proceed directly to payment. Instead, the program adds items to the payment page.
When the user clicks Continue on the form, the payment page appears with the new item. The
Payment part determines the available payment methods and the merchant account. To provide a link
on your website for users to access payment pages without adding items, use the Payment Summary
part. For information about the Payment Summary part, see Payment Summary on page 171.

Note: To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or The Raiser's Edge, select Test Mode
on the Properties tab. For example, you can complete the fields on a Payment form to ensure the
confirmation page is styled and working properly. Although you submit the payment and receive a
confirmation, a transaction does not appear on the NetCommunity page in The Raiser's Edge. Use
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Test mode to verify the user’s experience, not to test data processing. Test mode does not validate

credit card numbers and merchant accounts. Only users with supervisor rights can view parts in Test
mode.

> Design Payment

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under General, set an expiration date for payment pages.

« To clear unpaid payment pages that website users have not modified, select Clear unpaid
transactions and enter the number of days to wait before you clear the pages.

« To keep all payment pages regardless of when last modified, select Never clear unpaid
transactions.

General
Select whether to automatically clear unpaid transactions after an expiration period.

@ Clear unpaid transactions days after the transaction group was last modified

(O Never dear unpaid transactions

when viewing the pending transactions, the payment form can be displayed immediately or after clicking 'Checkout'.
@ Display the payment form after clicking 'Checkout’

O Display the payment form immediately

Specify whether to send a summary acknowledgement email.

® Send the acknowledgement email defined for Donations, Event Registrations, Memberships or eCards that use this payment part
O send summary acknowledgement email

2. Select when to display the payment form for users to enter payment information.

+ To display the payment form on the payment page, select Display the payment form
immediately.

« To display the payment form on a separate page, select Display the payment form after
clicking ‘Checkout’.

3. You can determine if a donor receives a summary email to acknowledge one or more

payments made with this Payment part or individual acknowledgement emails for each
payment.

« To send a summary acknowledgement email for donations, event registrations, and

memberships a donor pays for with this Payment part, select Send summary
acknowledgement email.

Note: From a Donation, Event Registration, or Membership part, you can choose to always send the
acknowledgement email defined for the part. If you add a Payment part with Send summary
acknowledgement email selected to one of these parts, the donor receives the acknowledgement
email you designed for the donation, event registration, or membership payment, as well as the
summary acknowledgement email you defined for the Payment part.
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» To send donors an acknowledgement email for each payment, select Send the
acknowledgement email defined for Donations, Event Registrations, or Memberships

that use this payment part.
4. Under Required Fields, select the checkbox for each donor field to make required on the

payment page. To ensure you download complete constituent information, we recommend
that you make all these fields required.

Required fields

Specify whether the following fields are required.

[JFirst name
OTitle

OPhone

5. Under Additional fields, select the additional fields to include on the payment page.

a. Inthe Include column, select the checkbox for each additional field you want to appear on
the payment page. If you require a field, you must also include it.

b. Inthe Required column, select the checkbox for each additional field website users must

complete to submit their payments.

Tip: We recommend you include Middle name so your organization meets the Canadian Revenue
Agency's requirements for donation receipts.

6. Under Payment Methods, select the payment methods to offer to website users.

Payment methods

Select which payment methods the user will be allowed to choose from at checkout.

[¥] Credit card
[ Direct Debit
[JPledge (Bill me later)

Merchant account:*

‘ <please select= v Select which internet merchant account to use to process donation transactions.

Under Merchant Account, select the merchant account to use to process credit cards. For

example, select your IATS account. The system administrator sets up merchant accounts in
Administration. For information, see the Administration Guide.

8. Click Next. The Acknowledgement Email screen appears.
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Name: |test Acknowledgement |*
Subject: |test Acknowledgement |*
From Address: | |* From Name: |*

Hide Options

Reply Address: | |

Motifications are to be sent to the following address

Failures: |:||
B G FF -2 K B EGE=2 O E= |0 @
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Dear CFrstName >, =

y = b,
Thank you for your contribution of w/ to our organization. The advancements we have made can be attributed in many ways to people like

you who have genercusly supported our mission. We are grateful for your generosity and hope that you will take great pride in the important difference that your
contribution makes.

Below is @ summary of your contribution:

< Donation.Begin Section Gift Information: Donation Begin Loop

< Gift Amount

A s

Recurring Information.Begin Section >
e S FTEQUENCY
Path: p

9. Create an acknowledgement email for website users who make a payment with this Payment
part. You can use the default text provided or enter different text. For information about how
to design an email acknowledgement, see the Email Guide.

Note: You must select Send summary acknowledgement email under General for donors to receive
the summary email you create for the Payment part. For information about how to send both a
summary and individual acknowledgement emails, see the Email Guide.

The summary acknowledgement email includes loop merge fields for donations,
memberships, and event registrations. For information about how to use loop merge fields,
see Event Registration Loop Merge Fields on page 115.

Tip: When you edit a Payment part, you can click Acknowledgement Email to access the
Acknowledgement Email screen. For information about how to create this email message, see the
Email Guide.

10. Click Save. You return to Parts.

Payment Summary

With the Payment Summary part, website users can view useful information about their payment
pages. The payment summary can display the number of items on a payment page and the total cost
for the items. It can also provide a link to view the payment page and pay for transactions. When you
add a link and place the summary on a page template, a website user can access the payment page
from any web page that uses that template. You can also use merge fields to create two versions of the
summary: one for an empty payment page and one for a page with transactions.
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When you create a payment summary, you select a Payment part to connect to the summary. For
information about the Payment part, see Payment on page 168.

2 Design Payment Summary

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Payment part field, select the Payment part to connect to the
summary.

Payment part: ®
,<pleé_,~;e_'éeiect> E] Select a Payment part on which to base this summary.

Design the payment summary. You can use merge fields to include a link to the payment page and to display
important data such as the number of transactions and the total cost.

g Formatting Insert View
e # Cut Fontfamily = Fontsze + IS - 1=+ 3F 5 @
_j 53 Copy E===xx ?v
DTS P Sl T H

B 7 U & A~
Paste — L I

HImL Code

2. Under Display text, enter the text to appear in the payment summary. You can use merge
fields to display the number of transactions on a website user's payment page and the total
cost, as well as to provide a link to the page. You also can use merge fields to create
conditional statements that appear according to whether the payment page contains
transactions. To format the content’s appearance and layout, use the HTML editor.

For more information about the HTML editor, see the Program Basics Guide.

3. Click Save. You return to Parts.

Payment 2.0

With the Payment 2.0 part, website users can pay for multiple transactions with a single charge. For
example, when users register for events, make donations, or renew memberships, the program can add
the transactions to their shopping carts. If users leave the website without paying, the transactions
remain in the shopping carts.

Note: Website users who do not log in to your site can still add items to shopping carts. To identify
these anonymous users, the program uses cookies. To return to their shopping carts, users who did
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not log in must use the same computer as when they added transactions. If multiple users add
transactions from a computer without logging in, the program adds all the transactions to a single
shopping cart.

The Payment 2.0 part shopping cart can process transactions for the following parts. It cannot process
transactions from other sources.

« Donation Form

« eCards

« Event Registration Form (Classic)
o Membership

After you place the Payment 2.0 part on a web page and route transactions to the shopping cart for
other parts that integrate with Payment 2.0, the parts then send users to the shopping cart during
transactions and the Payment 2.0 part determines the merchant account and available payment
methods. After users add items to the shopping cart, they can click links to edit individual transactions.
When users pay with credit cards, the program collects user information on secure payment pages to
help you comply with the Payment Card Industry Data Security Standard (PCI DSS).

2 Design Payment 2.0

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under General, enter how long to maintain shopping carts for users who
add transactions but do not log in to your website.

General

Days to keep anonymous carts:
30 Enter how long to maintain the cookies that identify shopping
carts for anonymous users

Warning: If you enter "0" in the Days to keep anonymous carts field, the program does not
maintain cookies to identify users who are not logged in. If one of these anonymous user adds
items to a shopping cart and does not check out, the user cannot return to the cart later.
Depending on the browser, the cart is cleared either when the browsing session times out or when
the user closes the browser.

For registered users on your website, the Payment 2.0 part maintains shopping carts until they
process the items in their carts. However, the program can remove individual items such as
event registrations when the parts place time limits on how long the items can remain in
shopping carts.

2. Under Confirmation screen, design the payment summary that appears after user check out in
the shopping cart.
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Confirmation screen
Design the confirmation screen that appears after users check out.

[ Load Confirmation Template J

9o Formatting Insert View
'ﬁj] A Cut Font family =  Font size - = -i=-EEE @
| | =3 Co o e o
A B U@A-Y-E=E==x x, F-
Paste WL Cade .
Dear ° First Name >

§ < Summary Gift Amount

Thank you for your contribution o to our organization. The advancements we have made can

be attributed in many ways to people like you who have generously supported our mission. We are grateful for your

generosity and hope that you will take great pride in the important difference that your contribution makes.

Below is a summary of your contribution:

Total- <.2ummary Gift Amount

Date- Gift Date

Summary:
Receipt Grid

Combined Acknowledgements

On behalf of our entire organization, thank you again for your generous contribution.

In the HTML editor, enter content for the payment summary and format the appearance and
layout. To include personalized information, use merge fields. To remove the changes you
make to the default confirmation screen, click Load Confirmation Template.

For more information, see the Program Basics Guide.

3. Under Required Fields, select the checkbox for each field to make required on the payment
form. To ensure you download complete constituent information, we recommend that you
make all these fields required.

Required fields
Specify whether the following fields are required.

[ First name
OTitle

[JPhone

4. Under Additional fields, select the additional fields to include on the payment page.
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In the Include column, select the checkbox for each additional field you want to appear on
the payment page. If you require a field, you must also include it.

In the Required column, select the checkbox for each additional field website users must
complete to submit their payments.

Tip: We recommend you include Middle name so your organization meets the Canadian Revenue
Agency's requirements for donation receipts.

5.

To enable users to specify their consent preferences for how they want to receive
communication from your organization:

a.

Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:

Communication Consent Part v

Select how to display the consent options: @

Inline

® Overlay

Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to

embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

6. Under Payment methods, select the payment methods to offer to website users. You can

allow users to pay with credit card and direct debit, or to make pledges to pay later.

Warning: If you select Direct debit only, the Payment 2.0 part cannot process event registrations
because the Event Registration Form part does not accept direct debit payments. You must either
select an additional payment method or direct event registration transactions to a different
Payment 2.0 part.
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Payment methods
Select the payment methods to offer users when they check out.

Merchant account:
| <please select» v| Select the Internet merchant account to process credit card
transactions.

Credit card
CIprledge (Bill me later)

(I Direct debit

Note: To help you comply with the Payment Card Industry Data Security Standard (PCI DSS), the
Payment 2.0 part directs users who pay with credit cards to the secure payment page to process
payments. It does not direct users to this page when they make pledges or pay with direct debit.
For information about the secure payment page, see Secure Payment Page on page 178.

7. In the Merchant account field, select the merchant account to use to process credit card
transactions. For example, you can use your organization’s Blackbaud Merchant Services
account. The system administrator sets up merchant accounts in Administration. For more
information, see the Administration Guide.

Warning: If you create multiple Payment 2.0 parts for your website, you should use the same
merchant account for each part. If you use multiple merchant accounts and users purchase items
through more than one Payment 2.0 part, the program processes all items with the merchant
account for the last item. If you set up merchant accounts for different currencies, this means users
may pay for some items with the wrong currency.

8. Under Additional payment fields, select whether to include reCAPTCHA on the form. When
you select this option, a reCAPTCHA checkbox displays below credit card payment fields on
your Blackbaud Secure Payments form. Users must select the reCAPTCHA checkbox before
they can submit the form.

Additional payment fields
Select the additional payment fields to display on the form.

Field Include

reCAPTCHA @

9. Click Next. The Acknowledgement email section appears.
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Acknowledgement email

Design the acknowledgement email to send users after they check out.

Name of email: New Acknowledgement *
Subject: *
From address: * From name: *

Reply address:

Motifications are to be sent to the following address

Failures: []
7o Formatting Insert View
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Dear * First Name

Thank you for your contribution of ° Summary Gift Amount to our organization. The advancements we have made can
be attributed in many ways to people like you who have generously supported our mission. We are grateful for your
generosity and hope that you will take great pride in the important difference that your contribution makes.

Below is a summary of your contribution:

Total- * Summary Gift Amount
Date: Gift Date
Summany:

Receipt Gnd

"Combined Acknowledgements

Cn behalf of our entire organization, thank you again for your generous contribution.

10. Enter a name for the acknowledgement, a subject, and an address and name to include in the
From field of the email message.

11. To receive responses from recipients at a different email address than the one you use to send
the message, enter the return address in the Reply Address field.

12. Under Notifications are to be sent to the following addresses, select Failures to receive
failure messages for email messages that are not delivered. In the field beside the checkbox,
enter an email address to receive failure messages.

Note: Failures are email addresses that do not receive the acknowledgement email. Failures can
also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications
(DSN).

13. In the HTML editor, enter content for the acknowledgement email message and format the
appearance and layout. To include personalized information, use merge fields.

For more information, see the Program Basics Guide.
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Note: You design acknowledgement messages for each part that routes transactions to a shopping
cart. To include all these acknowledgements messages in the email message you design for the
Payment 2.0 part, use the Acknowledgement Block merge field. For example, you can add the
merge field to a Payment 2.0 part acknowledgement email message and then route transactions to
the part from Donation Form and Membership Form parts. After website users check out, they
receive a single Payment 2.0 acknowledgement email that includes acknowledgment messages
from the Donation Form, and Membership Form parts. You can also use this merge field on the
Payment 2.0 part’s confirmation screen.

14. Click Save. You return to Parts.

Secure Payment Page

To help you comply with the Payment Card Industry Data Security Standard (PCI DSS), the program
uses a secure payment page to process biographical billing information and payment information for
the Event Registration and Payment 2.0 parts. Users enter the information on a secure payment web
page that is hosted on a separate Blackbaud server from your website.

Note: Whether you host your site or Blackbaud hosts your site, the secure payment page on the
hosted Blackbaud server processes credit card payments only.

When a user submits a credit card payment on the Payment 2.0 part, the user navigates through a series
of pages. First, a user enters the amount and biographical information on your site. When the page is
complete, the user clicks Check out.

The program uses the style sheet, layout, template, and page for desktop browsers and mobile devices
to display the secure payment page on the Blackbaud server. On this page, the user enters billing and
payment information, such as credit card details.

Note: Your organization can use the Template 1.0 static page or Template 2.0 responsive page for
your secure payment page. However, if you are using the static page, we recommend you upgrade to
the responsive page to provide an optimal experience for website users on various devices. For
information about upgrading an individual static secure payment page to a responsive one, refer to
the Website Design Guide.

To complete the transaction, the user clicks Pay now. The secure payment page uses Blackbaud
Payment Service to transmit the users’s information and process the credit card transaction. For more
information about Blackbaud Payment Service, see the Payment Application Data Security Standards
Implementation Guide.

Warning: Your code tables in The Raiser's Edge for countries and their subdivisions, such as States
and provinces, must follow the International Organization for Standardization’s ISO 3166 standards.
The secure payment page uses ISO 3166-1 for countries and ISO 3166-2 for subdivisions such as
states. If your code tables do not match these standards, Blackbaud Secure Payment changes
selections to the closest abbreviation when it processes transactions, and this can lead to incorrect
address information. For example, if your countries table includes “United Kingdom,” The secure
payment page changes this to the United States abbreviation "US” because it is the closest
abbreviation to “Un.” In ISO 3166-1, the abbreviation for the United Kingdom is “GB,” and your code
table must match this. For information about how to edit your code tables in The Raiser's Edge for
countries and their subdivisions, see the Configuration and Security Guide.

The user returns to your site and your confirmation page appears.
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Secure Payment Page: Important Considerations

There are several important items to remember about the secure payment page for the Payment 2.0
part. The secure payment page uses your style sheets, layouts, templates, and pages for desktop
browsers and mobile devices to render the page. Make sure you consider this information to enhance
accessibility for both options.

When you use the same Payment 2.0 part on two web pages that use two different templates,
the secure payment page renders using the template for the page the website user navigates
from. For example, your payment page for an event registration uses a template with a red
background and your payment page for a donation uses a template with a blue background.
When a user navigates from the event registration payment page to the secure payment page,
the page renders using the red template. When a user navigates from the donation payment
page to the secure payment page, the page renders using the blue template.

Some parts, such as Formatted Texts & Image and Menu, appear on the secure payment page.
Images also appear. However, you may notice that some parts, including Unformatted Text, do
not appear on the page.

When you include targeted content on your page, be aware that it does not apply to the secure
payment page. No matter the role the user is in, the secure payment page renders the view for
an anonymous user the same way your page appears for anonymous users. Anonymous users are
users not logged in to your website.

We recommend you remove parts that contain a Flash file. These files include JavaScript that the
secure payment page removes for PCI DSS compliance. If you do not remove the part, an Adobe
download message likely appears in its place on the secure payment page.

Likewise, we recommend you remove graphics that include JavaScript. The secure payment page
removes these graphics for PCl DSS compliance. If you do not remove the graphic, the page
likely renders incorrectly.

We recommend you remove third-party social media sharing widgets from your page. These
links typically include JavaScript that the secure payment page removes for PCI DSS compliance.

External style sheets including those you import in Stylesheets do not appear. Only styles from
the default style sheet or inline on a part appear.

To enhance performance between your site and Blackbaud's server, the program holds design
and property updates you make to the style sheet, layout, template, and page for your payment
page in a queue. When this content remains static for five minutes, the updates push to the
Blackbaud server within one hour. You cannot change this process. However, you can click
Update templates in Sites & settings to manually update the changes for your secure payment
page. For more information, refer to the Administration Guide.

A generic template exists for the secure payment page. It is unlikely you want to use it because it
does not match the rest of your website. However, Flash and JavaScript content does not upload
to the secure payment page for PCI DSS compliance. If your page, template, or layout includes
this content and the absence of it heavily impacts the appearance of your secure payment page,
you may want to use the generic template. You can also use the generic template if you need to
temporarily revert your template updates to the page. When you are ready to use your template
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again, you select Enable secure payment template updates and click Update templates in
Sites & settings. For more information, refer to the Administration Guide.

Note: The program does not send updates to the Blackbaud secure payment server for Payment 2.0
and Event Registration pages that do not accept credit cards.

Secure Payment Page: Transaction Processing Safeguards

When users navigate from an Event Registration Form or Payment 2.0 web page to the secure payment
page and an interruption unexpectedly occurs before the transaction is submitted, your payment
processor receives the payment and the information from the Payment 2.0 web page creates a
transaction to process in The Raiser's Edge.

Note: An interruption can occur when your website server refreshes while a user attempts to submit a
transaction. An interruption can also occur when a user leaves your secure payment page for a time
that exceeds the session login and then returns to the page and submits the transaction.

To support this feature, database processes check the secure payment page for unprocessed data
every 24 hours.

« For Payment 2.0, the payment page can still include information after The Raiser's Edge transmits
data to the database if users complete payment fields on the secure payment page but do not
submit their transactions. Your system administrator can access the page to provide you with a
list of these users so you can follow up with them.

The remaining data is stored for 30 days unless your system administrator changes the
UnprocessedBBSPTransactionLifeSpaninDays web.config setting to increase or decrease the
number of days. For example, to increase the number of days to 60, enter
<UnprocessedBBSPTransactionLifeSpaninDays = 60> in the <appSettings> node of web.config.

Your system administrator can also use the ArchiveUnprocessedBBSPTransactions web.config
setting to specify whether the process should move the remaining data from the table to the
CMS_UnprocessedBBSPTransaction archive table in the database, or delete it permanently. For
example, to move Payment 2.0 data to the archive table, enter
ArchiveUnprocessedBBSPTransactions=True in the <appSetting> node of web.config. Otherwise,
enter False.

« For the Event Registration Form, the process checks for unprocessed data between 12-01-2014
and the current date. Your system administrator can change the Event2_MaxGiftDate web.config
setting to specify a different beginning date. The value for the date must be in UTC format. For
example, to change the date to 12-15-2014, enter < add key="Event2_MaxGiftDate"
value="2014-12-15" />.

Payment Summary 2.0

Payment Summary 2.0 part works with Payment 2.0 parts to provide website users a summary view of
their payments. The payment summary can display the number of items on a payment page and the
total cost for the items. It can also provide a link to view the payment page and pay for transactions.
You can also include a summary grid that lists the items added to the cart and provides a brief
description of each. When you add a link and place the summary on a page template, a website user
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can access the payment page from any web page that uses that template. You can also use merge
fields to create two versions of the summary: one for an empty payment page and one for a page with
transactions.

When you create a payment summary, you select a Payment 2.0 part to connect to the summary. For
information about the Payment 2.0 part, see Payment 2.0 on page 172.

2 Design Payment Summary 2.0

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Payment 2.0 part field, select the Payment 2.0 part to connect to
the summary.

General options

E’_E_lym ent___?___._c_l__part:* _
jF’ayment 20 E Select a Payment 2.0 part on which to base this summary.

To include a summary grid that lists the items in the shopping
Include shopping cart summary grid cart, select this option. The grid appears below the payment
summary content.

Payment summary content
Design the payment summary. You can use merge fields to display important data such as the number of
transactions and the total cost.
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d?] & Cut Fontfamily - Fontsize = i=+ i=-iE = @
= 53 Copy

B 7 U 2 A~37-~ x X, W
Paste T Cods = —-— :

g o coa Cart Summary Fields.Iterm count

Cart Summary Fields.Total cost = Cart Summary Fields.Begin content for no pending transactions
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He Pending Tr B Cart Summary Fields.End content for no pending transactions

Cart Summary Fields.Begin content for pending transactions
Pending: . Cart summary Fields.End content for pending transactions

Pay now

2. To include a summary grid that lists the items in the shopping cart, select Include shopping
cart summary grid. The grid appears below the payment summary content.

3. Under Payment summary content, enter the text to appear in the payment summary. You can
use merge fields to display the number of transactions on a website user's payment page and
the total cost, as well as to provide a link to the page. You also can use merge fields to create
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conditional statements that appear according to whether the payment page contains
transactions. To format the content’s appearance and layout, use the HTML editor.

For more information about the HTML editor, see the Program Basics Guide.
4. Click Save. You return to Parts.

Personal Notes

To display content from the Notes tab of a constituent record on your site, create a Personal Notes
part. You can select the note types to appear on the website or select a group of note types to appear.
With this part, a site user can search notes for himself or for other constituents. In addition, a user can
manage his personal notes. Managing notes includes the ability for a user to add, edit, or delete a
personal note on his record. A user cannot make changes to a note for another constituent.

The Personal Notes part can create two pages on your website. The first page is a display page for
notes. This page contains an area to search for notes. The second page, if created, is the manage page,
where users can make changes to personal notes.

If a user changes a personal note, the data downloads to the Notes tab as a profile update transaction.
For more information about how to download note information, see the Blackbaud NetCommunity &
The Raiser’s Edge Integration Guide.

2 Design Personal Notes

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Topics to Include, select the checkbox beside the note topic to
include on your web page.

The Notepad Type table in The Raiser’'s Edge determines the available note topics. To add or
edit a note topic, do this in The Raiser's Edge.

a. Inthe Display As column, enter the information to appear for the note topic on the web
page.
b. To allow users to create more than one note topic, select Multiple Submissions Allowed.

If you do not select this checkbox and the user has multiple note topics of the same type
existing on a constituent record, all notes can appear in note search results.

2. Inthe Display Notes field, to create a web page to search for note information, select
Available. To select this page as the default page for personal notes on your website, select
Default.

3. Under Heading, in the Title field, enter a name for the web page. Remember that this creates
the display page for notes.

a. When both Display Notes and Manage are marked Available on the Edit Part screen, the
Tab caption field appears. In this field, enter the text to appear at the top of the page. Leave
the default text, or write your own text. When the user is on the Manage page, this text
becomes a link. The user clicks the link to access the Display page.
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b. In the Instructions field, enter content to instruct the user on how to search for a note. Leave
the default instructions, or write your own instructions.

4. Under Search Options, select the note search features.

a. To filter a note topic search, select a query in the Limit to query field. To choose an existing
constituent query from The Raiser’s Edge, click Change.

b. In the Split search fields into [ ] columns field, select the number of search field columns to
appear in the criteria table. You can display up to five columns.

c. To process a search while the user browses the web page, select Load unfiltered results
when this part is loaded. When you select this checkbox, the search processes before the
user enters criteria and clicks Search on your website.

d. Select the fields the user can use to search notes, such as First Name or Last name. To select
a field, right-click and drag it from the Profile Fields box to the Search Form Fields box. To
move a field from the Profile Fields box to the Search Form Fields box, you can also select
it and click the right arrow.

Tip: To display only a list of notes on your web page and not note search fields, select Load
unfiltered results when this part is loaded and do not include fields in the Search Form Fields box.

The system administrator selects the attributes available on the Settings tab in Sites &
settings. On the website, multiple-value attribute fields, such as Organization type, become
drop-down boxes with the various attributes available as selections. For more information,
see the Administration Guide.

To arrange the placement of a field in the Search Form Fields box, select the field and click
the Up or Down button.

5. Under Listing Options, in the No records found message field, enter the message to appear
if no records meet the search criteria the user enters in a note search. By default, “No notes
match your criteria” appears.

a. Inthe Show navigation options field, select where to display the navigation buttons when
the search finds results. You can select "Above the results,” “Below the results,” or “Both
above and below the results.”

b. In the Results per page field, select the maximum number of results to appear on a page
when a site user searches notes. You can display up to 50 results per page.

Search results sort by the date the note was last changed in The Raiser’s Edge. To view this
date, select File, Properties on the notepad for the screen. Notes with the same modify date
sort by name. Notes with the same modify date and name sort by note topic.

Warning: Note text formatting in The Raiser's Edge does not convert to the Personal Notes part on
your web page.

c. To allow users to update their personal notes, select Allow users to edit/update their own
notes in search results.

6. In Manage field, to create a second page for the Personal Notes part so users can manage
notes, select Available. To select this page as the default page for personal notes on your
website, select Default.

Note: To manage notes, users must first log into your website. Changes the user makes do not appear
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on the website until they are approved on the NetCommunity page in The Raiser's Edge. If a new user
registers for your site, the user cannot manage notes until the sign-up transaction is processed. For
more information, see Blackbaud NetCommunity & The Raiser’s Edge Integration Guide.

7. Under Heading, in the Title field, enter a name for the second personal notes web page.
Remember that this creates the manage page for notes.

a. When both Display Notes and Manage are marked Available on the Edit Part screen, the
Tab caption field appears. In this field, enter the text to appear at the top of the page. Leave
the default text, or write your own text. When the user is on the Display page, this text
becomes a link. The user clicks the link to access the Manage page.

b. In the Instructions field, enter content to instruct the user how to manage the personal
notes. Leave the default instructions, or write your own instructions.

8. Under Listing Options, in the No records found message field, enter the message to appear
if no records meet the search criteria the user enters to search notes on the web page. By
default, the message “"You have no notes at this time” appears.

9. Click Save. You return to Parts.

Poll

Use the Poll part to create a simple poll or survey. A poll may ask a trivia question or who users predict
to win a race. After a website user submits an answer, the program calculates the poll results and
displays them on the site.

With the Poll part, you can enter your poll or survey question, the text to display on the submit button,
whether to use a pie chart or bar chart to display the results, and, if required, the possible answers for
the poll or question. To prevent skewed polling results, these fields are disabled after a website user
responds to a poll.

> Design Polls

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter a title for the poll.
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General

Title: Question: *®

Pall

Submit button text: = Chart type:

Submit Pie Chart v

Chart image width (px):
If a width is not specified, the chart image will be set
automatically.

Poll answers
At least two answers are required in order to use this part.

Answer: | | Add

2. Inthe Question Field, enter the question for the poll.

In the Submit button text field, enter the text to appear on the button users click to submit
their answer.

4. Inthe Chart type field, select "Pie Chart or "Bar Chart.”

5. Poll responses are limited to 255 characters. If you expect long poll answers, we recommend
you enter a pixel (px) size in the Chart image width field. If you enter an image width less
than a poll response, the response is truncated in the image. To correct this, adjust the pixel
size in the Chart image width field.

6. Under Poll answers, for each answer for the poll response, enter the answer in the Answer
field and click Add. The box displays the answers entered for the poll response.

7. Arrange the order of the answers as they should appear on your website.
 To adjust the position of an answer in the order, select it and click Move up or Move down.
« To remove an answer from the box, select it and click Remove.

8. Click Save. You return to Parts.

Profile Display

Use the Profile Display part to display a read-only profile page for website users to view profile details
about an individual or organization. You select the fields to include in the profile display. For example,
for an individual, you can display biographical, address, and contact information about the user. You
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can also create separate Profile Display parts for individual constituents, organization constituents, and
user networking groups.

Note: The Profile Display part displays profile information the user enters on a Profile Form part. For
information about how to create an editable profile form, seeProfile Form on page 188.

You can use the Profile Display part to display information for only the logged-in user or to link to a
directory so it displays information for any person or organization selected in the directory. For more
information about directories, see Directory on page 34.

Warning: You cannot use HTML to embed your own form via HTML in a Profile Display part.

> Design Profile Display

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Source field, select the profile type to appear when the website
user clicks the link.

Source:*
Current user Select the profile type to appear for a website user. "Current user” displays the profile
g for the logged-in user. "Directory” displays on a page that links from a directory.

Max height/width for full-size image:
px When you select to include the Profile image merge field in the HTML editor, enter the
maximum display height and width for profile images when users click thumbnails on the
web page.

Max height/width for thumbnails:
px When you select to include the Profile image merge field in the HTML editor, enter the
maximum thumbnail height and width for profile images on the web page.

« "Current User” — Select this to display the profile for the logged-in user.

« "Directory” — Select this if this profile part is added to a page linked to a directory. When a
profile is linked to a directory, users can click a field in the directory to display the profile for
the selected person. For more information about directories, see Directory on page 34.

2. In the Max height/width for full-size image field, enter the maximum display height and
width for full-size profile images that display when users click thumbnails on the web page.

3. Inthe Max height/width for thumbnails field, enter the maximum height and width for
profile image thumbnails on the web page.

Tip: When you leave the Max height/width for full-size image and the Max height/width for
thumbnails fields blank, the default size to display full-size and thumbnail profile images on a web
page is 200 px. To include profile images on the part, make sure you include the Profile image
merge field in the HTML editor design box.

4. On the HTML editor, select whether to create profile display content for an individual or
organization constituent or for a user networking group.
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« To design content to appear for an individual constituent, select the Individuals tab.
« To design content to appear for an organization constituent, select the Organizations tab.

« To design content to appear for a group on your user networking site, select the Blackbaud
NetCommunity group tab.

5. To enter and format the profile content’s appearance and layout, use the HTML editor. For
more information about the HTML editor, see the Program Basics Guide.

« When you design content to appear for an individual or organization constituent, you can add
merge fields for personalized information to appear.

« When you design content to appear for a user networking group, you can add merge fields
for personalized information from the User Networking Manager part to appear.

Note: On your website, email address merge fields on a Profile Display part appear as links users can
click to send an email message to the address.

6. Click Save. You return to Parts.
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Profile Form

With the Profile Form part, you can create profile forms for constituents and organizations to update
their biographical, address, and contact information. For example, Jane Compton is a member of the
Class of 1988. When she visits your website, she navigates to the user profile page and enters the
information you selected to appear on the individual Profile Form part, such as her full name, current
address, and spouse information. You can download the information she enters on your website to The
Raiser's Edge.

You select the fields of information to appear in each section of the form. The user can select whether
profile information is public (all users can view it) or private (only the user can view it). We recommend
you use the profile form on password-protected pages only.

Note: When users update their profiles, the changes appear in profile displays or directory listings
automatically, even before the changes are downloaded.

If a user is a relationship type with appropriate rights, he or she can edit profile information for an
organization. For example, you can specify that only constituents with a relationship type of
"Administrator” or "Primary Contact” can edit their organization'’s profile.

Note: To edit an organization’s profile, in addition to the relationship type set on the Settings tab in
Sites & settings, the website user must be established as a contact for the organization in The Raiser's
Edge.

> Design Profile Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Select the type of constituents to use the Profile Form, select
either Individual or Organization.
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2. Under Profile form options, in the After update navigate to field, browse to the web page
to appear after website users submit their profile information.

If you do not select a page, the profile form appears after users submit profile information.

3. If you select Organization, the Message to display when there are no organization records
box appears. In the box, enter the message to appear when website users who navigate to a
page with the profile form part do not have an organization record or are not a relationship
type with Edit Org Profile marked on the Settings tab in Sites & settings. For example, enter
“There are no organizations associated with your record.” For more information, see the
Administration Guide.

4. Add each section to the profile form as required.

a. Inthe Section field, select the type of section to add to the form. Fields appear in the grid
for the section type you selected.

The system administrator selects the attributes available on the Settings tab on the Settings
tab in Sites & settings. For more information, see the Administration Guide.

b. Inthe Heading field, enter the text to appear at the top of the section. For example, for the
Bio section of an individual profile, enter “Personal Information.”



190 CHAPTER 1

To specify the order of sections, add a number to the beginning of each section heading. For
example, if you select "Preferred Address” in the Section field and enter “2. Preferred
Address” in the Heading field, the Preferred Address section appears second in the profile.

c. Inthe Fields grid, select the fields to include in the section and options for the fields.

Note: To protect user passwords, users cannot change their user IDs, passwords, or email addresses
on profile forms unless they confirm their passwords first. When users attempt to change the
Preferred Email field in the Phones and Email section or the User ID and Password fields in the User
Login section, a field requests their current password. Users must enter their passwords so that other
users cannot change their credentials or receive email messages with their unencrypted passwords.

Option Function

Include Select the checkbox next to each field to include in the profile display grid.

Field This column displays the fields from The Raiser's Edge you can include in the section.

Edit To allow the user to edit a field, select this checkbox. If you do not select this
checkbox, the field appears in the profile but the user cannot change its value.

Required To make a field required, select this checkbox. If you select this checkbox, the user
must select or enter a value for the field to complete the form.

Privacy edit To allow users to hide the content of a field, select this checkbox. For example, to

Use code table

Edit codes

Alternate caption

allow users to hide their birth dates on the profile display, select this checkbox for the
Birth date field. On the profile display, “{private}” appears when users hide the field.
For organizations, this column is disabled.

Note: By default, the Profile Form part uses privacy settings from Field Options to
determine whether to display content on the form display. After you process users
and they visit the profile display, the program locks in these default privacy settings,
and future changes in Field Options do not affect privacy settings for the users.
However, users can still change the settings for the fields where you select Privacy
edit.

If a field has code table values, this checkbox appears. If you select this checkbox, the
field on the form displays the code table values from The Raiser's Edge. If you do not
select this checkbox, the user must enter a value in the field.

If a field has code table values, this checkbox appears. To enable the user to enter a
value other than a code table value, select this checkbox. On the form, an Other field
appears next to the field so users can enter a value other than those provided.

To edit a field name, enter a new name in this column. For example, you can call the
Birth date field the Birth date (mm/dd/yyyy) field.

5. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part v

Select how to display the consent options: @

Inline

& Overlay

a. Under Consent, in Consent part, select a saved Communication Consent part to include on
the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

When the Communication Consent part is included on the Profile form, note the following:
Consent options do not display for organizations, the profile update transaction does not
include any Request No Email attribute information, and the Request No Email checkbox is
not displayed on the form, whether or not the Request No Email attribute is included on the
form via the Bio fields.

If the Communication Consent part is not included on the Profile form, then the Request No
Email checkbox will display on the Profile form provided that the Request No Email attribute
is included on the Profile form via the Bio fields.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

6. Click Save. You return to Parts.

Quick Search

To use the Quick Search part, you must have Microsoft Full-Text Search on your web server. If you do
not, the part does not appear in Parts. This part can search other parts: Formatted Text and Images,
Formatted Text and Images (Secured), Discussion Group, Event Calendar, Job Board, and Weblogs.

Note: You can select to install Full-Text Search when you install SQL Server. For general information
about Full-Text Search, see your SQL Server documentation.
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Learn About Quick Search

The Quick Search part is a text box with a search button that appears on the web page for site users to
search for information. Due to its small size, it is useful to include on a web page template to add
search functionality on pages throughout your site. The search text box has a limit of 255 characters.

Because the part does not have room to display search results, you must select a web page for the
results to appear on. The web page must contain a Search part. This part is large enough to display
search results similar to Google. The first line is a hyperlink to the web page. The next several lines
provide a preview of the text that contains the word or phrase a user searched on. Words or phrases
used in the search appear in bold.

Note: The primary difference between the Quick Search and Search parts is how results appear on
your site. With the Quick Search part, you select a web page for results to appear on. With a Search
part, results appear automatically below the Search part. You can add a Quick Search part to a web
page template; however, we recommend you not add Search parts to a template.

The parts available for a quick search are indexed by part. For example, a Formatted Text and Images
part contains “boy.” On the same page, a Discussion Group part contains “scout.” If a user enters “boy
scout” in the search field, results do not appear because the same part does not contain both words.

Warning: When the Quick Search part performs a search, it includes all pages on your website that
contain a searchable part. Therefore, the potential exists for search results to return unfinished web
pages. To prevent this, establish security to restrict the users who can view unfinished pages.

Note: When a user searches for a word or term on your website, search results include pages only.
Searches do not include templates or the parts on templates.

The Quick Search part uses “stem” search. When a user enter a word in the search field, the search
results include the word plus its plurals and verb tenses. For example, if a user searches for “run,” the
search results return parts that contain the words “run,” “ran,” and “running.” The search also accepts
certain operators and wildcards in the search text box. You can use the asterisk, quotation marks, and
the minus sign in the Quick Search part.

Operator Function

Asterisk (*) Begins with (For example, enter “"donat*" to return
results such as donate, donating, donation.)

Quotation marks (“ ") Whole phrases (For example, “Become a Member Now”
returns results that contain the entire phrase.)

Minus (-) All words in search box minus preceding word or words
(For example, “event registration -form” searches for
"event” and "registration,” but excludes results that
contain “form.”)

When a site visitor performs a search with the Quick Search part, security is upheld. For example, a web
page contains the Formatted Text and Images part with the phrase “Board Member Personal
Addresses.” Only users in the Board Member role with the applicable task rights can access this page.
When other users search for “board member + addresses,” the page is not returned.
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For information about security, see the Users & Security Guide.

2 Design Quick Search

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Results page browse to the web page to display search results.

2. Inthe Search button caption field, enter the text to appear on your search button, such as
”GO."

If you do not enter text for the button in the field, the button does not appear on your site. To
process search results, site users press ENTER on the keyboard after they enter search
information in the text field.

3. Click Save. You return to Parts.

Search

To use a Search part, you must have Microsoft Full-Text Search on your web server. If you do not, the
part does not appear in Parts. This part can search other parts: Formatted Text and Images, Formatted
Text and Images (Secured), Discussion Group, Event Calendar Job Board, and Weblogs.

Note: You can select to install Full-Text Search when you install SQL Server. For general information
about Full-Text Search, see your SQL Server documentation.

Learn About Search

When you add a Search part to your web page, a field name, text box, and search button appear on the
page for site users to search for information on your website. Results appear below the Search part
similar to Google. The first line is a hyperlink to the web page. The next several lines provide a preview
of the text that contains the word or phrase a user searched on. Words or phrases used in the search
appear in bold.

Note: The primary difference between the Quick Search and Search parts is how results appear on
your site. With the Quick Search part, you select a web page for results to appear on. With the Search
part, results appear automatically below your Search part. You can add a Quick Search part to a web
page template; however, we recommend you not add a Search part to a template.

The parts available for a search are indexed by part. For example, a Formatted Text and Images part
contains “boy.” On the same page, a Discussion Group part contains “scout.” If a user enters "boy
scout” in the search field, results do not appear because the same part does not contain both the
words.

Warning: When the Search part performs a search, it includes all pages on your website that contain
a searchable part. Therefore, the potential exists for search results to return unfinished web pages. To
prevent this, establish security to restrict the users who can view unfinished pages.
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Note: When a user searches for a word or term on your website, search results include pages only.
Searches do not include templates or the parts on templates.

The Search functionality uses “stem” search. When a user enters a word in the search field, the search
results include the word plus its plurals and verb tenses. For example, if a user searches for “run,” the
search results return parts that contain the words “run,” “ran,” and “running.” The search also accepts
certain operators and wildcards in the search text box, such as asterisks, quotation marks, and minus
signs.

Operator Function

Asterisk (*) Begins with (For example, enter "donat*” to return
results such as "donate,” "donating,” "donation.”)

Quotation marks (“ ") Whole phrases (For example, “Become a Member Now”

returns results that contain the entire phrase.)

Minus (-) All words in search box, minus preceding word or words
(For example, “event registration -form” searches for
"event” and "registration,” but excludes results that
contain “form.”)

Warning: When you search for a phrase and do not use quotation marks, you may not receive any
results. For example, "Become a Member Now" returns results, while Become a Member Now does
not. This issue is due to a SQL Server setting that specifies how SQL handles searches that contain
"noise” words. For more information, see this article: http://msdn.microsoft.com/en-
us/library/ms187914.aspx.

To fix the issue, run this SQL:

sp _configure 'show advanced options', 1

RECONFIGURE

GO

sp_configure 'transform noise words', 1

RECONFIGURE

GO

When a site visitor performs a search through the Search part, security is upheld. For example, a web
page contains the Formatted Text and Images part with the phrase “Board Member Personal
Addresses.” Only users in the Board Member role with the applicable task rights can access this page.
When other users search for “board member + addresses,” the page is not returned.

For information about security, see the Users & Security Guide.

2 Design Search

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Search properties, in the Title field, enter a name for your Search
part. This title appears on your site.


http://msdn.microsoft.com/en-us/library/ms187914.aspx
http://msdn.microsoft.com/en-us/library/ms187914.aspx
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Search properties
With the Search part, you can search other parts on your website including the Discussion Group, Event
Calendar, Formatted Text and Images, Formatted Text and Images (Secured), Job Board, and Weblog parts.

Title:
Enter a title. If you can leave the field blank, no title appears on
the page.

Description:
Enter a description. When you leave the field blank, no
description appears on the page.

Search button text:
Search Enter the text to appear on the search button. When you leave
the field blank, the button text defaults to "Search”.

2. Inthe Description field, enter additional text to appear for users to read, such as “Search Job
Postings.”

3. Inthe Search button caption field, enter the text to appear on your search button, such as
IIGO.II

If you do not enter text for the button in the field, the button does not appear on your site. To
process search results, site users press ENTER on the keyboard after they enter search
information in the text field.

4. When you host multiple websites, Select the sites to search appears. Use these options to
choose the sites to search with this part.

Tip: For more information about multiple websites, see the Administration Guide.
 To return results from all of your sites, select All sites.

Select the sites to search
You can select the sites to search with this part. Only pages from the site specified display in search results.

@ Al sites This option returns search results from all sites.

O current site

O Specify sites

« To only return results for the site the user is on, select Current site.
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Select the sites to search
You can select the sites to search with this part. Only pages from the site specified display in search results.

O &l sites To only return results for the site the user is on, select Current site.

® Current site

&) Specify sites

« To select sites to search, select Specify sites. A list of your sites appears for you to include the
sites to search.

Select the sites to search
You can select the sites to search with this part. Only pages from the site specified display in search results.

O Al sites From the list below, select the sites to include in the search.
@ current site 4 Sites

: . Site 14

@ Specify sites

= Site 2

5. Click Save. You return to Parts.

Slideshow

To include a slideshow presentation of graphics on your website, you can create a Slideshow part. The
slideshow can present graphics in a specified or random order. You can add navigation buttons so
website users can start and stop the slideshow and move forward and backward between pictures. If
the image has an assigned caption, it appears below the image and above the navigation buttons.

2 Design Slideshow
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.
1. From the Design tab, under Slideshow options, to display images in the slideshow in random
order, select Random display order.
2. Toinclude buttons below the slideshow, select Show navigation buttons. This table includes
the navigation buttons available for the Slideshow part.

This table includes the navigation buttons available for the Slideshow part.

Button Function

lEI Play
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Button Function

Pause
Forward
Back
Stop

To display captions with the images in the slideshow, select Show image caption.

~w [ & & =

To enter the maximum dimensions for an image in your slideshow, select Fixed width and
height for all images and enter the number of pixels in the Number of pixels field. This
setting defines the height and width of the boundary that contains the image but does not
directly alter the size of the images.

An image's number of pixels cannot exceed the number you enter in this field. For example, if
you have an image that is 200 pixels and set this boundary to 500 pixels, the image cannot
increase to 500 pixels. Conversely, if you have an image that is 500 pixels and set the
height/width size to 200, the image shrinks to fit that boundary.

Note: There is no limit to the number of photos you can include in a slideshow.

5. Inthe Slide display interval (seconds) field, enter the number of seconds to display an image
before the next image in the slideshow appears. The default amount is five seconds.

6. Under Add images, click Add image. The Select Image From Image Library screen appears.
For information about how to insert an image, see the Program Basics Guide.

7. To change the order or remove images in the slideshow, click the up and down arrows or the
red “x" buttons.

8. Click Save. You return to Parts.

Suggested Content

With the Suggested Content part, you can create recommendations for website users to visit other
areas of your website. For example, you can use the part to direct users to articles or donation forms
that are related to the content on the pages they visit. The part displays short summaries about
suggested content and links to the pages with the content.

The Suggested Content part uses tags and user interests to determine the content that it recommends.
When you create parts for your website, you associate tags and users interests with them and select
whether to make the parts eligible for Suggested Content parts. Then when you create a Suggested
Content part, you select the tags and users interests to use to generate recommendations.

Note: For the Suggested Content part to be effective, you must associate tags and user interests with
the parts on your website. If you do not maintain these tags and user interests, the Suggested Content
part cannot recommend the most relevant content or keep recommendations up to date. To
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page 23.

When a user visits a page that includes a Suggested Content part, it recommends other parts that most
closely match its tags and user interests. As you update the content on your website, the part
automatically updates its recommendations to reflect the changes. For example, when you add new
parts or edit the tags and interests associated with existing parts, the Suggested Content part updates
its suggestions to take these changes into account.

To determine the content to recommend, the Suggested Content part assigns point values to the tags
and user interests that it includes. It then assigns point values to all parts on the website that are
eligible for the Suggested Content part. When the Suggested Content part creates its
recommendations, it selects randomly from all eligible parts but emphasizes the parts with the most
points. This allows the part to avoid recommending the same content repeatedly and still focus on the
most relevant content. After the part selects the parts to recommend, it organizes the items to display
the most recently edited or created first.

To assign point values, the Suggested Content part performs several calculations.

» For tags associated with the Suggested Content part, the part assigns points based on user history.
When website users visit your website, the program tracks the content they view. For each part that
a website user views, the Suggested Content part assigns points to the tags associated with that
part. The number of points depends on how often and how recently the user viewed the part. For
each view, tags receive five points, but this decreases to one point during the course of seven days.

« For user interests associated with the Suggested Content part, the part assigns 20 points for each
match to a user interest in a website user’s profile.

« For parts that are eligible for the Suggested Content part, the part adds the points from all the tags
and user interests associated with the parts and then subtracts points for each time a user viewed
the parts. The number of points it subtracts depends on how recently the user viewed the part. For
a recent view, the part subtracts 25 points, but this decreases to 5 points during the course of
seven days.

2 Design Suggested Content

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Layout options, in the Number of items to display field, select
how many suggestions to display. You can recommend up to 30 items.

2. In the Orientation field, select whether to display suggestions in a horizontal or vertical list.
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Layout options
Number of items to display:

| 1 [ The part displays up to 30 recommendations to other parts on
vour website. It includes a link and summary for each suggested
item.
Orientation:
(& Horizontal Select how to display suggestions. You can place them side by
O vertical side or one on top of the other.

3. Under Tags to include, select the tags and interests to include in the suggested content. By
default, the part includes all eligible tags and interests.

Tags to include
Select the tags that designate suggested content. The part searches for these tags on other parts. It displays
summaries of the closest matches along with links to the web pages with the content.

Include: Exclude: Include all Remove all
Advocacy X || Arts X || Athletics EMESRE . EEREeE) Eupr) SRR
Basketball ¥ || Biking X | | Botanical X

Cards X | | Community X

Contemporary art ¥ | | Cooking X || Cricket X
Design ¥ | | Donate ¥ || Education X

Events ¥ | | Fishing ¥ | | Football

Gardening X || Get Involved ¥ || Giving X

« To remove atag or interest, click Remove tag for it in the Include box. To remove all tags
and interests, click Remove all. The tags and interests you remove appear under Exclude.

« To add a tag or interest back to the part, click it under Exclude. To return all tags and interests,
click Include all.

Note: Tags are keywords or phrases that describe the content on parts and allow you to link to similar
content. User interests are attributes associated with constituent records. For the Suggested Content
part to be effective, you must associate tags and user interests with parts throughout your website. If
you do not maintain these tags and user interests, the part cannot recommend the most relevant
content or keep its suggestions up to date. For information about how to associate tags and user
interests with parts, see Tags Tab on page 23. For information about how to capture user interests for
website users, see User Interests Form on page 229.

4. Click Save. You return to Parts.
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Survey

With the Survey part, you can create surveys to learn more about your website users. After users submit
responses, you can view a summary of responses, view response details, clear responses, and refresh
the survey results on the bottom of the Design tab.

If website users are logged in to your website, you can download their survey responses to records in
The Raiser’s Edge. You cannot view survey responses on records, but you can create queries in The
Raiser’s Edge to view or report on survey responses.

For more information about how to download survey transactions, see the Blackbaud NetCommunity &
The Raiser's Edge Integration Guide.

You can add several types of survey questions in multiple formats.

Choice - One Answer (Vertical) — Select this to ask a question that allows respondents to select an
answer from a vertical list. To allow respondents to enter an answer that is not provided, you can add
an Other selection.

Choice - One Answer (Horizontal) — Select this to ask a question that allows respondents to select an
answer from a horizontal list.

Choice - One Answer (Dropdown) — Select this to ask a question that allows respondents to select
one answer from a drop-down list. To allow respondents to enter an answer that is not provided, you
can add an Other selection.

Choice - Multiple Answers (Vertical) — Select this to ask a question that allows respondents to select
multiple answers from the vertical list. To allow respondents to enter an answer that is not provided,
you can add an Other selection.

Choice - Multiple Answers (Horizontal) — Select this to ask a question that allows respondents to
select multiple answers from a horizontal list.

Matrix - One Answer Per Row — Select this to ask a question and arrange possible answers in
columns. The respondent can select one answer per row.

Matrix - Multiple Answers Per Row — Select this to ask a question with possible answers arranged in
columns. The respondent can select multiple answers per row.

Matrix - Multiple Answers Per Row (Dropdown) — Select this to ask a question with possible
answers arranged in columns. The respondent can select multiple drop-down answers per row.

Open Ended - One Answer — Select this to ask a question that allows one text answer no longer than
a single field. You can define the maximum number of characters a respondent can use in his answer.

Open Ended - Multiple Answers — Select this to ask a question that allows multiple text answers no
longer than a single field. You can define the maximum number of characters a respondent can use in
his answer.

Open Ended - Essay — Select this to ask a question that allows a text answer longer than a single field.
You can define the maximum number of characters a respondent can use in his answer.

Open Ended - Constant Sum — Select this to ask a question that requires a numerical answer. You can
define an amount all answers must total.
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Open Ended - Date — Select this to ask a question that requires a date as an answer. The respondent
can enter the date in the field or click the calendar button to select the date.

Presentation - Text — Select this to add text to the survey, such as a message to thank the
respondent for taking the survey.

Presentation - Image — Select this to add an image with text to the survey. The text can describe the
image, or you can leave the text box blank and add questions that refer back to the image.

Presentation - Page Break — Select this to add a page break between survey questions.

2 Design Survey

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.

From the Design tab, under Survey status, select the survey's current status.

Survey status:
O Test mode @ open O Closed Select the survey's current status. Test moede allows you to test

survey without recording survey responses. Open allows
respondents to take the survey. Closed closes the survey.

2.

In Test Mode — Select this to test the survey. The program does not record survey responses
entered during Test mode.

Open — Select this to allow respondents to take the survey.

Closed — Select this to close the survey. If you select Allow users to view survey results, a
Show Survey Results button appears instead of questions.

In the Title field, enter a name to appear on your web page for your survey.

Title:

Subtitle:

Enter a survey name to appear on the web page.

Enter additional text about the survey for website users to
read.

In the Subtitle field, enter additional text about the survey for website users to read.

In the Submit button text, Next button text, and Previous button text fields, enter the text
to appear for these navigation buttons. You can use the default values or enter different text
for each button.
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Submit button text: *

Submit Enter text to appear for the navigation buttons. You can use the

default values or enter your own text for each button.
Mext button text:*

Mext ==

Previous button text: .
<< Previous

5. In the On submit message box, enter a message that appears when the user clicks Submit.

On submit message:

Enter text to appear after a user submits survey.

Survey closed message:

Enter text to appear when the survey is closed.

In the Survey closed message box, enter a message to appear to notify users when the survey
is closed.

To add a Display Results button after the user submits his response, select Allow users to
view survey results.

] Allow users to view results Select to allow users to view results after completing survey.

8. Under Survey questions, to add a question, click New Question.
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Survey questions

Click New question to add 3 question.

MNew guestion Print preview | | Export results

The Add Survey Question screen appears.

Add Survey Question

Question Sample

V=3 Choice - One Answer (Vertical)

Select an answer

Question:
'C)Answer 1

'D Answer 2
) Other

Maximum gquestion length: 255 characters |

¥ Skip auto numbering

O Answer required

Answers
Enter each answer an a separate line.

L] Display in random order

Select Other to include an Qther field. This allows a respondent
to enter a different answer than the ones you provide.

O other

Limit answers to characters (max 2553)

Note: When you select a question type, a sample appears under Sample.

a. Under Question, in the Type field, select the type of question to add. The options that
appear in the Question and Answers frames depend on the selected question type.
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After a user submits a response, you cannot edit questions for a survey.
b. Inthe Question field, enter the question to ask.

c. To not have the program automatically number the survey questions, select Skip auto
numbering.

d. To require respondents to answer the question before they can submit the survey or move
to the next page of a multi-page survey, select Answer required.

e. Under Answers, enter possible answers on separate lines. Enter the first answer choice in the
box and press ENTER on your keyboard. On the second line, enter the second answer choice
and press ENTER. Continue until you have entered all possible answers.

f. To display answers in random order, select Display in random order.

g. If you select a choice question type, Other appears. To add Other as an answer choice with a
text field for respondents to enter their response, select this checkbox and, in the Limit
Answers to [ ] characters field, enter the maximum number of characters a respondent can
enter in his answer.

h. If you select an open-ended question type, in the Limit answers to [ ] characters field, enter
the maximum number of characters a respondent can enter in his answer.

i. If youselect a matrix question type, the Answer columns frame appears. Enter answer
column names on separate lines.

Answer columns
Enter each answer column name on a separate line.

j.  If you select a “Matrix — Multiple Answers per Row (Dropdown)” question type, in the
Number of columns field, select the number of columns to appear. In the Heading fields,
enter a heading for each column. In the Choices box, enter answer choices for each column
on separate lines.



Parts 205

Answer columns

Mumber of columns: | 1

Heading

Choices

k. If you select a "Presentation — Text” question type, in the Text box, enter the text to appear.
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Question

V=M Fresentation - Text w
Text:

Maximum gquestion length: 255 characters

F Skip auto numbering

| If you select a "Presentation — Image” question type, in the Question box, enter the text to
appear. To insert an image, click Add image. The Select Image from Image Library screen
appears. For information about how to insert an image, see the Program Basics Guide.

Question

Type: | Presentation - Image v

Question:

Maximum question length: 255 characters

[] Skip auto numbering

| Add image I| [ Remove image

m. Click OK. You return to the Edit Part screen and the new question appears at the bottom of
the screen.

9. To generate a print preview of the survey, click Print preview.

Tip: Users with create and edit rights or Supervisor rights can print survey results to a PDF or export
them to a .csv file when accessing the survey part on a page.
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10. To export results into a .csv file, click Export results.

Note: After you receive responses to the survey, the View response details, Clear responses, and
Refresh results buttons appear beside Print preview and Export results. For more information
about these buttons, see Survey Response Data on page 207.

11. Click Save. You return to Parts.

Survey Response Data

After you receive responses to the survey, response data appears under Survey questions on the
Design tab. For example, you can view the number of questions in your survey, the page count for the
survey, and the number of survey responses. Also, the tab displays each question and calculates
information about the responses such as the percentage or respondents for a question.

Survey questions
Number of questions: 1
Number of pages: 1
Total survey responses: 455

1 What is your favorite ice cream?

Response  Response
Answer Response Percent B E

Percent Total
Chocolato M 1 48% 218
Vanillz — l 52% 235
Total Respondents 453
(skipped this guestion) 0

After the summary response information, the View response details, Clear responses, and Refresh
results buttons appear beside Print preview and Export results.

LN _.-'P-H'w‘__ ._."'/ . ) ;/.v__..v riram e S ey FE e T —reair] b .:i].ﬂ. " /_,-H_ /,-"\. e ,,\,.-J: "‘-.,__-r. e
o (skipped this guestion) 0
[‘u‘iew response details_} [ Clear responses ] [ Refresh results ] § Print preview ] [ Export results

| Save | | Cancel |

To view the details for each survey response, click View response details. The Survey Response Details
page appears and includes details about the respondent and the answers to your questions.
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Survey Result Details

Title: My Survey
MNumber of Questions: 1
Number of Pages: 1
Total Survey Responses: 453

Displaying 1 of 453 ==

Rezpondent: Anonymous
Email:
1P Address: 10.40.1.156

Response Date: 2/3/2011

1 What i1s your favonte ice cream?
@ Chocolate

@ vanilla

After you close a survey and report on its results, you can click Clear Responses on the survey part to
remove the responses from respondent records. Also, you cannot edit survey questions after a user
submits a response. If you need to edit the questions but have already downloaded a response, you
can click Clear Responses to make the questions editable. When you click Clear Responses, a message
appears to make sure you want to delete them. Also, an additional transaction appears in the responses
count on the NetCommunity page and is included in the total download count after you process the
transactions. Survey responses do not clear from records until you process this transaction, but you can
edit survey questions immediately after you click Clear Responses.

To make sure you have the latest response data from your website, select Refresh results.

Tag Display

With the Tag Display part, you include words or phrases related to a page's content as hyperlinks on
the page so users can quickly access similar content on your website. You can also display all tags in
use in the program so users can navigate to areas of your site. When a user clicks a tag, a search results
page appears. The search results include all pages with the selected tag. Users can also search for tags.
Enter "tag:” followed by the exact tag name in a Search field to view all pages that contain a matching
tag.

When you include a tag display, you provide website users a more precise way to locate information
because you assign tags to only relevant parts. For example, you add the tag “Tournament” to Event
Registration Form parts you create for different golf tournaments your organization hosts. When a user
views a page with this tag and clicks the Tournament link, the search results include links to all pages
that contain a part with the “Tournament” tag. If a user entered “Tournament” in a Search field, the
search results may include pages that contain the word “"Tournament” but are not directly related to
your organization’s events.

You can create and apply tags to parts from the Tags tab on the Edit Part screen. When you build a
page, each part you add may contain its own list of tags. From the Edit Part screen, you can choose to
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display only the tags assigned to the parts on the page or all tags used on your site. For information
about how to add tags to a part, see Tags Tab on page 23.

2 Design Tag Display

The tag display is linked to a search results page, so you must create this page before you add a
Tag Display part. For information about how to create a search results page, see Learn About
Search on page 193. For information about how to create or edit a part, as well as the tabs on the
Edit Part screen, see Create and Edit Parts on page 10.

1. From the Design tab, in the Results Page field under General, browse to the page to display
search results on.

| Design |

General

This part will display tags as hyperlinks that navigate to a search results page. You must specify a Results
Page that contains a Search Part, which will render the results.

Results Page: #

]

Display

Select whether to display the tags assigned to the parts on the current page or all tags in the system.
You determine how tags appear on a page in the Stylesheet Editor. The default style for all tags in the
system is different than the default style for tags from parts on the current page. These styles can be
changed separately in the stylesheet editor.

¥ Display tags for parts on the current page
" Display all tags in the system

Save Cancel

Note: Only pages you added a Search part to appear on the Select a Page screen. The page grid does
not include pages based on templates that contain a Search part.

2. Select the tags to include in the tag display.

« To display only tags defined for parts on the page, select Display tags for parts on the
current page. When you add this part to a page, only tags assigned to other parts on the page
appear.

« To display all tags in use, select Display all tags in the system. You can use this option to
create a tag display that includes all tags on your website. This provides another layer of
navigation because users can navigate your site based on types of content.

Note: By default, the tag display appears with a “Tags:” header and a comma separates each entry in
the list. You can edit this heading and delimiter from the Language tab. For information about how to
edit the Language tab settings, see Language Tab on page 17.

Note: Each display option has a default format. If you select Display tags for parts on the current
page, when you add the part to a web page, the tag display appears as a horizontal line of text with
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each entry separated by a comma. If you select Display all tags in the system, the tags appear as a
vertical list, with each entry on a separate line. To change the appearance and orientation of the tag
display, you can apply custom styles to tag elements for the appropriate style sheet. For information
about how to manage style elements, see the Website Design Guide.

3. Click Save. You return to Parts.

Targeted Content

With a Targeted Content part, you can target information or features on a web page to different users
based on roles or the individual user. For example, you may want Major Donors to see a donation form
designed specifically for them, but you want all other users see the standard donation form. Use a
Targeted Content part to attach both donation forms on the same web page. When a major donor
accesses the page, the first donation form appears. When other users access the page, the second
donation form appears.

2 Design Targeted Content

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, create a part or add an existing part.

When a user visits 8 page with targeted content, the first part that has targeted Roles that match the user's group membership will
be displayed. If the user's membership does not match any of the Roles in the parts below, nothing will be displayed.

Drag and drop the parts to reorder them. Parts with 3 siefeethrsush part name will never be displayed.

Part Name Targeted Roles
| HHH £ X | Community Health - Members | Major Givers; Members; |
| HHH £ X | Community Health - Nonmembers | Everyone; |
[ AddNewPart |[ Add Existing Part |

« To create a part to appear on the web page for a targeted audience, click Add New Part. The
New Part screen appears.

 To select an existing part for a targeted audience, click Add Existing Part. The Select a Part
screen appears.

a. Select the part for the targeted audience, such as “Major Donor Donation Form.”

b. Click Select. You return to the Design tab. The Targeted Roles and Users column displays
the roles and users associated with the selected part. This determines who sees the targeted
content on the web page with the Targeted Content part.

To display a complete list of roles and users associated with a part, hover over the row in the
Targeted Roles and Users column.

Note: The first part in the list appears first on the web page for the roles and users associated with
the part. For example, the Major Donor Donation Form you selected has view rights for the Major
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Givers role. When users in this role log into the website and access the donation page, they see a
form designed specifically for them that other user roles do not see.

2. Create additional parts or include existing parts as necessary for the targeted content. You can
include as many parts as you want. For example, you can include the "Healthcare Donation
Form” for users in the healthcare profession and the “Simple Donation Form” for the rest of
your donors.

Note: When a user accesses a page with a Targeted Content part, the first part in the list that includes
that user or the user’s role appears. For example, Mark Adamson is a member of the Board Members
role. When he accesses the donation page, he does not view the Major Donor Donation Form or
Healthcare Donation Form parts because those parts are not associated with the Board Members role.
Mark views the Simple Donation Form part because he is a user in the Board Members role. If the
users or user's role is not included in any parts on the Targeted Content part, nothing appears in that
area on the web page.

3. On the Design tab, the first column displays three action buttons.

a. To move a part in the list, click and drag the dotted button on the far left.

Tip: If you move a part, remember that users with multiple roles see the first part in the list that is
associated with one of their roles. For example, Renee Wilson is a major donor, cardiologist, and
board member. When she accesses the donation page, she views the Major Donor Donation Form
because that part is listed before the other parts on the Design tab.

b. To edit a part, click Click here to edit this part. For example, to add a role to view the
targeted content, click this button to access the Targeting & Security tab for the part.

For information about users and roles, see the Users & Security Guide.

c. Toremove a part from the Targeted Content part, click Click here to remove this part.

Tip: If a part in the list appears in red with a strikethrough, it never appears on a web page because
all roles and users are included in previous parts in the list. This occurs if you include the Everyone
role, which includes all users, in a part that is not last in the list for the targeted content.

4. Click Save. You return to Parts.

Targeted Content On a Web Page

In Pages & templates, when you include a Targeted Content part on a web page, the part appears with
Page part and Edit part buttons.
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B:’ Targeted Content Donation Form Palmetto Pointe Medical Center

i Welcome Supervisor User

@'Page Properties ﬁPreview [ﬁTemplate Designer @ Edit Stylesheet %Copy Page XDeIete @Return

View .i\s:l‘: Page Desigrer = | on date: | Elco

MEDICAL CENTER

S oI e Bt A ,
¥ [outk Home Page patient care healthcare professionals reseanch found ation Donate
'v

Targeted Content

Y Targeted Content

& Major Donor Donation Farm (Donation Form)

& Simple Purchase Farm (Donation Farm)

PALMETTO POINTE

MEDICAL CEMTER

To edit the Targeted Content part, click Page part. This button appears as a blue flag icon. To edit a
part included in the Targeted Content part, click the Edit part button. This button appears as a pencil
icon. For more information about Pages & templates, see the Website Design Guide.

When a user accesses a page with a Targeted Content part, the first part in the list that includes that
user's role appears. Using the examples in Targeted Content on page 210, the following donation page
appears for users in the Major Givers and Site Administrator roles.
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My Profile

patient care healthcare professionals research foundation Donate

My Language |Eng|ish {United States)
Events Calendar

Staff Intranet Major Donor Donation Form
Health Headlines

. Amount: $| *
Bridge Run Dashboard

Sh i
opping Additional Information

Frequency: IOne time 'I

Staff Directory

Volunteer
Corporate: i i i
Ways I can Help p [ This donation is on behalf of a company
A Anonymous: i i
Take Action ¥ M1 prefer to make this donation anonymously
Current Alerts Billing Information
Title: I vl
First name: |Supervisor
PALMETTO POINTE
MIDICAL CENTER Last name: IUser *
e ST
A o Country: United States =
-
P ;" Address = *
"/L Lines: x
Al

=

For users in the Cardiologists and Medical Staff roles, the following donation page appears.
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MEDICAL CENTER

I RE I‘
M.EI"‘ LY
patlent care healthcare professionals research foundation Donate

My Profile My Language |Enaglish (Unitsd States) =]

Events Calendar
Staff Intranet Healthcare Donation Form

Health Headlines Amount: I
. Bronze Donor  $50.00
Bridge Run Dashboard

o
St Silver Donor $100.00

Staff Directory © Gold Donor $500.00

Volunteer " platinum Donor $1,000.00

Ways I can Help & other $|

Take Action

Designation: I.ﬂ.rea of Greatest Meed = |
Current Alerts

Additional Information

Frequency: IOne time vl

Corporate: " This donation is on behalf of a company

PALMETTO POINTE

MIBICAL COMTIR

kol iy e

Anonymous: [ prefer to make this donation anonymously

For users in roles such as Board Members and Everyone, the following donation page appears.
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2

iL’L’* AT 2 4-«3&“:. DR B ay ™ 5 i
logout Home Page patient care healthcare professionals research foundation Donate

My Profile

My Language |English {United States) =]
Events Calendar

Staff Intranet Simple Donation Form

Health Headlines
Amount: $| *

Bridge Run Dashhoard

Shoppin
LU Additional Information

Frequency: IOne tirne vl

Billing Information

Take Action Title: | :I'

Current Alerts

Staff Directory
VYolunteer

Ways I can Help

First name: ISupervisnr
Last name: |User
Country: ILInited States vI
PALMETTO POINTE
MIDICAL COIMTI® Address a .
%Wa: iy kan Lines: I j
= City: |
s -
Ca r‘,ﬁ State: | <Please select> x| *

Transaction Manager

With the Transaction Manager part, you can create and display a giving history for donors. When a

website user logs in to your website, the Transaction Manager part uses the user’s login information to
filter his donor information and display it as a customized giving history. With this part, users can view
their offline and online gifts, as well as any pending online transactions that have not been processed.

On the website, the Transaction Manager part can display one of two tabs, or both. The Active tab
displays current pledges.
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Active | History
Date Hange: | 4| dates El
Designations. | o designations El
Group By: El
Apply
Gift Pay Installment Installment
Lol v Type ol Method Balance Frequency Schedule
Single Installments
= 11/20/2006 Pledge $1,000.00 Cash $1,000.00 p L dueon
(Pay) 11/20/2006
Balance Remaining: %1,000.00
Page 1 of 1
. Remaining
Currency Gift Total Pledge Total Pledge Total
USD $0.00 $1,000.00 $1,000.00

The History tab displays all gifts the user made to the organization for the selected time period or

fund. Users can also select how transactions are grouped in the grid. For example, they can group by
date or payment method.
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Active | History
Date Range: |AII dates -
Apply
. Pay Installment Installment
Date ¥ Gift Type Amount Method Balance Frequency  Schedule
Credit Single
11/14/2008 Cash $5,000.00 -~ 4 Installment
Credit Single
4/8/2007  Cash $500.00 Card Installment
Single Installments
11/20/2006 Pledge $1,000.00 Cash  $1,000.00 iy o dueon
(Pay) 11/20/2006
Personal Single
10/29/2006 Cash $200.00 Check Installment
Single
6/15/2006 Cash $25.00 Cash Installment
Credit Single
2/1/2006  Cash $10,000.00 ~ 4 Installment
Page 1 of 1
. Pledge Pending Remaining
Gift Total Total Total Pledge Total
$23,427.50 $1,000.00 $0.00 $1,000.00

On the Transaction Manager part’s Edit Part screen, you select the tabs to display and the gifts to
include in the giving history. You can include all gifts, filter gifts by gift type or purpose, or use an
offline gift query to filter gifts. The giving history includes a donor's original gift, but it does not
include any matching gift from the donor's employer. In addition to your filtering criteria, you can
select whether to include recognition credits, also called soft credits, and pending online transactions
in the giving history. When you include pending gifts, the gifts appear regardless of any filtering
criteria you apply.

You can also choose whether to allow website users to make payments from the giving history toward
outstanding pledges. This option is available for donors who select the Pledge (Bill Me Later) payment
method or donors for whom you enter a pledge offline. If you allow pledge payments and the pledge
will be paid in installments, a Pay link appears in the Amount column with the pledge entry on the
Active and History tabs. The user clicks this link to view a donation form for the pledge and make a
payment online. The Pay link also appears for unpaid event registration fees.
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Tip: The Pay link does not appear if a pledge installment is pending, if the total pledge balance is
zero, or if the donor submitted credit card or direct debit payment information at the time the
pledge was created.

Note: Pledges and pledge payments appear as separate entries on the History tab. From a pledge
entry, you can view the remaining balance and the most recent payment. From a pledge payment
entry, you can view the date, amount, and balance of the pledge. However, pledge payments include
pledge information only when the pledge appears in the giving history. If you filter gifts and exclude
a pledge, payments do not include information about the pledge. For example, you can use a gift
query to exclude gifts before a certain date. If a pledge is made before that date, the giving history
shows subsequent pledge payments but not the pledge details.

To customize the appearance and content of the giving history, you can select the columns to display
for the donor, edit column headings, and add or remove columns. You can also add a gift summary
section.

2 Design Transaction Manager

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Select the tabs to display on the Design tab, select whether to display the History tab,
Active tab, or both.

Select the tabs to display
This part can display a donor's giving history and current transactions. You select whether to display the History tab, Active tab, or both. To
display the donor's previous transactions, select History tab. To display the donor's current pledges, select Active tab. To include both tabs,
select Both and select the default tab to appear when the donor opens the web page.

@ History tab This only displays the donor's previous transactions on the History tab.
@ Active tab

© Both tabs

To display the donor's previous transactions, select History tab.

To display the donor's current pledges, select the Active tab.

To display the donor's giving history and current transactions, select Both tabs. In the field that
appears on the right, select the default tab to display when the donor opens the web page.

2. Under Configure results, in the Results per page field select how many gifts to include on
each page of the giving history.

Configure results
Select the maximum number of gift records to appear in the transaction manager. You can display up to 100 records per page.

Results per page:
2 Y]

N T SN NP S U ST eV RPN WP
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3. Under Choose the gifts to display, select the gifts to include in the giving history.
« To include all gifts, select All gifts.

Choose the gifts to display
You can include all gifts in a constituent's transaction manaager or filter gifts to meet your criteria. To filter gifts, enter the criteria
here or use a Raiser's Edage query.

® all gifts This option displays all gift types, campaigns, funds and appeals for all gift dates.

© Custom filtering criteria To filter the gifts, select Custom filtering criteria.

Oaift query

- "0“-. PF S S W S S Y R

« To filter the gifts on the Transaction Manager part, select Custom filtering criteria.

Choose the gifts to display
You can include all gifts in a constituent's transaction manager or filter gifts to meet your criteria. To filter gifts, enter the criteria
here or use a Raiser's Edge query.

Qan gifts This option filters gifts by gift type, campaigns, funds and appeals.
e e o To display all gifts, select All gifts.
Gift Types:
O Gift query All Types E:)
Campaigns: | ay; Campaigns EG)
Funds:| Al Funds i)
Appeals: | 4 Appeals =)

M\Hr‘\-‘j *me‘w\rwxﬂmh"

To select the gift types, campaigns, funds, or appeals to include in the giving history, click the
binoculars. On the screen that appears, select your filter criteria.

« To use a gift query from The Raiser's Edge to filter gifts, select Gift query.

Choose the gifts to display
You can include all gifts in a constituent's transaction manager or filter gifts to meet your criteria. To filter gifts, enter the criteria
here or use a Raiser's Edge query.

O Al gifts Thiz option uses a query from Raiser's Edge to filter gifts.

& custorn filtering criteria To display all gifts, select All gifts.

) . *
® Gift query Gift Query: None &

To select a query, click the binoculars. On the search screen that appears, select a query. For
information about the search screen, see the Program Basics Guide.

» To include soft credits, select Include soft credits.
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If you include soft credits, the total gift amount may exceed the amount
[ include soft credits given by the user because soft credits acknowledge multiple donors for a
single gift. For information about soft credits, click here.

If you include pending transactions, the transaction manager displays gifts
you receive on your website that have not vet been processed. These
online transactions appear regardless of any filters you apply to the
transaction manager data.

[Jinclude pending online transactions

._ NW-‘M”‘ MMxJ\"'\‘\ r.,\'w J'.\*".—.\‘-’n*

« To include pending transactions from your website, select Include pending online
transactions.

Note: For pending online transactions, only the gift amount, payment method, and gift date
appear in the giving history. Other details do not appear until you process gifts.

« To include unpaid event registration fees, select Include unpaid event registrations. When
you select this option, the Configure event fee payment field appears.

4. Under Choose the columns to display, select the columns to include in the giving history.

« To display the default Date, Gift Type, Fund Description, and Amount columns, select
Default.

Choose the columns to display
You can customize the appearance and content of the transaction manager. You can add and remove columns, and you can
rearrange the order. To rename the column headings, use the Language tab.

® Default This option displays the default transaction manager configuration.

O custom To customize the columns, select Custom.

Date Gift Type Fund Description Amount

n..M\«H_"I-\_\_\.J\ *\J‘MMW\’~M&"“N

Note: The Gift Type column includes pending transactions. To avoid redundancy, you can exclude
the Pending column if you include the Gift Type column.

« To include specific columns, select Custom.

Choose the columns to display
You can customize the appearance and content of the transaction manager. You can add and remove columns, and you can
rearrange the order. To rename the column headings, use the Language tab.
O pefault This option allows you to customize the appearance of the transaction manager page. You can remove columns,
add columns to display additional information, and reposition columns.
® Custom

Date Gift Tvpe Amount Pav Method Balance Receipt Date

+ Add Column

S . e F\'\-\-J‘ . _’-M M.x___\_ P .’*‘M J«-—m
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Click Add Column and select each column to include in the giving history. To edit a column,
click the column title in the list that appears. You can reposition the column or delete it from
the giving history.

Note: An Export button appears on the web page so a user can export his active gifts and his
giving history. The columns you select to display from this option are the columns that appear in
the export output.

5. Under Choose the summary information to display, select Include gift totals section to
include a summary section that displays gift totals.

Additional options appear so you can select the columns to include in the summary section.

This option adds a summary section for gift totals. The date range

Include gift totals section ) i i ) i
g ‘ and designation filters also apply to this section.

This option adds a column that displays all currencies the

Include currenc es .
] v typ constituent used.

This option adds a column that displays the total gift amount.
Include gift total This excludes all pending gifts, pending pledged gifts, and
non-pending pledged gifts.

This option adds a column to display the total soft

Include soft credits total )
credits amount.

This option adds a column to display the total donation
Include donation amount total amount. This total excludes pending gifts, pledges, and
soft credits.

This option adds a column that displays the total pledged aift

[¥] Include pledged gifts total
] AL : amount.

This option adds a column that displays the total pending gift
Include pending gifts total amount. You cannot select this option if you did not select
include pending online transactions.

This option adds a column that displays the total

[¥] Include remaining pledge balance total .
remaining pledge amount.

Tip: The Include soft credits total and Include donation amount total checkboxes appear when
you select Include soft credits under Choose the gifts to display.
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To allow website users to make payments against outstanding pledges, under Configure
pledge payment, select the web page that contains the donation form to use for pledge
payments.

BN T e X ’-\_\ ‘J \*\\J"‘m.-‘.." J‘\-!__\r_\ PSPOR P"‘-\."-m‘\

Configure pledge payment
Select a page that contains a Donation Form for your online donors to use to pay outstanding pledges. You must select a page
that uses a valid merchant account.

Donation - Payment 2.0 || #

Warning: You must select a donation form that includes a valid merchant account. You should not
select a donation form that requires only the Pledge (Bill me later) payment method because
website users cannot pay a pledge with another pledge. For more information about bank
merchants, see the Administration Guide.

7.

Click Save. You return to Parts.

Unformatted Text

Use the Unformatted Text part to embed HTML text or scripts on a page. For example, you can paste in
the embed code provided by YouTube to display a video. You can also use this part to enable Google
Analytics E-Commerce tracking features.

For more information about how to configure the program to use Google Analytics, see the
Administration Guide.

Warning: Code and scripts that you include in this part are beyond of the scope of Blackbaud
Support.

2 Design Unformatted Text

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.
2.

From the Design tab, enter the HTML code or script in the box.
To select additional options for the code, select Show advanced options.

In the Placement in HTML field, select where to place the code in the page’s HTML. You can
place it in the <head> tag, at the bottom of the <body> tag, or within the <body> tag
according to where you place this part on the page.

Warning: Code and scripts that you include in this part are beyond of the scope of Blackbaud
Support.
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Design | Properties Usage  Targeting & security  Tags

Enter the HTML and/or script for the page. Click here for code examples you can use with this part.

if(LOGGEDIN){

_gaq.push(['_setCustomvar', 1, 'userName', LOGGEDIN, 21);
Telse{

_gaq.push(['_setCustomVar', 1, 'userName’, 'Visitor', 21);

[¥]Ehow advanced opfions

Placement in HTML:
|In the =body= tag with the patt

i Save | | Cancel |

4. Click Save. You return to Parts.

User Education Profile Form

With the User Education Profile Form part, you can create profile forms for users to update their
education information online. You select the fields of information that appear on the display and
update forms. The user can select whether profile information is public (all users can view it) or private

(only the user can view it). We recommend you use the User Education Profile part on password-
protected pages only.

Note: You can update the database with changes users make on the update form.

2 Design User Education Profile Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Primary Alumni, select whether users can edit and delete their
primary alumni education records.

» To allow users to edit primary alumni education records, select Allow users to edit the
Primary Alumni Education record.
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« To allow users to delete primary alumni education records, select Allow users to delete the
Primary Alumni Education record.

2. To allow users to add new nonprimary alumni education records, select Allow users to add
new education records.

3. To allow users to delete their nonprimary alumni education records, select Allow users to
delete existing education records.

4. Inthe Message to display when there are no education records box, enter the text to
appear on the form when the user has no education record.

5. Under Education record field options, set up the Education and Education Attributes sections
of the User Education Profile form.

a. Inthe Section field, select the section type to set up. Select "Education” or "Education

Attributes.”

b. Inthe Heading field, enter the text to appear at the top of the section. For example, for the
Education section, enter "My Education.”

c. Inthe Fields grid, select the fields to include in the section and other options.

Option

Function

Show in grid

Show in Edit/Details
Form

Field

Editable

Required

Privacy Editable

Use Code Table

Editable Codes

Alternate Caption

Select the checkbox next to each field to include in the profile display grid.

Select the checkbox next to each field to include on the update form.

This column displays the fields from The Raiser's Edge you can include in the
section.

To allow the user to edit a field, select this checkbox. If you do not select this
checkbox, the field appears in the profile, but the user cannot change its value.

To make a field required, select this checkbox. If you select this checkbox, the user
must select or enter a value for the field to complete the form.

To allow users to hide a field on the profile display grid, select this checkbox. For
example, if you select this checkbox for GPA, users can select whether to display
their GPA on the profile.

If a field has code table values, this checkbox appears. If you select this checkbox,
the field on the form displays the code table values from The Raiser's Edge. If you
do not select this checkbox, the user must enter a value in the field.

If a field has code table values, this checkbox appears. To allow users to enter
values other than a code table value, select this checkbox. On the form, an Other
field appears next to the field so users can enter a value other than those
provided.

To edit a field name, enter a new name in this column. For example, you can call
the Frat/Sorority field Fraternity/Sorority.
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6. Click Save. You return to Parts.

User Email Preferences Form

Design the User Email Preferences Form to provide a way for website users to subscribe to and
unsubscribe from email for chapters, newsletters, or notifications. You can also select constituent
attributes from The Raiser's Edge to appear in an email preference list so users can subscribe to emails
such as monthly or quarterly recurring messages.

Each email you create in Blackbaud NetCommunity requires a link to a web page that includes this part.
When a user clicks the link to view or change subscriptions, the program displays your organization's
email options, and if the user has a constituent record in The Raiser's Edge, their subscription
information automatically displays. For example, the user receives your monthly newsletter so its
checkbox is selected on the page. When a user accesses the email preferences page directly on your
site, they must log in so the program knows the identity of the user. Once logged in, the page displays
the email options along with applicable subscription information.

A global opt-out checkbox always appears on the part so users can opt out of all email
communications. When a user selects or clears this checkbox, a profile update transaction generates in
The Raiser's Edge for you to process to the constituent record. After you process the transaction, the
Requests no email checkbox updates according to the user's selection. Email preference changes for
chapter email, newsletters, notifications, and constituent attribute preferences automatically update
constituent records without requiring you to process transactions.

> User Email Preferences Form Part Considerations

« When there are no email messages in your database for an email option, its section does not
appear on the part. For example, if you do not use the Chapter Manager part on your website,
the chapter email section does not appear on the email preferences web page.

« To provide at least one web page so users can subscribe to or unsubscribe from newsletters, you
must grant the Everyone role view rights for at least one User Email Preferences Form part on a
page. You can create other user email preferences form pages that exclude view rights for the
Everyone role, but you must grant view rights for Everyone for at least one part on a page for
newsletters.

o Newsletter subscriptions also derive from sending them. The program sends subscription
newsletters to constituents on the assigned email lists, plus additional subscribers from the
email preferences page. Explicit unsubscribers and users with Requests No Email do not receive
the newsletters. The program prevents a duplicate email to the same record in The Raiser's Edge.
It does not prevent duplicate emails when The Raiser's Edge query contains duplicate records
unless you clear the Send a unique email to each constituent who shares the same email
address checkbox in Sites & settings.

« The program automatically configures chapter email under the opt-out section. Blackbaud
NetCommunity groups “Chapter Manager part name — Chapter name List” for the list. For
example, “Alumni Chapter Manager — San Diego List" is the Chapter Manager part named
(Alumni Chapter Manager) — Chapter name (San Diego) List.

Chapter emails derive from the Chapter Manager part.
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This information informs you of the email options that appear on the email preferences page based on
whether the user has a constituent record in The Raiser's Edge and is a member of your website. The
only option that appears at all times is the global opt-out checkbox so users can opt out of email
communications from your organization.

« When a website user has a constituent record in The Raiser's Edge, but is not a member of your
website, the email preferences page appears along with the user's subscription information. The
user does not have to log in to your site because the link in the email automatically identifies the
user.

In this scenario, the user is not a member of your site and cannot subscribe to chapter email or
notifications. The user can subscribe to newsletters and constituent attribute based emails.

« When a website user has a constituent record in The Raiser's Edge and is also a member of your
website, the email preferences page appears along with the user's subscription information. The
user does not have to log in to your site because the link in the email automatically identifies the
user.

In this scenario, the user can subscribe to chapter email, newsletters, notifications, and
constituent attribute based emails.

« When a website user does not have a constituent record in The Raiser's Edge and is also not a
member of your website, the user can subscribe to newsletters.

In this scenario, after the user creates and account and you process the sign-up request
transaction to The Raiser's Edge, the user can return to the email preferences page and subscribe
to chapter email, notifications, and constituent attribute based emails.

2 Design User Email Preferences Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Select the Design tab.

2. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

Consent

The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part v

Under Consent Preference, select a saved Communication Consent part to include on the
form. This part can only be included inline on the User Email Preferences form and not as an
overlay.
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Note: When the Communication Consent part is included on the User Email Preferences form, no
profile update transaction is created in The Raiser's Edge when a user submits the form. The
constituent's consent information is written directly to their record in The Raiser's Edge.

3. Under Email Preference, in the Title field, enter a title to appear on the web page for email
preferences.

General

Title:
User Email Preference Enter a user emall preferences title to appear on the web page.

After update navigate to:
T Select the page to appear after 3 website user updates the

subscription.

4. Inthe After update navigate to field, browse to the page to appear after website users
update subscription information. If you do not select a page, the page designated as the
Home Page in Sites & settings appears for users.

5. Under Attributes, select the constituent attributes to appear as email preference options on
the web page in the Include column. To change the text that appears for the attribute on the
web page, enter it in the Caption field, and to move an attribute in the list, click and drag the
dotted button on the far left.

Attributes
Select the constituent attributes to display as email preference options on the web page. You can only use constituent attributes with
a type of Yes/No and Table with this part.

Constituent attribute options

Include Field Caption
i Planned Giving Do you want to receive planned giving information?
EEHH eMessages eMessages

You can only use constituent attributes with a type of Yes/No and Table with this part. Table
type attributes are available without being marked as one per record. If you recently added a
new constituent attribute in The Raiser's Edge and it does not appear in the grid or in Sites

& settings for you to make it available on the web page, click Refresh code tables in Code
tables. This updates code tables from The Raiser's Edge in Blackbaud NetCommunity. For more
information about how to update code tables, see the Administration Guide.

Tip: You may want to consider including the same constituent attributes on your User Login part for
new registrations so that users can subscribe to emails as they register for your site.

6. Under Opt-out checkbox, customize the instructions that appear for the opt-out section of
the User Email Preferences form. In the Opt-out checkbox label field, enter the text to appear
for the global opt-out checkbox on the website, such as “To no longer receive email from us,
select the checkbox.”



228 CHAPTER 1

Opt-out checkbox

The opt-out checkbox on the email preferences form allows website users to indicate that they do not want
to receive email messages from your organization.

Opt-out checkbox label: ®

Check this box to indicate that Enter a label for the checkbox to opt out of email messages.
vou do not wish to receive

future email communications

from us.

For verification purposes, if a user selects to opt out of a newsletter, the user is asked to enter
his or her email address. If the email address is not registered with the program, the user
cannot opt out of the newsletter.

Note: Even when a user selects the global opt-out checkbox on the website, he or she continues to
receive requested notifications and acknowledgment emails.

7. Under Subscriptions, customize the instructions that appear for the subscriptions section of
the User Email Preferences form. In the Subscribe instructions field, enter the text to appear
for the newsletter subscription checkboxes on the website.

Subscriptions

Customize the email subscriptions text that is presented to users. Users can use this option to specify which
subscriptions they want to receive.

Subscribe instructions: *

Please select the s Enter the instructions for the subscriptions.
communications you would like

to see from us. Your current

subscriptions are already

checked. Uncheck the box for +

8. Under Directory messages opt-out, select Include opt-out for directory messages on this
form to enable website users to opt out of receiving email messages sent from other
directory users. In the Directory opt-out checkbox label field, you can customize the text
that displays for the opt-out checkbox on the User Email Preferences form.

Directory messages opt-out

This checkbox allows website users to indicate whether or not they want to receive email messages sent from other directory users on a
Directory part.

[ include opt-out for directory messages on
this form

Directory opt-out checkbox label:*

I do not want to receive messages from Enter a custom checkbox label for the option to opt out of directory email messages.
directory website users,




PARTS 229

For verification purposes, if a user selects to opt out of directory messaging, the user is asked
to enter his or her email address. If the email address is not registered with the program, the
user cannot opt out of the messaging.

9. To customize section titles with help text and additional messages that appear for the part,
select the Language tab. For information about the Language tab, see Language Tab on page
17.

10. Click Save. You return to Parts.

User Interests Form

With the User Interest Form part, you can create a web page that captures a website user's interests.
You can download the information that website users select on the User Interests Form. You can use
this information to raise funds and create awareness for your organization. For example, if many

website users select Wine Tasting on your User Interests Form, you can host a wine-tasting event in

your community.

Note: To download the website users’ interests, you must select the attribute from The Raiser's Edge
to map to for downloads in the Interests attribute field on the Settings tab in Sites & settings. For
more information, see the Administration Guide.

2 Design User Interests Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter a name to identify the User Interests Form part.
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Title:

Help message:

2. Inthe Help message field, enter the message to appear on the website page, such as to
provide instructions for site users.

3. Under Interests to include, select the interests website users can choose from on the User
Interests Form.



ParTs 231

Interests to include:

Basketbhall
Biking
Cards

Contemporary art

Cooking
Cricket

Fishing
Football

Gardening

T W
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Note: The interests that appear default from table attributes in The Raiser's Edge. For example, you
can have a constituent attribute called “Interests” with a data type of “table” in The Raiser's Edge. This
attribute appears on the User Interests Form.

4.

Click Save. You return to Parts.

User Login

To control the areas users can access on your website, create a User Login part. When a user logs in, the
user login determines the roles that the user belongs to and the features that the user has security
rights to access.

There are several important items to remember about the User Login part. Make sure you consider this
information when you design the part.

The part automatically includes sections for the login and logout pages. You can design the part
to also include sections for the new user registration page and the forgotten password page.

You create emails to acknowledge registrations and provide forgotten usernames.
When you have multiple websites, create multiple login pages to provide access to each site.

The Fundraiser part has its own user login. For information about how to create the user login for
a Fundraiser, refer to the Team Fundraising Guide.

You can enable social media to allow new users to register with their social network login. When
you use the social media login option, you can indicate where to display the social media icons
on login forms.

Multiple users can use the same email address when they sign up for your site. This makes it easy
for an entire family to sign up for a fundraiser or other event. If a family shares an email address
and one user forgets a password or username, the reminder email contains all usernames
associated with that email address. The password reset link connects to a page where the user
can select the username that needs a new password.

When you include a link to this part in an email message, you can create a special page link to
send users to the login page and you can also create a special page link to send users to the
forgotten password page. When you include this link in a message and an email recipient clicks
the link, a secure page appears with a Forgotten Password field for the user to enter their email
address. This link remains active in the email for the user to take action to reset the password any
time. After the email address is submitted on the web page, another email sends to the user.
That email contains another link that returns the user to the reset password page on your
website. For more information about how to create a special page link, refer to the Program
Basics Guide.

2 Design User Login

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.

From the Design tab, when you configure social media for third-party authentication with
social networks such as Facebook and Twitter, Social website login appears with the Enable
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social website login checkbox. To enable social media options for the login, select the
checkbox. Additional options appear.

a. Inthe Sign in text field, enter the text to display for standard and social network login
options.

b. In the Social website sign in text field, enter the text to display above the social site icons.
c. Under Display options, specify where to place the social site icons relative to the standard
login fields.
Note: For more information about social media for third-party authentication, refer to the
Administration Guide.

2. Under Captions and properties, select whether to include forms for new registrations or
forgotten logins. To include a form, select its checkbox in the Enabled column.

Captions and properties
Select titles and hyperlink captions for the web page. You can edit the text to appear on the page on the
Language tab.

Enabled
Login
MNew User Registration
Forgotten Password/User ID
Forgotten Password
Forgotten User ID F

Note: To change the caption for a form, select the Language tab. For information about the Language
tab, see Language Tab on page 17.

We recommend you clear New User Registration if you import records from The Raiser's
Edge into the website. Imported users are registered automatically, so they do not need to
register a second time with the User Login part. For information about how to import users,
see the Users & Security Guide.

Note: After you create a login page with the User Login part, select it in the Member Login Page
field in the Registration and Login Options frame on the Settings tab in Sites & settings. For more
information, see the Administration Guide.

3. In the Constituent code field, select the constituent code to assign to users who use this form
on your website. For more information about constituent codes, refer to the Program Basics
Guide.

4. Under Navigation, select the web page to appear after users log in, log out, register, or reset
passwords.
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By default, the Login, Logout, and New user registration forms are set to the default home
page you selected on the Settings tab in Sites & settings, and the Password reset form is set to
blank.

 To clear the web page selected for a form, click Remove page for that form. If you do not
select a page for New user registration, users are directed to the page selected for the login
form. If you do not select a page for Password reset, the program does not redirect users to
another page. Instead, a message appears to indicate the password is reset.

5. Under Additional fields, select the biographical fields to include on the new user registration
form.

Additional fields

Select which additional fields will be displayed during the user registration process.
Field Include Required
Title O O
Address block Ll
Home Phone | F
Gender Ll .
Middle name | [
Maiden name F] F]
Class of | |
Birth date ] ]
Lookup ID F Ll

a. Inthe Field grid, select Include for each field to include on the form. To make a field
required, select Required. When you select Include for the Address block field, it is
automatically required.

b. In the Attribute grid, select Include for each constituent attribute to include on the form. To
change the text to appear on the web page, enter it in the Caption field. To make the
attribute required, select its checkbox in the Require column. To move an attribute in the
list, click and drag the dotted button on the far left.

The Raiser's Edge provides these constituent attributes. To add a new attribute for your part,
create it in The Raiser's Edge. For example, you can use a constituent attribute to track t-shirt
sizes for participants. To track this information, create a t-shirt size attribute. If you know an
attribute exists, but do not see it online, check the Settings tab in Sites & settings to verify
the attribute is available.

6. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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Consent
The Communication Consent part allows website users to specify their consent preferences for how they want
to receive communication from your organization.

Consent part:
Communication Consent Part T

Select how to display the consent options: @

Inline

® Overlay

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded to the BBNC plugin
along with their transaction. After the transaction is processed, their constituent record is
updated in The Raiser's Edge with their communication consent preferences. If the user is
logged in when they submit the form and their BBNC account is linked to a constituent
record in The Raiser's Edge, their communication consent preferences are written directly to
their record in The Raiser's Edge.

7. Under Role assignment, select the checkbox under Member for each role to assign to users
who sign up through this User Login part.

Role assignment
Select which role to assign to users registering or joining on this page.

Role Member
Content Authors Fi
Members
Site Administrators F

8. To create a reminder email to send to members who click Forgotten Password/Username or
Forgotten Password, click Forgotten Password/Username Email on the action bar. The
HTML editor appears. You can use the default text provided or enter different text.

Note: When you include the Password Reset Link merge field in the reminder email, the field
displays as a secure link that remains active for 24 hours. When a user clicks the link, a secure page
appears to enter and confirm a new password.

9. To create an email to send to new users after they register, click New User Registration Email
on the action bar. The New User Registration Email screen appears. You can use the default
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text provided or enter different text. Use the merge fields to include the username, password,
and other personalization.

For information about how to create an email, refer to the Email Guide.

10. To create instructions to appear on the Login, New User Registration, and Forgot Password
screens of the part, select the Helplets tab. For information about this tab, see Helplets Tab on

page 20.

11. To customize the messages and labels that appear for the part on your website, select the
Language tab. For information about the Language tab, see Language Tab on page 17.

12. Click Save. You return to Parts.

User Photos Form

To allow website users to upload a picture along with a profile image on a profile web page, include a
User Photos Form part on a page that also includes the Profile Display part. When a user uploads an
image on the User Photos Form, the image appears along with the profile information for the user.
When you include the User Photos Form part on a profile page that links to a Directory part, other
website users view the image when they access profiles through the directory.

Images must be *bmp, *.gif, *.ico, *jpeg, *jpg, or *.png files.
Tip: On the Settings tab in Sites & settings, you can require approval for images. Under User Image
Options, select Require approval for all images uploaded by users. When you include the User

Photos Form part on a profile page and users upload images, you must approve the images in Image
library for it to appear on your website. For more information, see the Administration Guide.

2 Design User Photos Form

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select the tag in the Image tag field to associate with images that users
upload through the user photos form. Tags are keywords or phrases to identify an image’s
content. For more information about tags, see Tags Tab on page 23.
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Image tag:*

Default caption:

Max height/width for thumbnails: ®
P

px

After update navigate to:

Max height/width for full-size image:

Select a tag to associate with images that use this part. A tag can
only be used by one User Photos Form part.

Enter a caption to appear if the user does not enter one for the
photo.

Enter the maximum thumbnail height and width for uploaded
photos.

Enter the maximum display height and width for uploaded photos.

2. In the Default caption field, enter the caption to display with images when users do not enter

captions.

3. In the Max height/width for thumbnails field, enter a size limit for images as thumbnails. By
default, images uploaded on this part appear as a thumbnail on the web page.

4. In the Max height/width for full-size image field, enter a size limit for how to display
images when users click thumbnails. If you leave the field blank, images do not appear when

users click thumbnails.

5. In the After update navigate to field, browse to the page to direct users to after they select

images on this part.

6. Click Save. You return to Parts.

Volunteer Opportunity

If you use Volunteer Management for The Raiser's Edge, you can create a Volunteer Opportunity part to
show a list of jobs on your website. A website user can learn about the volunteer jobs, sign up for a job
position, and enter data that is relevant to the position. For example, the volunteer can provide
emergency contact information, special skills and needs, and medical needs.

Note: For more information about volunteers and jobs in The Raiser’'s Edge, see the Records section

in the Raiser's Edge help file.

With the Volunteer Opportunity part, you can create a volunteer page that includes a list of volunteer
jobs at your organization. Once the user selects a job from the job list, details about the job appear,
such as its description, start date, and position. After the user clicks the sign-up button, the volunteer
sign-up form appears. The user completes this form to submit to your organization.

Volunteer transactions appear on the NetCommunity page in The Raiser's Edge. When a volunteer
transaction processes, the data appears on the Volunteer tab on the user’s constituent record and a job
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assignment for the user appears on the job record. For more information, see the Blackbaud
NetCommunity & The Raiser’s Edge Integration Guide.

> Design Volunteer Opportunity

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1.

Note:

a.

Tip: F

From the Design tab, in the Constituent Code field, select a constituent code to add for
volunteers. For more information about constituent codes, see the Program Basics Guide.

In the Volunteer Type field, select a volunteer type to assign to the user, such as Coordinator
or Gift Shop Staff. A volunteer type denotes how a volunteer serves your organization.
The Raiser's Edge determines the volunteer types available in this field.

The Raiser's Edge determines the volunteer types available in this field. To add a type, create it
in Volunteer Types table in The Raiser’'s Edge. For information, see The Raiser’s Edge
Configuration & Security Guide.

Under Job List, in the Title field, enter the title for the job list. Leave the default part name, or
enter your own title, such as "Outside Volunteer Jobs.” This title appears at the top of the
volunteer web page.

The Job List frame creates the first volunteer section of the web page.

In the Instructions field, enter content to instruct the user on how to use the job list step.
Leave the default instructions, or enter your own.

You can select a job query that contains the jobs to appear in the job list for this part. For
information about how to use the Query Search screen, see the Program Basics Guide.

or a query to appear as a selection, you must first create it in The Raiser's Edge. When you

create a query, you may need to refresh the website for it to appear as a selection. To refresh, select

View,

C.

Refresh from the menu bar.

In the box under the Jobs to Include field, enter the text to appear if the query does not
return job results, such as “There are no volunteer jobs at this time. Please check back next
month.” Leave the default message, or enter your own.

d. Under Specify how you’'d like the list to appear, specify how job results appear. Select the

number of jobs to appear per page, whether page links for the job appear above or below
the results (or both), whether the job start and end dates appear, whether users can search
the list, and whether to use the field names from The Raiser’s Edge.

In the box under Allow this list to be displayed, enter the text to appear if no jobs match
the user’s job search, such as “Please search our volunteer jobs again! Your criteria did not
return any jobs.” Leave the default message, or enter your own.

e. To display custom field names from The Raiser’s Edge, select Use field names from

4.

The Raiser’s Edge. When you select this, text in the Display As column from Configuration,
Fields in The Raiser’'s Edge appears on the web page for jobs. Otherwise, default field names
appear. For more information, see The Raiser's Edge Configuration Guide.

Under Job Detail, in the Instructions field, enter content to instruct the user on how to use
the job details step. These instructions appear after a user selects a job from the job list. Leave
the default instructions, or enter your own.
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Note:

a.

5.

Note:

The Job Detail frame creates the second volunteer section of the web page.

In the Button Text field, enter the text to appear on the button that creates the sign-up
form for the job the user selects. You can leave the default text or write your own button
text.

To display custom field names from The Raiser's Edge, select Use field names from

The Raiser’s Edge. When you select this, text in the Display As column from Configuration,
Fields in The Raiser's Edge appears on the web page for jobs. Otherwise, default field names
appear. For more information, see The Raiser’s Edge Configuration Guide.

In the Display column, select the checkbox beside the volunteer attribute to appear. To
change the text of the attribute on your donation page, enter the text in the Caption field.

Under Volunteer Sign-Up Form, in the Instructions field, enter content to instruct the user
on how to use the sign-up step. These instructions appear after the user clicks the sign-up
button on the job detail step.

If the Minimum age field on the job record in The Raiser’s Edge contains an age, a required
Date of Birth field appears after the instructions.

To display custom field names from The Raiser’s Edge, select Use field names from

The Raiser’s Edge. When you select this, text in the Display As column from Configuration,
Fields in The Raiser's Edge appears on the web page for volunteers. Otherwise, default field
names appear. For more information, see The Raiser's Edge Configuration Guide.

The Volunteer Sign-Up Form frame creates the third volunteer section of the web page.

In the Button Text field, enter the text to appear on the sign-up button. This button submits
the sign-up form to your organization. You can leave the default text or write your own button
text.

Tip: To sign up for a job, the user must be registered to your website.

6.

9.

To store volunteer emergency contact information, select Emergency Contact Information.
To make this a required field on the sign-up form, select Require emergency contact name
and phone number.

To display a Vehicle section on the sign-up step, select Vehicle Information.

In the Available Checkbox Caption field, enter text to appear beside the vehicle checkbox on
the sign-up step. Leave the default text, or enter your own. On the sign-up step, a Vehicle
Type field appears with this checkbox. The Volunteer Vehicle Type table in The Raiser's Edge
determines the selections in this field.

To include an additional information section on the sign-up step, select Additional
Information.

In the Section Title field, enter the text to appear at the top of the additional information
section. Leave the default title, or enter your own.

In the Instructions field, enter content to instruct the user on how to use the additional
information section. Leave the default instructions, or enter your own.

The job record determines the remaining sections available to add to the sign-up step. For
example, you can create sections for skills and experience, courses and training, medical
information, special needs, interests, or checklist items. To add a section to the sign-up step,
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select its checkbox and, in the Section Title and Instructions fields, enter the information to
appear for the section.

10. Under Navigation, browse to the web page to appear after users submit volunteer sign-up
requests. If you do not select a page, the home page from the Settings tab in Sites & settings
appears by default.

11. Click Next. The Acknowledgement Email screen appears.

12. Create an acknowledgement email for website users who use the volunteer opportunity form
to submit a volunteer sign-up request. You can use the default text provided or enter different
text.

Tip: When you edit a Volunteer Opportunity part, you can click Acknowledgement Email to access
the Acknowledgement Email screen. For information about how to design an email to acknowledge a
volunteer sign-up request, see the Email Guide.

13. Click Save. You return to Parts.

Weblog

With the Weblog part, you can collect or share information on your website that pertains to your
organization. This can range from your organization’s news to appeals sent to your alumni to links to
other related websites. Given the appropriate rights, your program users and website users can update
the Weblog part.

The part creates a RSS feed of posts. Include the part on one of your website pages so users can add
and edit posts to appear in the feed. Users can view the feed from the page when they click the RSS
icon next to the title of the Weblog, or from an RSS reader. You can add the News Reader part to your
website to display the feed, or users can subscribe to the feed with a third party reader.

Note: When users add or edit posts, the program includes content from the Story Title and Story
Content fields in the search results for the Search and Quick Search parts. Also, the program uses
content from the Tags for this story field to create category information in the RSS feed. Some RSS
readers use this information to arrange posts in groups that share common categories.

2 Design Weblog

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Date format field, select a date format for the blog.

2. Under RSS Publishing Properties, in the Title field, enter the title of your weblog, such as
“Best Solicitation Practices for Fundraising.”

Note: The Title field is optional. However, to save a weblog, you must either enter a title or enter
description information in the Description field.

a. Inthe Description field, enter any additional information, such as "Check weekly for
updates.”
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b. Inthe Link URL field, enter your website link that news readers such as NewsGator use to link
to your site. This link should direct the website user to your weblog or a general information
page about your organization.

To view the information you enter in this field, click XML for the weblog on your site. For the
example, the XML information for your description reads " <description>Check often for
weekly updates</description>." In addition, news readers use the weblog description
information to provide general information about the contents of the weblog. For more
information about the News Reader part, see News Reader on page 147.

c. Inthe Copyright field, enter a copyright notice for your weblog, if you have one.

d. Inthe Editor’s Email field, enter your email address or the person who is responsible for the
content of your weblog.

e. To approve weblog posts before they appear on your site, select Moderated.

3. Under Image Properties, click Select Image. The Select Image From Image Library screen
appears. For information about how to insert an image, see the Program Basics Guide.

4. To share valuable information from another website with your site users, in the Link URL field,
enter the address of the website to link to the weblog.

5. Under Security Rights, specify the roles with post and manage rights for the weblog.

a. Inthe Post column, select the checkbox to assign post rights to users and roles. This does
not grant rights to edit or delete postings.

b. Inthe Manage column, select the checkbox to assign manage rights to users and roles. This
grants rights to add, edit, and delete postings. If Moderated is selected, these users and
roles can approve postings.

c. Toinclude additional users and roles, select Add users and roles.

6. Click Save. You return to Parts.

Web Traffic Reports

Using the Report (Web Traffic) part, you can create reports with statistics about your website’s traffic.

Warning: To create a Web Traffic report, you must run Microsoft SQL Server Agent. If you are unsure
whether you run this program, consult your system administrator.

You can add several types of Web Traffic reports:

Site Usage Report — The Site Usage Report displays the total number of hits each page on your
website received and the percentage of total hits compared to other pages on your site. Web pages
are hyperlinked so you can open them directly from the report.

Page Rank Report — The Page Rank Report is a small bar graph that displays the number of hits a
page received and its overall rank compared to other pages on your website. You can place this graph
on any page. We recommend you grant view rights to only to those who need to see the statistics.

Page View Summary — The Page View Summary displays the total number of page views, the
average number of page views, and the average number of page views per visit for all pages in the
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website. Website users can filter the report results by date range and group the results displayed in the
bar graph by day, week, or month.

Page Overview Report — The Page Overview Report displays the total number of page visits and
views for each page viewed. It also includes a bar graph that displays the total number of page visits
and views for each page ID. You can filter the report so it includes only pages with the top 10 number
of views or visitors, the bottom 10 number of views or visitors, or all pages that had views or visitors.
Web pages are hyperlinked so you can open them directly from the report.

Visit Summary — The Visit Summary displays statistics for website visits during the specified period
of time. The summary includes the total number of visits and average number of visits per day. It also
includes the total length of time visitors spent on the website and the average visit length per visitor.
To calculate the average visit length, the program divides the total length of time of all the visits by
the total number of sessions (individual visits).

Visitor Summary — The Visitor Summary displays statistics including the total number of website
visitors, the number of unique visitors, the number of one-time visitors, the number of repeat visitors,
and the average number of visits per visitor. The summary also includes the total number of program
visitors and the number of unique program visitors. Website users can filter the report results by date
range.

Note: In the Visit Statistics section, Total Visits is the total number of users (everyone who accessed
the website, logged-in or not.) In the Blackbaud NetCommunity Users section, Total Visits is the total
number of logged-in users that visited the website. For example, here are the Visitor Summary results
for a website:

Visit Statistics

- Total Visits: 13,301

- Unique Visitors: 13,265

- Average Visits per Visitor: 1.00
- One Page Visits: 12,941
Blackbaud NetCommunity Users
- Total Visits: 72

- Unique Users: 36

- Average Visits per User: 2.00

What this means — The website was viewed 13,301 times by 13,265 unique visitors. 36 views were
from visitors who had previously viewed the website during this period.

Of those 13,265 unique visitors, 36 of them logged into the website a total of 72 times among them.

Web Traffic Reporting Terms

This table explains the items included in Web Traffic reports.

Hits Number of times a page was accessed
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Views Number of times visitors viewed a page
Visits Number of times users logged into the website
Unique visitors Number of logged-in users and anonymous visitors (those not logged into the

website) who visited the website. These are counted only once, even if they visit
multiple times during the report’s date range.

Return Visitors Number of unique users who visited the website more than once while logged in.
(This excludes return visits by those not logged in.)

Only Visited once Number of logged-in users and anonymous visitors (those not logged into the
website) who visited the website only once

Unique Hosts Number of different IP addresses that accessed the website

Unique Users Number of different logged-in users that accessed the website

2 Design Web Traffic Report

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Report Type field, select the type of report to create.

To view a pop-up preview of the report, click on the report type. For information about report
types, see the introduction to Web Traffic Reports on page 241.

2. Inthe Report Title field, select the report title.

« To use the report name as the title, select Default.

« To use a custom title, select Other and enter the report title in the field.
3. To display the name of the report, select Show Report Title.

4. Click Save. You return to Parts.
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